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Preface

About this manual
Getting Started with Synergy/DE provides a technical overview of all components of Synergy/DE®, 
as well as a task-oriented “cookbook” for using Synergy/DE. It walks you through the steps 
required to develop a basic Synergy™ application—and tells you what else you can do and where 
to get more information if you want to go beyond the basics.

Because we assume that you are familiar with programming in some language, this guide does not 
cover basic principles of programming. Instead, it includes language features specific or integral to 
developing in Synergy/DE.

Manual conventions
Throughout this manual, we use the following conventions:

 In code syntax, text that you type is in Courier typeface. Variables that either represent or 
should be replaced with specific data are in italic type.

 Optional arguments are enclosed in [italic square brackets]. If an argument is omitted and the 
comma is outside the brackets, a comma must be used as a placeholder, unless the omitted 
argument is the last argument in a subroutine. If the comma is inside the brackets and an 
argument is omitted, the comma may also be omitted.

 Arguments that can be repeated one or more times are followed by an ellipsis…

 A vertical bar (|) in syntax means to choose between the arguments on each side of the bar.

 Data types are boldface. The data type in parentheses at the end of an argument description 
(for example, (n)) documents how the argument will be treated within the routine. An a 
represents alpha, a d represents decimal or implied-decimal, an i represents integer, and an n 
represents numeric (which means the type can be d or i).

WIN
 Items or discussions that pertain only to a specific operating system or environment are called 

out with the name of the operating system.
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Other resources
 Repository User’s Guide 

 Synergy DBL Language Reference Manual 

 Synergy Tools 

 Environment Variables & System Options 

 UI Toolkit Reference Manual 

 Installation Configuration Guide 

 xfNetLink & xfServerPlus User’s Guide 

 Professional Series Workbench online Help system

 S/DE Composer online Help system

Product support information
If you cannot find the information you need in this manual or in the publications listed above, you 
can reach the Synergy/DE™ Developer Support department at the following numbers:

800.366.3472 (in the U.S. and Canada)
916.635.7300 (in all other locations)

To learn about your Developer Support options, contact your Synergy/DE account manager at one 
of the above phone numbers.

Before you contact us, make sure you have the following information:

 The version of the Synergy/DE product(s) you are running

 The name and version of the operating system you are running

 The hardware platform you are using

 The error mnemonic and any associated error text (if you need help with a Synergy/DE error)

 The statement at which the error occurred

 The exact steps that preceded the problem

 What changed (for example, code, data, hardware) before this problem occurred

 Whether the problem happens every time and whether it is reproducible in a small test program

 Whether your program terminates with a traceback, or whether you are trapping and 
interpreting the error
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Reporting Synergy .NET issues
If you are having any of the following problems, please send us the complete set of source files to 
re-create the issue, and send us the information in the BuildVersion.txt files in the 
\MSBuild\Synergex\dbl and \Synergex\SynergyDE\dbl directories in “Program Files” or “Program 
Files (x86)”.

 Visual Studio lock up or crash

 Compiler crash

 Unusual MSIL Assembler (ilasm.exe) issues

 “Invalid program” errors

 “JIT Compiler has encountered an internal limitation” error at runtime

For Visual Studio issues, zip the entire project.

Note that for untrapped errors, you won’t get a traceback, as you would with traditional Synergy. 
Instead, you’ll get the Windows Dr. Watson box. And if you click Debug, you’ll go into the 
debugger. If the program was not built with debug information, and you instead click Cancel, you’ll 
get a traceback. 

Synergex Professional Services Group
If you would like assistance implementing new technology or would like to bring in additional 
experienced resources to complete a project or customize a solution, Synergex® Professional 
Services Group (PSG) can help. PSG provides comprehensive technical training and consulting 
services to help you take advantage of Synergex’s current and emerging technologies. For 
information and pricing, contact your Synergy/DE account manager at 800.366.3472 (in the U.S. 
and Canada) or 916.635.7300.

Comments and suggestions
We welcome your comments and suggestions for improving this manual. Send your comments, 
suggestions, and queries, as well as any errors or omissions you’ve discovered, to 
doc@synergex.com.

mailto:doc@synergex.com
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1
What Is Synergy/DE?

Welcome to Synergy/DE version 10, the next generation of Synergy tools designed with 
programmer productivity and flexibility in mind.

What Is Synergy/DE? 1-2

Defines the underlying philosophy and advantages of developing in Synergy/DE.

Elements of Synergy/DE 1-4

Briefly describes each component of Synergy/DE.

Developing an Application 1-7

Illustrates the products and steps you can use to create a Synergy application.

Using the Documentation 1-9

Describes the reference manuals, user’s guides, and online Help that are included with the 
Synergy/DE products.
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What Is Synergy/DE?
Synergy/DE is a full suite of development tools that provides everything you need to create 
powerful, event-driven business applications. It includes tools to write and process your 
applications, design and support your user interface, manage your data from one central location, 
and create comprehensive reports.

An underlying philosophy
If you were building a house, you would need many tools, ranging from the very powerful to the 
very basic. Having these tools readily available would reduce the time and maximize the efficiency 
with which you could complete the job. This same principle applies to developing a business 
application: Well-chosen, accessible tools make the job a lot easier. Using the right tool for the right 
job is the fundamental philosophy of Synergy/DE.

Using Synergy/DE, you can focus most of your resources on your vertical or custom application, 
because Synergy/DE takes care of your systems-level development. 

Advantages of Synergy/DE
Synergy/DE enables you to

 take advantage of one of the most highly scalable distributed technologies. Unique Synergy 
multi-tier technology enables you to scale your application from one stand-alone machine to an 
enterprise-wide system hosting thousands of users.

 open your Synergy business logic and data to a variety of thin client technologies. Using 
Synergy/DE xfNetLink and xfServerPlus, you can build distributed solutions that enable web 
browsers, Visual Basic .NET front-end applications, ASP.NET, Java, or Synergy thin clients to 
access Synergy routines and database files.

 maintain database independence. Third-party applications can access your Synergy data, and 
your Synergy application can access popular, third-party SQL databases.

 easily create and maintain your application. “Draw” and maintain user interface elements in a 
visual environment. Easily add new features to accommodate your customers’ changing needs. 
Quickly customize and localize your user interface.

 keep your applications portable. Develop your applications in any environment—Windows, 
virtually all UNIX platforms, OpenVMS—and in most cases deploy in other environments by 
simply relinking.

 save time. Save development and maintenance time by creating and reusing object and 
executable libraries. Call routines or share information with applications written in other 
languages.

 use functional depth. Develop complete applications by working only at the high level, such as 
in Composer or by calling environment-supplied subroutines, or drop down to the core level 
where you have complete flexibility to customize all aspects of your application. 
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 manage the development process. Eliminate duplication of work by reusing supplied and 
custom libraries and centralizing all data definitions where the entire development team can 
access them and ensure consistency between efforts.

 reduce maintenance. Centralizing data definitions and libraries means that changes can be 
made in one central location rather than throughout thousands of lines of codes.
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Elements of Synergy/DE
The following Synergy products comprise Synergy/DE:

Professional Series
Both Professional Series Workbench and Professional Series Development Environment include 
the components listed below. In addition, Professional Series Workbench provides an interface that 
not only launches all of these components but features a Synergy DBL–sensitive visual editor as 
well as project management tools. (Professional Series Workbench is only available on Windows.)

UI Toolkit
UI Toolkit gives you all you need to create your application’s user interface, including an extensive 
set of subroutines to handle your environment maintenance and menu, input, text, selection, and list 
processing.

Figure 1-1. The components of Synergy/DE.

Connectivity
Series

xfSeries

Professional
Series

(Workbench or
Development
Environment)
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Composer (Windows only)
Composer is an interactive user-interface design tool. You “draw” windows and input windows just 
the way you like, graphically assigning properties that are immediately reflected on your screen, 
and Composer generates the appropriate script commands to define your objects. Composer also 
accepts predefined input windows and fields from Repository, so you can view and modify them 
graphically.

Repository
Repository is the tool you use to define and maintain the data that will be used in your application 
or in reports that can be created with Synergy/DE ReportWriter or xfODBC. It provides a method 
of managing data structures and fields in one centralized location, so that you can modify a field 
throughout your application simply by changing one definition in your repository.

Synergy DBL
Synergy DBL is a high-level business programming language that encourages structured, 
system-independent, modular code. Beyond the basic statements that specify processing to be 
performed, Synergy DBL includes a large number of prewritten external subroutines and functions, 
a source-level debugger, graphical user interface support, and a fast and efficient 
system-independent file structure.

Synergy DBMS
The Synergy DBMS system includes everything needed to create and manage high-speed, keyed 
access and ordered sequential access databases.

ReportWriter
ReportWriter is an end-user application that retrieves, integrates, and consolidates data into 
columnar, ad hoc reports. You can customize and include ReportWriter as part of your application, 
either predefining reports for your customers to run or enabling them to design their own reports.

Synergy Runtime
Synergy Runtime supports the actions requested by your Synergy/DE applications during 
execution.
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Connectivity Series

SQL Connection and Synergy database drivers
SQL Connection is Synergy/DE’s SQL API that works in conjunction with the appropriate database 
driver to enable a Synergy application to access SQL data sources (typically RDBMSs). 
Synergy/DE provides database drivers that enable SQL Connection access to popular databases 
such as Oracle and SQL Server.

SQL OpenNet
SQL OpenNet provides the middleware needed if your Synergy SQL application will be accessing 
remote RDBMSs (residing on a remote computer on your network).

xfODBC
xfODBC opens Synergy DBMS data to any third-party, 32-bit ODBC application. It supports 
version 2.5 of the ODBC API (level 1) and uses SQL OpenNet for remote data access.

xfSeries

xfServer
xfServer processes network client requests for Synergy DBMS data. Residing on the same 
computer as the Synergy databases, the server can serve data to any Synergy application running 
with a Synergy runtime (version 6.1 and higher). 

xfServerPlus
xfServerPlus handles the remote execution of Synergy routines. in conjunction with xfNetLink.

xfNetLink
xfNetLink provides three methods for accessing Synergy logic:

 xfNetLink Synergy Edition, which is a set of routines that work in conjunction with 
xfServerPlus to execute Synergy routines stored on a remote machine

 xfNetLink Java Edition, which works in conjunction with the Java™ programming language

 xfNetLink .NET Edition, which works in conjunction with Microsoft’s .NET Framework
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Developing an Application
Figure 1-2 illustrates how you can use Professional Series to develop your application.

Figure 1-2. Developing an application with Synergy/DE.
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Developing a distributed application
Synergy/DE also provides the capability to design and deploy your Synergy application in two-tier 
or multi-tier systems. See chapter 9, “Accessing Logic Remotely with xfServerPlus.” The xfNetLink 
& xfServerPlus User’s Guide provides additional information about building a distributed 
computing system.
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Using the Documentation

Getting Started with Synergy/DE
This manual is primarily intended for experienced developers who are new users of Synergy/DE 
tools. It provides a technical overview of all components of Synergy/DE, as well as a task-oriented 
“cookbook” for developing with Professional Series. Like a tutorial, this guide walks you through 
the basic tasks (illustrated in figure 1-2) that you will perform as you develop your Synergy 
application. It also discusses client/server, web, and .NET development.

Online Help
Composer has a complete online Help system, including context-sensitive help. The Composer 
Help system provides online instructions for performing any task in Composer. You can search for 
information about any topic and then display that information, with hypertext links to additional, 
related information, on the screen. The context-sensitive help informs you to how to proceed from 
the current point or defines your current options. Workbench also has an online Help system, as do 
many of the Synergy/DE utilities.

Synergy/DE reference manuals and user’s guides
Here’s a list of other manuals that will assist you in using Synergy products:

 Synergy DBL Language Reference Manual 

Describes the syntax of all statements, functions, subroutines, compiler directives, utilities, and 
environment variables included in Synergy DBL. Also documents other DBL features, such as 
program organization, expressions, indexed sequential access method (ISAM), system options, 
compiler and runtime errors, the message controller, and the debugger.

 Synergy Tools 

Describes the programming tools that are used with Synergy DBL: the compiler, linker, 
librarian, and runtime; the debugger; the Synergy DBMS file management system; and general 
utilities. Also documents the Synergy DBL error messages.

 Environment Variables & System Options 

Lists and discusses all of the environment variables and system options available in 
Synergy/DE.

 UI Toolkit Reference Manual 

Describes the syntax of all Toolkit subroutines and utility programs, which are used to create 
and maintain state-of-the-art user interfaces.
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 Repository User’s Guide 

Explains how to define data in Repository and describes its utility functions. Also describes the 
syntax of Synergy Data Language statements and Repository information-retrieval 
subroutines.

 ReportWriter User’s Guide 

Explains how to use ReportWriter to access and organize your data into useful reports. 
Includes a tutorial and describes the ReportWriter utility functions.

 SQL Connection Reference Manual 

Describes how to access SQL databases from Synergy applications.

 Professional Series Portability Guide 

Discusses the functions, requirements, and processes that are unique to each of the platforms 
on which Synergy/DE runs, so that you can design your application to be as portable as 
possible.

 xfODBC User’s Guide 

Describes how to access Synergy databases from ODBC applications.

 Installation Configuration Guide 

Provides information about using License Manager to license your Synergy products, 
configuring a client/server system with xfServer, and installing and configuring Connectivity 
Series products. Also includes general information on Synergy/DE installation and operating 
system requirements.

 xfNetLink & xfServerPlus User’s Guide 

Describes how to build a distributed Synergy application with a Synergy, Java, or .NET 
front-end that enables you to access Synergy routines and data remotely.

 Synergy/DE Quick Migration Guide 

Describes the changes you need to make to your code when upgrading to the latest version of 
Synergy/DE. 
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2
Developing Your Application in 
Workbench

This chapter introduces you to the Professional Series Workbench, a visual development 
environment that includes the Professional Series Development Environment toolset, an integrated 
launch pad that brings these tools together, Synergy DBL–sensitive code editing capabilities, and 
project management tools. Professional Series Workbench is only available on Windows.

What Is Professional Series Workbench? 2-3

Defines Professional Series Workbench.

Where Do You Begin? 2-4

Describes how to set up the startup environment and how to run Workbench.

Accessing Synergy/DE Tools 2-8

Explains how to launch Synergy/DE tools from Workbench.

Setting Up Your Development Environment 2-9

Describes the benefits of using workspaces and projects and explains how to create them.

Editing Synergy Code with the Workbench Editor 2-16

Explains how to edit a file, automate code formatting and completion based on your own company 
style, display popup help for routine syntax, and work with documentation comments and tag files.

Generating Synergy Code Segments 2-27

Describes how to use aliases and code templates to quickly generate Synergy DBL/UI Toolkit code 
for some of the more common code structures, including your own method routines.

Analyzing Your Code 2-33

Describes the analysis tools that can help you identify which routines are called by a specified 
routine and which routines call a specified routine.

Compiling, Building, Running, and Debugging 2-36

Describes how to compile, build, and run your project from Workbench, as well as how to 
customize compile, build, debug, and execute commands for individual projects.
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Customizing Your Development Environment 2-38

Discusses how to customize the way a project is opened, define script extensions other than .wsc, 
add your own commands to the Workbench menu, add or remove buttons from the Workbench 
toolbar, change the tagging delay or turn tagging off completely, access the version control tool of 
your choice, and copy or save your customization settings.

Using Workbench for Non-Windows Development 2-46

Describes how you can use NFS-based mapped drives or FTP to make Workbench your primary 
editor on non-Windows systems.
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What Is Professional Series Workbench?
Professional Series Workbench is an enhanced version of the Professional Series Development 
Environment (PSDE). Workbench makes moving between Repository, Composer, and other 
Synergy/DE components easier as you develop your applications. Workbench’s smart, fully 
customizable language-sensitive editor provides color coding, automatic indenting, standardized 
code templates, project tag capability for recognizing and accessing routine code, and many other 
code-automating features. It enables you to take advantage of automated script compiling and many 
other features that can streamline your development efforts. 

In short, Workbench can help you spend less time writing and debugging, ensure standard coding 
practices, and speed your applications to market. 

The Workbench editor is based on SlickEdit® technology from SlickEdit, Inc.
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Where Do You Begin?

Starting Workbench
Depending on what version of Windows you’re running, do one of the following:

 On versions prior to Windows 8, select Start > All Programs > SynergyDE > Workbench.

 On Windows 8, go to the Start screen and select the Workbench tile.

 On Windows 8.1, go to the Apps screen and select SynergyDE > Workbench.

 On Windows 10, from the Start menu, select All apps > SynergyDE > Workbench.

The Workbench desktop looks like this: 

Figure 2-1. The Workbench desktop.

Project toolbar Edit window Synergy/DE toolbar

Message area and command line Output toolbar
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Running Workbench for the first time after installation runs the update_synergy command, which 
initializes Workbench and creates the SlickEdit configuration directory, C:\Documents and 
Settings\user\My Documents\My SlickEdit Config\version, where user is the user name of the user 
who is currently logged in and version is the current version of SlickEdit in the format x.x.x (for 
example, 10.0.2). 

Defining the startup environment
Setting environment variables and initialization settings enables you to control program 
functionality externally without modifying your code. For a more complete discussion of the 
advantages of environment variables, refer to “Referencing data indirectly” on page 5-18. For a list 
of all environment variables and initialization settings available to Synergy/DE and instructions on 
how to set them, refer to the “Environment Variables” chapter of Environment Variables & System 
Options.

You can define environment variables and initialization settings either in the environment, in the 
synergy.ini file, or in the Open tab of Workbench’s Project Properties dialog box. Synergy.ini is an 
initialization file that contains variables that affect the Synergy runtime and Synergy/DE 
development tools on Windows.

Variables are set in the following order:

 Globally, by selecting Start > Settings > Control Panel > System > Advanced > Environment 
Variables

 At a DOS prompt

 In the synergy.ini file (which is read when the project is opened)

 In the Open tab of the Project Properties dialog box (see “Customizing the way a project is 
opened” on page 2-38) or using syn_set or syn_set_global on the Workbench command line 
(see “Setting environment variables in Workbench” on page 2-6)

Environment variables set in the environment are available to Workbench when it is started. All 
appropriate initialization settings from the [synergy] section of synergy.ini are set in the order in 
which they are specified in synergy.ini. Settings in synergy.ini override any duplicate variables set 
at the environment level. We set the variables from the active synergy.ini when Workbench is 
started and again whenever a Synergy/DE project is opened. We restore the settings from the 
synergy.ini that was active when Workbench was started whenever a project is closed. Settings in a 
project’s Open tab are specific to that project.

Accessing the Workbench command line
Besides enabling you to set environment variables, the Workbench command line can be used to 
execute Workbench or operating system commands and to run other programs. You can display and 
move the cursor to the Workbench command line in one of two ways:

 With your cursor in the edit window, press ESC.

 Click in the message area at the bottom of the Workbench window. (See figure 2-2.) 
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Setting environment variables in Workbench
To set an environment variable when a Synergy project is open,

 At the Workbench command line or in the Open tab of the Project Properties dialog box, enter 
the following command:

syn_set var=value

where var is the environment variable you want to set and value is the value you want to set it 
to. This command overrides any variable set globally, at a DOS prompt, or in synergy.ini while 
the current project is active. If value is empty, Workbench unsets var from the environment 
while the project is open. When the project is no longer active, the variable is unset (or reset to 
its original value if it was already set when Workbench was invoked). 

Figure 2-2. Typing at the Workbench command line.

Workbench command line
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To make Workbench load the environment variables from the [synergy] section of synergy.ini and 
then synuser.ini, 

 At the Workbench command line or in the Open tab of the Project Properties dialog box, enter 
the following command:

syn_set_synergy_ini [path]

where path is the directory path to which the SFWINIPATH environment variable will be set. 
The environment variables will be loaded from the [synergy] section of the synergy.ini and 
synuser.ini files in that path. If path is not specified, Workbench uses the default path for 
synergy.ini and synuser.ini as defined in “Setting Environment Variables and Initialization 
Settings” in the “Environment Variables” chapter of Environment Variables & System Options. 
If syn_set_synergy_ini is not called in the project’s Open tab, it will be called after all project 
open commands.

To reset your environment variables back to what they were when you opened the project,

 At the Workbench command line, enter the following command:

syn_init_proj filename 

where filename is the name of a file that will list the environment variables and initialization 
settings after they are reset. See “Accessing the Workbench command line” on page 2-5 if you 
need help displaying the Workbench command line.

Running Workbench on a Terminal Services machine or in a 
shared configuration
On a Terminal Services machine or in a shared configuration, the update_synergy command only 
creates the SlickEdit configuration directory for the user who is currently logged in. For clients of a 
shared installation, it creates this directory on the client machine. For Terminal Services users, it 
creates this directory on the Terminal Services machine.

Environment variables set with syn_set after syn_set_synergy_ini is called are available 
in the environment for any command that Workbench spawns. Be aware, however, that the 
Synergy tools (dbl, dblink, etc.) may read the [synergy] section of synergy.ini, which will 
override settings made in the spawned environment when these tools are launched from 
Workbench. We recommend that you use syn_set to add environment variables based on 
values in synergy.ini, instead of trying to override variables that are set in synergy.ini. 

We do not recommend using the SlickEdit set command to change the value of an 
environment variable.
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Accessing Synergy/DE Tools
You can start the following tools from the Synergy/DE menu and/or toolbar:

 Composer

 Script

 Repository

 Method Definition Utility

 Synergy/DE Online Manuals

You can launch one of these applications (or to bring it to the forefront) by clicking the relevant 
toolbar button, as shown in figure 2-3, or selecting it from the Synergy/DE menu.

When Composer is selected, if a Synergy/DE project is open and a script file is active, Composer is 
launched with that script file. If no script file is active, or no script files exist in the project, the 
Launch Composer dialog is displayed, where you can select an existing script or create a new script 
to edit in Composer.

The following utilities are available from the Utilities submenu:

 ActiveX Diagnostic utility

 Script-to-Repository Conversion utility

 File Extensions

 Synergy UI Toolkit Control Panel

 Method Definition Utility

 Synergy Type Library Configuration utility

 xfNetLink .NET Configuration utility

 SMC/ELB Comparison utility

 Variable Usage utility

 Synergy Prototype utility

Depending on what project type is open, additional utilities may be available from the Build menu.

Figure 2-3. The Synergy/DE toolbar.
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Setting Up Your Development Environment

Understanding workspaces, projects, and configurations
A workspace is the top level structure in Workbench. It enables you to group related projects 
together and also to save the settings from your editing session. Context Tagging at the workspace 
level provides contextual help for routines and classes across projects. The data for each workspace 
is stored in a text file that has the extension .vpw. 

Projects enable you to specify collections of files and build parameters that operate on those files. 
They facilitate tagging files, restoring edit sessions, compiling from Workbench, customizing 
builds, loading files, and managing version control, and they enable you to define environment 
variables specific to a project. We strongly recommend that you create a project if you want to use 
one or more of these features.

A configuration is contained within the project file. A project can have multiple configurations, 
each with different values for various project settings, to cause different tools and options to act 
upon the same set of working files depending on where or how those files are going to be used. The 
most common use of project configurations is to enable you to have debug and release versions of 
your project without defining two different projects. You might also require 32- and 64-bit 
configurations if your end user has concurrent 32- and 64-bit installations. All of these are included 
as part of your Workbench distribution, but you will need to customize the settings as described in 
“Customizing a configuration” on page 2-14 if you want to use them effectively.

Creating a workspace
Workspaces are usually created when you create a new project. At that time you have the option to 
create a new workspace for the project or add it to the current workspace, if one exists. See 
“Creating a project” on page 2-10. The Create new workspace radio button in the Project tab of the 
New dialog must be selected, as shown in figure 2-4 on page 2-11.

You can also create a workspace outside of a project, for example, if you intend to import existing 
projects or if you want a workspace to edit files that aren’t part of a project, but this isn’t very 
common.

Opening a workspace
From the Project menu, select a recent workspace from the bottom section of the menu. If the 
workspace you’re looking for is not listed, select All Workspaces and then locate your workspace in 
the displayed submenu.
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Creating a project

You can create several types of Synergy/DE projects in Workbench:

For instructions on creating a Java or .NET component project, see the relevant section of the 
xfNetLink & xfServerPlus User’s Guide:

 “Creating a Synergy/DE Java Component Project” in the “Creating Java Class Wrappers” 
chapter

 “Creating a Synergy/DE .NET Component Project” in the “Creating Synergy .NET 
Assemblies” chapter

Projects created prior to 9.3.1 may not have access to all of the features mentioned in this 
chapter.

If you want the end result to be Select this as the project type

One or more DBRs (multiple source files targeting one or 
more .dbr files) 

Synergy/DE

A DBR (multiple source files and one or more ELBs and 
OLBs, built into a single .dbr file)

Synergy/DE Application

An ELB (multiple source files built in one executable 
library)

Synergy/DE Executable Library 
(ELB)

An OLB (multiple source files built in one object library) Synergy/DE Object Library (OLB)

A COM type library Synergy/DE COM Component

A Java JAR file Synergy/DE Java Component

A .NET assembly Synergy/DE .NET Component

TIP
When developing for .NET, you’ll probably want to create one project for creating an 
assembly and one for creating an executable.



Developing Your Application in Workbench
Setting Up Your Development Environment

Getting Started with Synergy/DE 10.3.3 (5/16) 2-11

To create a regular Synergy/DE project, a Synergy/DE application project, or an executable or 
object library, 

1. From the Project menu, select New. The Project tab of the New dialog box is displayed. (See 
figure 2-4.)

2. Enter the desired information in each field and then click OK. 

You cannot change the project type after the project has been created, so select your 
project type carefully.

Figure 2-4. Creating a Synergy project.
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Select Create project 
directory from project name 
to create a directory with the 
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The Project Properties dialog box is displayed. (See figure 2-5.) From here you can add files to a 
project and define other project settings.

3. From the Files tab of the Project Properties window, click Add Files to add files to your project. 
The Add Source Files dialog box is displayed. (See figure 2-6.) (You can also add files by clicking 
Add Tree.)

4. Select the files you want to add and click Open. The Project Properties dialog box is redisplayed 
with the files you selected listed in the Project files field. 

5. Exit the dialog box when you’re done, unless you want to define other project properties.

To add additional files (including ActiveX controls) later, right-click on the project in the Projects 
tab of the project toolbar and select Add Files. The dialog box in figure 2-5 is redisplayed.

Figure 2-5. Adding files to a project.
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Using multiple configurations of a project
Workbench is distributed with the following configurations so you can set up different tools and 
options for the 32- and 64-bit release and debug versions of your application (if you need them):

 Release32

 Release64

 Debug32

 Debug64

 All Configurations

Debug32 is the default project configuration. You will need to customize any of these 
configurations that you want to use by changing their settings in the Synergy/DE Options dialog 
box. For example, you can configure your build commands to place the object code in different 
directories or perform a rebuild after switching configurations. 

Note that you can define additional configurations if you need them by clicking the Configurations 
button in the Project Properties dialog. 

Figure 2-6. Adding files to a project.
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Customizing a configuration

The following instructions apply to the Synergy/DE, Synergy/DE Application, Synergy/DE 
Executable Library, and Synergy/DE Object Library project types. To change the prototype, 
compiler, linker, or runtime settings for any of these projects,

1. From the Build menu select Synergy/DE Options. The Synergy/DE Options dialog box is 
displayed. (See figure 2-7.) (You can also get to this dialog from the Tools tab of the Project 
Properties dialog by selecting Synergy/DE Options in the Tool name field and clicking the Options 
button.)

2. In the Settings for field, select the configuration you want to modify. If you are making changes that 
should be applied across all configurations in the project, select All Configurations. 

3. If the files generated by this configuration are to be used on a 64-bit system (even if Workbench is 
currently running on a 32-bit system), check the 64-bit configuration box. This tells Workbench to 
use the 64-bit tool set.

Figure 2-7. Customizing compiler settings.
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4. Enter the desired information in each field on each tab and then click OK. Note that this dialog only 
contains the most commonly used options; you can use the Other options field to specify additional 
options.

The build commands for the debug version need to specify any debug options, and if you’re 
referencing ELBs or OLBs, you’ll need to select the libraries on the Link tab.

Switching between configurations

To change the active configuration, from the Build menu, select Set Active Configuration and then 
select the desired configuration from the submenu.

Adding a project to a workspace
You can add a project to a workspace either when you create that project or later. When you are 
creating a new project, select the Add to current workspace radio button on the Project tab of the 
New dialog box. (See figure 2-4.)

To add a project to a workspace after the project has been created,

1. From the Project menu, select Insert Project into Workspace. The Add Project to Workspace dialog 
box is displayed.

2. Type or select the name of the project file you want to add to the current workspace.

If you select “Generate batch file on build” on the Build tab, your source files must be on the 
same drive as the project file in order for the project to benefit from this feature.

Sharing workspace and project files can cause project corruption or abnormal side effects. 
We strongly recommend that workspace and project files reside on your local hard drive.
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Editing Synergy Code with the Workbench Editor
Professional Series Workbench includes a language-sensitive visual editor that provides

 automatic code indentation.

 Synergy DBL recognition.

 Synergy DBL compiler integration.

 Context Tagging.

 repository awareness.

 context-sensitive routine help.

Setting up automatic code formatting
To set up or customize automatic code indentation,

1. From the Tools menu, select Options > Languages > Application Languages > Synergy DBL > 
General. The Synergy DBL > General pane is displayed. (See figure 2-8.)

2. To make the editor automatically indent a statement correctly when you copy and paste it to nest it 
within another statement, select Use SmartPaste®. 

TIP
We suggest adding the Synergy DBL entry in the Options dialog to the Options Favorites 
menu tree. Select Tools > Options > Languages > Application Languages > Synergy DBL 
and click the Add Synergy DBL to Favorites button. Then click Show Favorites and click the 
plus sign before Synergy DBL to expand the listing.

Figure 2-8. Setting up automatic code formatting and completion.
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3. In the Indent style field, select “Syntax indent.”

4. Select Formatting under Synergy DBL in the tree on the left. The Synergy DBL > Formatting pane 
is displayed. (See figure 2-9.)

5. In the Syntax indent field, type the number of characters that each level should be indented when 
Enter is pressed. The default is 4. 

If Indent with tabs is checked, pressing Tab or Enter will indent with tabs rather than spaces. The 
value in the Tabs field sets the tabbing increment or individual tab stops. 

Figure 2-9. Setting code formatting options.
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TIP
We recommend that the Tabs value be either the same as or a multiple of the value of 
Syntax indent. If these values do not match, tabs will only be inserted when the cursor is 
indented past a tab location. We do not recommend specifying individual tab stops in the 
Tabs field.
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The Workbench editor offers four styles of automatic code indentation to choose from for 
conditional statements (IF, CASE, USING), looping statements (WHILE, REPEAT, FOR), and 
BEGIN-END blocks. When you type such statements, they are automatically indented based on the 
style you have selected. For example, as you type BEGIN beneath an IF statement, both the BEGIN 
and the END statement (which you can specify should be added automatically when BEGIN is 
typed) are formatted and indented according to your chosen style. To set this up,

6. Enter the desired information in the remaining input fields and then click OK. 

All of the above settings are global, rather than project-specific, settings.

Editing a file
You can either create a new file or edit an existing one.

1. Do one of the following:

The file opens in the edit window. (See figure 2-1.)

2. If the file is untitled or if it does not have a .dbl extension, save your file as a .dbl file using the 
Save or Save As command.

3. Type or edit your code, taking advantage of keyword completion and syntax expansion (if desired) 
as explained in the sections below.

4. When you’re done making edits, save your file again.

Taking advantage of keyword completion
After you type a Synergy DBL keyword, the color of the text changes to indicate that the editor 
recognizes a keyword. If the Enable auto-completion and Keywords check boxes in the Synergy 
DBL > Auto-Complete pane of the Options dialog are selected, a drop-down list of possible 
keywords is displayed when you type a partial keyword. Use the up and down arrow keys to 
highlight the desired keyword or alias, and select it by pressing Enter or the spacebar. For instance, 
if you type “exit”, the keywords EXITLOOP and EXITTRY are displayed in a drop-down list.

To Do this

Create a new file Select File > New. 
In the New dialog box, select Synergy DBL from the list of file types. You 
can also specify a filename, location, and whether to place the file in the 
current project.

Edit an existing file Select File > Open. 
In the Open dialog box, type or select the name of the file you want to edit.
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To turn on keyword completion and set the minimum number of characters at which the editor will 
complete the keyword for you, 

1. Select Tools > Options > Languages > Application Languages > Synergy DBL > Auto-Complete. 
The Synergy DBL > Auto-Complete pane of the Options dialog box is displayed. (See figure 2-10.)

2. Select the Enable auto-completion check box.

3. Select the Keywords check box.

4. In the Minimum prefix length field, type the minimum number of characters to type before the 
drop-down keyword list is displayed.

5. Click OK to exit the Options dialog box if you are done modifying options.

Compiler directives, although recognized as keywords, are not automatically completed in 
this way. If you want to customize the color of your keywords and compiler directives, see 
“Customizing keyword color coding” on page 2-42.

Figure 2-10. Setting up syntax expansion.
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Taking advantage of syntax expansion
When syntax expansion is enabled, Workbench inserts the corresponding block-ending keyword(s) 
whenever you type a block-beginning keyword followed by space at the end of a line. Examples of 
block-beginning keywords are CLASS (ENDCLASS), FOR (FROM...THRU), and SUBROUTINE 
(PROC). 

To enable alias expansion and to make Workbench automatically insert block-ending keyword(s) 
for the corresponding block-beginning keywords, 

1. Select Tools > Options > Languages > Application Languages > Synergy DBL > Auto-Complete. 
The Synergy DBL > Auto-Complete pane of the Options dialog box is displayed. (See figure 2-10 
on page 2-19.)

2. Select the Syntax expansion check box.

You can also generate extended block endings (for example, PROC...ENDSUBROUTINE for the 
SUBROUTINE keyword) by doing the following:

3. Select Synergy DBL > Formatting from the tree view on the left. (See figure 2-9 on page 2-17.)

4. Select the Extended Syntax Expansion check box. 

5. Click OK to exit the Options dialog box if you are done modifying options.

Getting help with routine syntax
As you type text in the Workbench editor, you can display help for the current situation. 

Displaying context-sensitive routine help

To display a list of arguments for a subroutine, function, or method,

 Type the routine name, followed by an open parenthesis.

If the routine has more than one definition (for example, a routine with multiple subfunctions), the 
displayed syntax will say “1 of n,” where n is the total number of definitions. You can cycle through 
the definitions by pressing ALT+comma (ALT+,) or clicking on the gray and black arrow buttons in 
the displayed routine help. (You can also press ALT+comma with the cursor anywhere in the routine 
name or syntax to display routine help in the first place.)

As you type each argument in the editor, it is boldfaced in the argument list so you can easily keep 
your place. Optional arguments are displayed in square brackets. (See figure 2-11.)

This procedure works not only for Synergy DBL and UI Toolkit routines but also for your own 
routines. Depending on how your project is set up, you may first need to set up a .dbl-specific tag 
file that references those routines. Refer to “Setting up a .dbl-specific tag file” on page 2-24 for 
more information.
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Displaying a list of valid operations for the current location

To list the valid variables, functions, macros, and so forth that can be used at a specific location, 
press ALT+period (ALT+.) at that location. If there is text before the cursor, the displayed list 
narrows down your options. For example, pressing ALT+period after “u_” provides a list of items 
that begin with “u_”.

If you’re specifying a record or group, when you press period (.) after the record or group, a list of 
all members in that record or group automatically appears. If your cursor is at a field name or class 
variable followed by a period (optionally followed by more text or, for a class variable, by the 
method name) and a right parenthesis, the Workbench editor displays the list of subfields for the 
field in question, matching text as described above. You can do this with repository structures as 
well, as long as you have .INCLUDEd the repository in your source code. (See “Including from a 
repository” in the Discussion for .INCLUDE in your Synergy DBL Language Reference Manual for 
more information.)

Creating and using documentation comments
Documentation comments are special comments containing XML tags that can be extracted and 
processed into a file, thereby making it easier to document routines. If documentation comments 
have been written for a routine, calling the routine or performing a mouseover of the routine name 
in Workbench will show a parsed view of the comments. 

In Synergy, documentation comments are indicated by three semicolons (;;;) as the first text on the 
line. When you type “;;;” on the line before a routine, Workbench automatically generates a default 
documentation comment containing summary and returns sections, as well as a section for each 
parameter that exists. 

Figure 2-11. Displaying context-sensitive help.



Developing Your Application in Workbench
Editing Synergy Code with the Workbench Editor

2-22 Getting Started with Synergy/DE 10.3.3 (5/16)

Text similar to the following is added to your code (unless you’ve edited the expansion text), where 
param_name1, param_name2, etc., are your actual parameter names: 

;;; <summary>
;;; 
;;; </summary>
;;; <param name="param_name1"></param>
;;; <param name="param_name2"></param>
;;; ...
;;; <returns></returns>

If you want to change the automatic expansion of documentation comments, 

1. Select Tools > Options > Languages > Application Languages > Synergy DBL > Comments.

2. Click the Edit Expansion button to edit the documentation comment text that Workbench inserts 
automatically, or change the check box settings in the Doc comments section as desired.

For general information about documentation comments, refer to SlickEdit’s online help file. 

Moving between routines in a single source file
Each named main routine, named function, named subroutine, macro, and 
.INCLUDE is represented on the project toolbar’s Defs tab in a tree view. 
(See figure 2-12.) 

To jump to a particular main routine, function, or subroutine in the source 
file, double-click on the routine name in the project toolbar. 

Figure 2-12. The Defs tab.

Setting up and using collapsible regions of code
A collapsible region is a block of code that you can hide or make visible depending on whether the 
region is collapsed or expanded. 

1. To define a collapsible region, add the .REGION compiler directive at the beginning of the code 
block and the .ENDREGION directive at the end of the code block.

2. Collapse or expand a collapsible block by double-clicking on the - or + in the left margin of your 
Edit window.

To collapse all code regions in the file, select View > Hide #region Blocks from the menu.
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Working with tag files
If you have multiple source files, you’ll probably want to use the editor’s tag file feature. A tag file 
lets you move between files using CTRL commands or get context-sensitive help for routines located 
outside the current file. A tag file is automatically created for each new project with the name of the 
project and the extension .vtg. You can add files to this file or create additional tag files if you 
desire. Once a tag file is created, it automatically updates in the background when you make edits.

The Symbol tab of the output toolbar displays tags for the word under the cursor. If only one tag is 
found, the source file containing the tag is displayed, and you can double-click on it to edit the file. 
Otherwise, the tag symbols are listed, and you can double-click on a tag symbol to go to that tag.

Adding files to the workspace’s tag database
1. From the Tools menu, select Tag Files (or click the Tag Files button on the Symbol tab). The 

Context Tagging - Tag Files dialog box is displayed. (See figure 2-13.)

2. Select the tag file you want to add files to and click the Add Files button. The Add Source Files 
dialog box is displayed.

We recommend that custom tag files be placed in directories outside the Synergy/DE 
directory tree. Any custom tag files should reside on your local hard drive.

If the source file contains a .INCLUDE as the first line in the file, the Symbol tab does not 
display the definition of tag symbols in the file.

Figure 2-13. Adding files to a tag file.

Select the tag file you 
want to add files to

Click Add Files
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3. In the File name field, type or browse for the name of a file you want to add and click the Open 
button. The file you select will be added to the list of files in your tag file.

4. Repeat steps 2 and 3 for as many files as you want to add.

Setting up a .dbl-specific tag file
You might want to set up a separate, extension-specific tag file for files that, for one reason or 
another, you don’t want to include in your project. For example, if you have a set of .INCLUDE or 
source files that you don’t modify very often or that are used by other developers (such as your core 
routines), you probably want to maintain them outside of your project. Setting up separate tag files 
for such files lets you use the editor’s tagging features for all symbols—not just the symbols in your 
project—including being able to view popup help for routines that aren’t part of the current project.

To set up a .dbl-specific tag file,

1. From the Tools menu, select Tag Files (or click the Tag Files button on the Symbol tab).

2. In the Context Tagging - Tag Files dialog box, click the Add Tag File button.

3. In the Add Tag File dialog box, select Synergy DBL from the list and then click OK.

4. In the Add Tags Database dialog box, enter a name for the new tag file and click Open. The default 
filename is tags.vtg. 

5. The Synergy/DE file extensions are listed in the File types field of the Add Tree dialog box. In the 
directory tree below the File types field, select a directory in which to save the tag file (or leave the 
Path blank to select the default location), and then click OK.

6. In the Context Tagging - Tag Files dialog box, click Done when you are finished.

Tagging imported classes
To tag imported classes efficiently, we recommend creating a separate tag file for a specific class, 
namespace, or series of classes and then including that tag file whenever the tags for those classes 
are needed. This feature is especially useful if you use the Synergy .NET assembly API and have a 
large number of imported classes created by the gennet40 utility, because you don’t need to include 
the source files for all of those classes in your project. 

1. Follow steps 1 through 3 of “Setting up a .dbl-specific tag file” above.

2. In the Add Tags Database dialog box, choose a descriptive name and an appropriate location for the 
import tag file and click Open.
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3. In the “Add Tree” dialog, do one of the following:

If the files in your tag file change…

Files in a tag file are not automatically retagged when they change. To retag the contents of a 
tag file,

1. From the Tools menu, select Tag Files (or click the Tag Files button on the Symbol tab).

2. In the Context Tagging - Tag Files dialog box, select the tag file that needs to be retagged.

3. Click the “Rebuild Tag File” button.

4. In the Rebuild Tag File dialog box, select the desired options and then click OK. (Select “Retag 
modified files only” if you only want to retag files that have been modified since the last time they 
were tagged.)

Including a tags database from another project
To include a tags database from another project (for example, your common library routines),

1. From theTools menu, select Tag Files (or click the Tag Files button on the Symbol tab).

2. Click the “Add Tag File” button. 

3. In the Add Tag File dialog box, select Synergy DBL from the list and click OK. 

4. In the Add Tags Database dialog box, select the project tag file that you want to add and click Open. 

To select Do this

An entire directory Select the directory you want to tag and click OK.

Individual file(s) 1. Click Cancel.
2. Select the new tag file in the list and click the “Add Files” button.
3. Locate and select the individual source files to be tagged. Click OK.
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Moving between files in your project
To jump to the definition of a routine or label in the source file (or vice versa), 

1. Place the cursor on the invocation of the routine or label or on its definition.

2. Do one of the following:

For example, placing the cursor over “sub1” in “xcall sub1” and pressing CTRL+period takes you to 
the definition of the subroutine sub1. Pressing CTRL+comma returns to the “xcall sub1” invocation.

Displaying online Help
 Do one of the following:

To move from Press

The invocation of the routine or label to the definition CTRL+period (CTRL+.)

The definition of the routine or label back to the invocation CTRL+comma (CTRL+,)

To find information about Do this

The editor using a table of contents Select Help > Contents

The editor using an index or full-text 
search

Select Help > Search

The editor using a list of frequently asked 
user questions and their answers

Select Help > Frequently Asked Questions

Other Synergy-specific aspects of 
Workbench

Select Synergy/DE > Workbench Help Topics

A specific dialog box or error message Click the Help button in the dialog or message 
box
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Generating Synergy Code Segments
Aliases and code templates are time-saving features of Workbench that generate common 
UI Toolkit code segments and method routines directly into your program.

Using aliases
Workbench provides two types of aliases: directory (stored in the alias.slk file) and 
extension-specific (stored in the dbl.als file). Both are distributed in the workbench directory. 
When they are modified for the first time, they are copied to the SlickEdit configuration directory, 
and the modifications are made to that version of the file. 

Using directory aliases means you don’t have to type in long path names when prompted for a 
filename or directory. For more information about directory aliases, refer to the online Help. (See 
“Displaying online Help” on page 2-26.)

Extension-specific aliases are used for syntax and code expansion, enabling you to generate 
entire sections of code automatically. The remainder of this section describes how to use 
extension-specific aliases.

Before you begin using aliases in Workbench, follow the instructions in “Taking advantage of 
syntax expansion” on page 2-20 to turn on alias expansion.

Invoking an alias
If the file you’re editing has an extension associated with Synergy/DE, you can expand an alias as 
follows:

 Type the alias into the Workbench editor and press the spacebar or Enter.

Each alias displays a Parameter Entry dialog box that prompts you for such information as routine 
name, variable names, and so forth (see figure 2-14 for an example). After you enter the requested 
information, Workbench inserts the alias code into the current source code window, substituting the 
names you specified in the appropriate places.

Figure 2-14. Entering alias parameters.

Type the requested names or IDs 
for the alias code segment you 
want to add to your program
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Workbench is distributed with aliases for the following code segments: 

Code segment Alias

Application move event synmeappmove

Application resize event synmeappsize

Application state changed synmeappstate

Application century method synmecentury

User defined data - check field method synmechkfld

Application close event synmeclose

User defined data - display field method synmedspfld

User defined data - edit display field method synmeedtdsp

Application input override method synmeentrst

User function key override method synmefkey

User help method synmehelp

User utilities method synmeutils

Input field arrive method synmiarrive

Input field change method synmichange

Input field display method synmidisplay

Input field drill method synmidrill

Input field edit format method synmieditfmt

Input field hyperlink method synmihyper

Input field leave method synmileave

List arrive method synmlarrive

List double click method synmldblclk

List leave method synmlleave

List load method synmlload

Tabset method synmtab



Developing Your Application in Workbench
Generating Synergy Code Segments

Getting Started with Synergy/DE 10.3.3 (5/16) 2-29

Customizing an alias
To modify either the code that is generated when you expand an alias or the parameters you are 
prompted for,

1. From the Tools menu, select Options > Languages > Application Languages > Synergy DBL > 
Aliases. (See figure 2-15.)

(You can also view which aliases are available from this pane in the Options dialog box.)

2. Edit as many aliases as you want to and then exit the Options dialog box.

Creating your own alias
1. From the Tools menu, select Options > Languages > Application Languages > Synergy DBL > 

Aliases. (See figure 2-15.)

2. Click the + button in the Alias file section. The Enter New Alias Name dialog box is displayed.

3. Enter the name of the alias you want to create and then exit the Enter New Alias Name dialog box.

Window button method synmwbutton

Window click event method synmwclick

Window close event method synmwclose

Window generic event method synmwevent

Window maximize event method synmwmax

Window minimize event method synmwmin

Window move event method synmwmove

Window restore event method synmwrest

Window scroll event method synmwscroll

Window resize event method synmwsize

Synergy function synfunc

Synergy subroutine synsub

Input processing loop syninp

List processing loop synlist

Tabset processing loop syntab

Code segment Alias
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4. In the edit window of the Synergy DBL > Aliases pane, type the code that will be generated when 
this alias is expanded.

5. Click the + button in the Parameters section. The Enter Alias Parameter dialog box is displayed.

6. Enter the desired information in each input field, as shown in figure 2-16, and then exit the Enter 
Alias Parameter dialog box.

7. Create as many aliases as you want and then exit the Options dialog box or select a different option 
to modify. 

Figure 2-15. Editing an alias.

Figure 2-16. Defining alias parameters.

Type or select 
the name of the 
alias you want to 
modify

Click to define a 
new parameter

Click to modify 
the name, 
prompt, or initial 
value of the 
selected 
parameter

Shows the 
parameters you 
will be prompted 
for when you 
expand the 
selected alias

Click to add a 
new alias

Click to delete the 
selected alias

Click to delete the 
selected parameter

Click to change the order of the 
selected parameter in the 
Parameters dialog box

Type your 
changes to the 
code that will 
be generated 
when the alias 
is expanded

Enter the name of a routine parameter in the 
generated code

Enter the text that will prompt you for 
information about the specified parameter 
when the alias is expanded

Enter an initial value, if any, for this parameter
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Using code templates
Template files enable you to create generic versions of your Toolkit method routines. When the 
drilldown button for a method property of an input field or button is clicked in Composer or 
Repository, Workbench generates the appropriate method routine into the editor. You can then 
customize the routine as desired.

Template files have the extension .tpl.

To expand a template file,

1. In the Application window in Composer, select the input field or button object for which you want 
to generate a method routine.

2. In the Properties window, click the drilldown button for the desired method property. The Choose 
Method File dialog box is displayed in Workbench.

3. Type or browse for the name of the source file that contains or will contain the code for the method 
you selected in Composer. If the file does not exist, it will be created for you.

Customizing template files
You can customize the template files that are distributed with Workbench. The *.tpl files are 
distributed to the workbench\wbsamples directory and then copied to the workbench directory if 
they don’t already exist. If you are in a Terminal Services or shared configuration and you want all 
users to have a version that is different from the distributed version, edit the template files in the 
workbench directory. If only some of the users want to use a modified version, they can copy the 
desired *.tpl files to their SlickEdit configuration directory and then edit those files instead.

Using tokens in template files
In the templates, you can use tokens to represent specific names. For example, structure and field 
tokens enable you to replace generic references to structures and input fields with references to 
actual structure and field names when generating methods for input windows. When Workbench 
inserts the template file’s contents into the specified file, it replaces all instances of the tokens with 
the appropriate structure or field name.

Workbench is distributed with the following tokens:

This token Is replaced with For this method

#STRUCTURE# Structure name Input field

#FIELD# Input field name Input field

#CURSOR# The flashing cursor (so you can begin typing) All

#ROUTINE# Routine name All
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If the field is a repository field, the #STRUCTURE# token is replaced with the repository structure 
name. If the field is not a repository field, the #STRUCTURE# token is replaced with the name of 
the structure the field belongs to in the input window. 

TIP
To avoid potential conflict with the names of tokens we may add in the future, we 
recommend that if you create your own tokens, you either use a character other than the 
pound sign as the delimiter (for example, @token@), or you use a unique prefix (for 
example, your initials, as in #AK_token#).
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Analyzing Your Code
When you must restructure or otherwise modify a routine, it’s important to be aware of possible 
ramifications to other pieces of code. Workbench provides some analysis tools to help you identify 
which routines are called by a specified routine and which routines call a specified routine.

Viewing a call tree of external routines
The call tree utility lists all routines (across multiple source files) called by the chosen routine. You 
can also expand any routine in the call tree to see what routines are called, in turn, by that routine.

The primary objective of this utility is to provide insight into the logical structure of an unfamiliar 
software system. The generated list of called routines can be especially useful when you are 
converting legacy systems into components. Or if you want to expose a method in a component, 
generating a call tree of that method enables you to view all the methods called from that method, 
which can help you determine the scope of work needed to expose the method.

Launching the call tree
A call tree can only be generated when a workspace is loaded.

1. From the Symbols tab of the project toolbar, right click on the routine for which you want to 
generate a call tree. (To locate the routine you want, expand the Workspace folder and then the 
Global Functions or Global Procedures subfolder, depending on whether you’re looking for a 
function or a subroutine, respectively.)

2. Select Calls or uses from the context menu. 

A call tree is displayed for all methods under the selected method. (See figure 2-17.) The call tree 
continues searching through submethods until either there are no more submethods, the 
submethods loop back recursively to an existing method, or the call tree reaches a method that is 
defined outside of the project.

To place your cursor at the beginning of a call in the Workbench editor, double-click on that call in 
the Symbol Uses/Calling Tree window.

Determining what appears in the call tree
To toggle which items are included in the call tree,

1. Right-click in the Symbol Uses/Calling Tree window to display the context menu.

2. Highlight Quick filters in the context menu and then select the items you want to display.
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Viewing where a method is called
When restructuring code for a component, you may want to know where a particular method is 
called, to help you identify which areas of code will be affected by changes to that routine.

Launching the reference utility
References can only be generated when a workspace is loaded.

1. From the Symbols tab of the project toolbar, right click on the routine, class, class member, or local 
field for which you want to generate references. (To locate the item you want, expand the 
Workspace folder and then the appropriate subfolder, depending on what type of item you are 
looking for.)

2. Select References from the context menu. 

Workbench searches all files in all projects in the current workspace to create a list of calls to the 
selected routine or references to the selected class, class member, or local field. The call list is 
displayed in the References tab of the output toolbar. (See figure 2-18.)

To locate a reference in the Workbench editor, double-click on the occurrence in the results 
window, or select the results window and press CTRL+G to move your cursor through the results 
window one line at a time. The appropriate file will be opened in the editor if it is not already open. 
The source line containing the reference is displayed in the preview window in the References tab if 
you highlight the occurrence in the results window.

Figure 2-17. Viewing a call tree.
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Another way to find references
1. From the Search menu, select Find.

2. Enter the name of the method or other item you want to search for and click the Files >> button. 

3. In the Look in field, enter the files or group of files to be searched. If you click the drop-down 
button, you can select <Buffers> to search all open files, <Workspace> to search all files in the 
workspace, <Project> to search all files in the project, or the specified directory to search that 
directory. (Refer to the SlickEdit help for additional information about the Find dialog box or 
appending multiple search targets.)

4. Click OK to search for all places where this method or other name appears in the selected files.

Browsing an ActiveX control
To view all methods and fields within an ActiveX control,

1. Add the ActiveX control to a project if it’s not associated with one already.

2. Select the Symbols tab on the project toolbar to display the Workbench class browser.

3. Locate the ActiveX control by expanding the Workspace folder and then the Packages/Namespaces 
subfolder.

4. Expand the ActiveX control or right-click on it to select an option from the context menu. 

You should be able to view all classes in the control, all methods in each class (including the 
parameters for each method), and all properties in each class.

Figure 2-18. Viewing routine references.
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Compiling, Building, Running, and Debugging
After you’ve typed and edited your code, you can compile, build (or link), and run your project 
directly from Workbench by selecting the desired command from the Build menu or clicking the 
appropriate toolbar button. (See “Customizing and adding commands” on page 2-39 for 
instructions on changing your default commands.)

Checking compilation errors
If Workbench encounters any compilation errors, it displays them in the Build tab of the output 
toolbar, which is below the edit window. You can move between compilation errors in the build 
window as follows:

As you select each error, that line of code is highlighted in the Workbench editor.

Debugging a project
To compile and build in debug mode, make sure Emit debug information (-d) is selected in the 
Compile and Build tabs of the Synergy/DE Options dialog box (Build > Synergy/DE Options). 
When you run the compiler and linker, the object and .dbr files will be created with debugging 
information.

You can also execute a user-defined (or default) debug command by selecting Debug from the 
Build menu.

Saving the current debugger state
The Synergy debugger enables you to save the current debugger state to a file. The debugger state 
includes break points, watch points, and option settings. By specifying the name of this debugger 
state file as the initialization file for the debugger, you can associate a set of debugger commands 
with a project and invoke those commands every time you restart the debugging session.

Use the debugger SAVE command to save the debugger settings to a file. (See the “Debugging 
Synergy Programs” chapter of Synergy Tools for details.)

To move to Do this

The next error Press CTRL+SHIFT+DOWN ARROW

The previous error Press CTRL+SHIFT+UP ARROW

A specific error Click on that error
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To restore the saved debugger commands, 

1. From the Project menu, select Project Properties and then click the Open tab. 

2. In the editing area of the dialog, set the DBG_INIT environment variable to the name of the file that 
contains the saved debugger state. 

When you invoke the Synergy debugger, it will use the specified file to initialize itself.
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Customizing Your Development Environment

Customizing the way a project is opened
To specify commands that will get executed when the project is opened,

1. From the Project menu, select Project Properties and then click the Open tab.

2. Enter the desired commands in the field shown in figure 2-19 and then exit the dialog box. (You do 
not need to close and reopen the project to make these changes take effect.)

The commands that you specify in this dialog box are executed before any initialization settings in 
the [synergy] section of synergy.ini are loaded and set. 

For details about specific commands, select Search from the Help menu and search for those 
commands.

Figure 2-19. Specifying project open commands.

Type any macro commands (one 
command per line) that you want 
executed when the project is 
opened

Select the configuration you want to 
modify. Select All Configurations to 
change the settings for all of your 
configurations 

TIP
To save effort, we recommend setting SFWINIPATH instead of individual settings. (Refer to 
SFWINIPATH in the “Environment Variables” chapter of Environment Variables & System 
Options for details.)
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Customizing and adding commands
You can customize the commands for compiling, building, debugging, and executing for a project, 
for a project type, or for a file with an extension associated with Synergy/DE when no project is 
opened. For example, if you have a version control system, you can specify that the Build command 
on the Build menu is “build” or “make” or any other command you want it to be. Alternatively, you 
can specify a batch file that designates which files to build. 

Workbench also enables you to create any number of tools to perform any desired commands. Two 
customizable tools (User 1 and User 2) are provided for you, or you can create a brand new tool. 
Note that any customized tool you create can only be activated from the menu and cannot be bound 
to a toolbar button or key press.

Customizing commands for a specific project
You can modify the command lines for existing tools or add new tools that can be used by an entire 
project.

1. Open the project if it is not already open.

2. From the Project menu, select Project Properties.

3. In the Project Properties dialog box, select the Tools tab if it’s not already displayed.

4. Enter the desired information in each input field and then exit the dialog box.

Once your project is set up, you can simply select Compile, Build, Debug, or Execute from 
the menu.

Customizing commands for a project type
You can modify the command lines for existing tools (Compile, Build, Debug, and so forth) or add 
new tools that Workbench will use when creating a Synergy/DE project.

1. Close any open workspaces and files.

2. From the Project menu, select New.

3. Click the Customize button.

4. In the Customize Project Types dialog box, select the configuration you want to change the 
template for (for example, Synergy/DE > Synergy/DE) and click the Edit button.

5. In the Project Package for project dialog box, select the Tools tab if it’s not already displayed.

6. In the Tool name field, select Synergy/DE Options and then click the Options button. 

Because Synergex reserves the right to override user settings in future versions of 
Workbench, we recommend you do not change the project packages for “Synergy/DE Java 
Component” or “Synergy/DE .NET Component.”
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7. Enter the desired information in each input field, as shown in figure 2-20. Then exit the dialog box.

All new projects of this type and configuration will inherit these tools when the project is created. If 
a project type has more than one configuration, you will need to customize each configuration 
individually.

Customizing commands for a file being edited outside a Synergy/DE project
You can customize the commands for compiling, building, debugging, and executing on a global 
level when a .dbl file is opened with no open project or workspace.

1. Close any open workspaces and files.

2. From the Tools menu, select Options > Languages > Application Languages > Synergy DBL > 
General.

3. Click the Language Specific Project button.

Figure 2-20. Customizing compiler commands.

Select the 
configuration you 
want to modify

Select the options 
you want the 
compiler to use for 
this configuration
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4. In the Project Properties dialog box, select the Tools tab if it’s not already displayed.

5. Enter the desired information in each input field (see figure 2-20), and then exit the dialog box.

You can add your own commands using the New button, although they will not appear in the menu.

Adding file extensions to Workbench
Workbench enables you to specify your own file extensions for source files, include files, and 
UI Toolkit script files in Synergy/DE projects. For example, unless you specify additional script 
extensions, only scripts with the extension .wsc will be recognized in Composer and Workbench. 
The extensions you specify will be added to the appropriate dialog boxes in Workbench.

To specify a new filename extension for a Synergy/DE project, 

1. From the Synergy/DE menu, select Utilities > File Extensions.

2. Enter the desired information in each input field (see figure 2-21), and then exit the dialog box.

3. If you’ve added a UI Toolkit script file extension and you want the default for a script file to be 
something other than .wsc, change the default extension in Composer by doing the following:

 Run Composer.

 From the Options menu, select Composer.

 Click the File tab, and in the Default Extensions section, change the Script file value. Exit the 
dialog box.

Figure 2-21. Specifying different script extensions.
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Customizing keyword color coding
Synergy keywords, compiler directives, and operators are automatically displayed in a different 
color from the rest of your code. To change the colors that are displayed,

1. From the Tools menu, select Options > Languages > Application Languages > Synergy DBL > 
Color Coding.

2. In the Lexer name field, make sure dbl is selected. 

3. Select the Keywords radio button to change the default keyword color, the Preprocessor radio 
button to change the default compiler directive color, or the Operators radio button to change the 
default operator color.

4. Click the Colors button.

5. In the Foreground color (or Background color or Embedded code) field, click the Click to change 
color button. In the Select a color dialog box, click the desired text color or change the Red, Green, 
and Blue values as desired, and then click OK.

6. Change the color of any other screen element by selecting the one you want to change in the list at 
the left side of the Colors pane and performing step 5.

7. Exit the Options dialog box or select a different option to modify when you’re finished customizing 
colors.

Changing the tagging delay
You can customize how often tagging takes place by changing the number of seconds of idle time 
before tagging begins on a changed buffer. The default value is 3, which means open files are 
retagged immediately after you stop typing or using the mouse. Most people find this value too low. 
To change the tagging delay value, 

1. From the Tools menu, select Options > Editing > Context Tagging.

2. Change the value in the Start after seconds idle field.

You can experiment with this value to find the one that works best for you. Depending on how fast 
you type, you may want to set this value to a number like 15 or 30. (In general, faster typists will 
probably prefer a higher value than slower typists.)

3. Exit the dialog box when you’re finished.

Turning tagging off
To turn off automatic tagging,

1. From the Tools menu, select Options > Editing > Context Tagging.

2. Set Tag file on save and Background tagging of open files to False. 
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When Background tagging of open files is not checked, Workbench only generates tags upon 
request.

3. Exit the dialog box when you’re finished.

Interfacing with version control tools
Workbench provides support for several popular version control systems. To access these tools 
directly from Workbench,

1. From the Tools menu, select Version Control > Setup.

2. In the Version Control Setup dialog box, select the version control system of your choice (or create 
a new one using the Add button). 

3. Click Setup and make any necessary changes to the version control commands, depending on your 
preferences or procedures.

4. Click OK.

The Get and Put toolbar buttons are now enabled.

For additional information, refer to the online Help system (see “Displaying online Help” on 
page 2-26) and select “Version Control” from the index. 

Changing the environment for .NET Component projects
By default, Workbench uses the batch file %VSnnCOMNTOOLS%vsvars32.bat (where nn is 
the highest version of Visual Studio that is installed on the system) to set the environment variables 
used by .NET. (See “System Requirements” in the “Creating Synergy .NET Assemblies” chapter of 
the xfNetLink & xfServerPlus User’s Guide for complete details.) You can specify a different 
environment set-up file. To change the batch file, 

1. Open the project.

2. From the Build menu, select Component Information and click the .NET Environment button.

3. In the .NET Environment Configuration dialog, enter the path for a different batch file in the .NET 
environment batch file field or click the browse button and select the desired file. 

4. Click OK.

Deselecting either of these options may cause all tagging to occur the moment you request 
it, which might cause Workbench to appear to hang.
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Copying customization settings
To copy certain Workbench customization settings to another machine or to another user in a 
Terminal Services or shared configuration, 

1. From the Tools menu, select Options > Export/Import Options.

2. To export all options, click the Export All Options button. To export a specific set of options, click 
the Setup Export Groups button. To import options that have already been exported, click the 
Import Options button.

3. For additional information and instructions, click the Help button in the Export/Import Options 
pane of the Options dialog.

To copy any of the customizations listed in the table below, 

1. If the target machine has a brand new Workbench installation, enter the command update_synergy 
at the Workbench command line before beginning this procedure. Restart Workbench and change 
your editor configuration to match the machine whose configuration you are copying.

2. Copy the desired files below from the source SlickEdit configuration directory to the target 
SlickEdit configuration directory:l

3. If any of your template files have been customized, see “Customizing template files” on page 2-31.

4. Run Workbench on the target machine.

File Description

diffmap.ini Diff dialog settings

oem.vlx Color

project.vpe File extension command settings

ubox.ini Comments

uformat.ini Code formatting

usrprjtemplates.vpta

a. The usrprjtemplates.vpt file is version specific and should therefore only be 
copied to a SlickEdit configuration directory of the same Synergy/DE version.

Project templates

vusrobjs.e User-defined dialog boxes and menus

wbcfg.e Workbench configuration file

wbkeys.e Workbench keymapping file
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5. Change the emulator configuration on the target machine to match the emulator settings on the 
machine from which you are copying.

6. Press ESC to go to the Workbench command line, and enter the command

load_conf

7. Exit Workbench.
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Using Workbench for Non-Windows Development
Even though Workbench is only available on Windows, you can use it as your primary editor for all 
Synergy/DE-supported platforms via distributed computing. There are two options for accessing 
source files:

You will need to use xfServer to access your repository. 

Using NFS-based mapped drives
If you have problems with file loss or corruption, before using an NFS-mapped drive, we strongly 
recommend that you add “-s3” to the end of the command shortcut that runs Workbench. For 
example:

c:\synergyde\workbench\bin\vs.exe -s3

Using the NFS protocol to map a drive enables desktop users on a network to access remote source 
files and window scripts from UNIX and OpenVMS. If this option is too slow, you’ll probably want 
to tweak the performance of your file server. Your NFS software can help you optimize 
performance. 

We also recommend that you turn off automatic tagging in Workbench. (See “Turning tagging off” 
on page 2-42.)

Option Pros Cons

NFS (Network 
File System) 
based mapped 
drives

 An NFS-based mapped drive is 
virtually identical to mapping a 
drive to a Windows server. 

 Projects can be used.
 Composer can be used.

 This option can be slower than FTP, 
although NFS can be optimized for 
better performance. 

 NFS is not a very high-performance 
file server when used on OpenVMS. 

FTP  This option is potentially faster, 
because you only transfer a file 
once and you edit it locally. 

 FTP is not suitable for systems 
using version control. 

 If you have multiple developers, the 
potential exists for overwriting each 
other’s changes. 

 Projects cannot be used. 
 Composer cannot be used.



Developing Your Application in Workbench
Using Workbench for Non-Windows Development

Getting Started with Synergy/DE 10.3.3 (5/16) 2-47

Using FTP
Workbench’s built-in FTP functionality provides the ability to import source code directly into the 
editor from any other system on your network. Once you’ve set up the session protocols, 
Workbench’s FTP tools enable you to edit remote code and compile it with the Windows compiler 
to check for errors. If you’ve set up your code to build on Windows, you can link it and perform test 
runs in the Workbench editor. You can then upload the modified source code to the original 
directory on the original platform simply by saving your work. 

To set up FTP links between Windows and remote platforms, you must do the following:

1. Define your connection if it is not defined already.

2. Start a connection.

3. Open the file you want to edit and make your changes.

4. Transfer the file between your local machine and an FTP host.

5. Close the connection.

Basic instructions follow in the sections below. For additional information, refer to the SlickEdit 
User’s Manual.

Defining a connection
1. From the File menu, select FTP > Profile Manager. The FTP Profile Manager dialog box is 

displayed.

2. If you want to set up any firewall/proxy settings, log file options, or any other default settings, see 
“Customizing your FTP sessions” on page 2-49.

3. Click Add. The Add FTP Profile dialog box is displayed. (See figure 2-22 and figure 2-23.) 

4. Enter the desired information in each field and click OK when you’re finished. 

You can define as many sessions with full specifications as required. You can also create more than 
one session to the same host with each accessing a different remote directory with source files. In 
addition, you can specify the full path to the local work directory into which you want to download 
the code for each session.

Starting a connection
1. In the FTP Profile Manager dialog box, select the connection you want to establish.

2. Click Connect.
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Opening a file for editing
1. After you have started a connection, click the Open tab on the Project toolbar. A listing of FTP files 

is displayed. 

2. Double-click on a file to open it.

3. Edit the file as usual in the edit window. 

Transferring files between your local machine and an FTP host
The FTP Client dialog box enables you to open several FTP sessions at one time and then jump 
from session to session as desired. 

1. From the File menu, select FTP > Client to display the FTP Client toolbar. 

2. Right-click on the local or remote file listing to display a menu of operations from which to choose.

Figure 2-22. Adding an FTP profile.
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subsystem, and 
then select an 
Auth type of Auto
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Closing a connection
1. Open the FTP Profile Manager dialog box (File > FTP > Profile Manager) if it’s not open already.

2. Select the connection you want to close in the Profiles field.

3. Click Close.

Customizing your FTP sessions
You can optimize each session’s protocols for the connecting remote host by customizing your FTP 
sessions in the FTP Options dialog box. From this dialog you can do the following:

 Specify a default password for anonymous log-ins

 Set default case sensitivity for the filenames you bring into Workbench from a UNIX system, 
so you can later upload those filenames back to the original system

 Specify whether you’ll be prompted to upload each time code is saved in the Workbench editor 
(or that code should not be uploaded at all when it is saved)

 Specify how long Workbench will wait for a reply from the FTP server

 Set up firewall and proxy specifications if you are creating FTP sessions on secured networks

 Set up a session log to be created for all FTP sessions

Figure 2-23. Adding an FTP profile (advanced settings).
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To customize your FTP sessions,

1. If you’re in the FTP Profile Manager dialog box, click Default Options. Otherwise, from the File 
menu select FTP > Default Options. The FTP Options dialog box is displayed.

2. Enter the desired information in each field of the appropriate tabs and click OK when you’re 
finished. 
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3
Setting Up Your Repository

This chapter introduces you to S/DE Repository and walks you through defining your data for 
several different uses. We’ve set up a small example for you to practice with, because we believe 
you will learn more quickly by actually performing the steps rather than just reading them. 

For each of the instructional sections of this chapter, you will need to define a structure and its 
fields; we strongly recommend that you begin by following the instructions in the sections 
“Defining a structure” on page 3-3 and “Defining fields” on page 3-4, even if you don’t need to 
define a record layout for use in an application.

What Is Repository? 3-2

Describes what Repository is, how to run it, and how to access context-sensitive help.

Defining a Record Layout for Use in an Application 3-3

Explains how to define the type and size characteristics of your data in Repository so it can be used 
by the Synergy compiler.

Defining User Interface Characteristics 3-7

Explains how to define the visual and behavioral characteristics of your data in Repository so it can 
be used by S/DE UI Toolkit (including Composer).

Defining Files for ReportWriter 3-14

Explains how to define additional visual and relational characteristics in Repository so your data 
can be used by Synergy/DE ReportWriter.

Defining a Database Schema for xfODBC 3-20

Tells where to find instructions for using Repository with xfODBC.



Setting Up Your Repository
What Is Repository?

3-2 Getting Started with Synergy/DE 10.3.3 (5/16)

What Is Repository?
Repository enables you to define the structure of your data in a centralized location, without 
redundancy. Repository can then supply this information to the Synergy compiler for processing 
application files, to Composer for building a user interface, and to ReportWriter for creating 
reports. 

Because data is only defined once, changes need only be made once. For example, if you want to 
expand a field that appears throughout your application, one simple change to your repository does 
the trick. 

Starting Repository
To start Repository, do one of the following:

 From the Workbench toolbar, select Repository.

 At a command prompt, type 

dbr RPS:rps

(If you are not in the directory that contains dbr.exe, DBLDIR\bin must be in your path.)

Getting help
From any field in any input window in Repository, you can access context-sensitive help for that 
field. If you’re not sure what information to enter in a field,

1. Place your cursor in the field.

2. Press F1 or click the Help button. 

Displaying a list of valid data for a field
Many fields in Repository also enable you to display a list of available selections. To display such a 
list,

 With your cursor in the field, select List Selections from the menu. 

See also
Your Repository User’s Guide. This includes instructions for using all features of Repository, as 
well as information about Repository utilities, the Synergy Data Language (which describes the 
contents of a repository), and the subroutines that enable you to access repository data from within 
an application.
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Defining a Record Layout for Use in an Application
The most efficient way to define data fields is in one central location—a data repository—rather 
than in each of the programs that make up your application. The same definitions can then be 
accessed by multiple applications across multiple systems. 

You will first need to define a structure and then define the data fields required by your application, 
including the data type and size of each field.

As an example for this chapter and the ones that follow, we’ve designed a simple application that 
maintains business contact information. It requires the following data fields:

company ,a45
address ,a45
city ,a25
state ,a2
zip ,d5
salutation ,a4
lname ,a16
fname ,a16
contact ,a32
phone ,d10
fax ,d10
modem ,d10
email ,a47
notes ,a47
type ,a10
status ,a10
sl ,d1
tk ,d1
rps ,d1
pvcs ,d1
odbc ,d1
dte ,d1

Defining a structure
The first step in defining a record layout is to create a new structure. In Repository, the term 
structure refers to the entire record definition, or the combination of field and key characteristics. 

To define a structure,

1. From the Modify menu, select Structures.

2. From the Structure Functions menu, select Add Structure.

The Structure Definition input window is displayed. (See figure 3-1.)

3. Enter the desired information in each input field and then exit the input window. 
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Defining fields
To define the necessary fields in your new structure, along with their data types and sizes, 

1. With the new structure highlighted, select Edit Attributes from the Structure Functions menu.

2. From the Attributes menu, select Fields.

3. From the Field Functions menu, select Add Field.

The Field Definition input window is displayed. (See figure 3-2.)

4. Enter the desired information in each input field, using the example fields listed on page 3-3, and 
then click the OK button. (You can also define display, input, validation, and method information 
by moving to those tabs before clicking OK. These tabs are discussed in “Defining field attributes” 
on page 3-9.)

Make sure the Excluded from Language field is not checked; you will need to be able to access the 
fields you define later. You can ignore the Template overrides section for this example. 

5. Repeat steps 3 and 4 for each field you want to define. We suggest you define all of the example 
fields except the fax, modem, and notes fields, which you can define by following the instructions 
in “Defining a field by copying an existing one” on page 3-5. 

Figure 3-1. Defining a structure.
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Enter a unique and 
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or select None if the structure requires no tag.
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Defining a field by copying an existing one
If a field you’re defining is similar to an existing field, you can make a copy of the first field and 
then modify it to create a new field. For example, in our sample application, you can create the fax 
and modem fields by copying the phone field.

To copy a field,

1. Highlight the field you want to copy in the Field Definitions list.

2. From the Field Functions menu, select Copy Field.

3. Enter a unique name for the new field and modify the information in any of the remaining input 
fields as desired; then exit the input window.

Figure 3-2. Defining a field.
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field is a 
group
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Reordering fields
The order in which the fields are listed determines the order in which they will exist within the 
structure. To move a field definition,

1. Highlight the field you want to move in the Field Definitions list.

2. From the Field Functions menu, select Reorder Fields.

The highlighted field is now enclosed in square brackets ([ ]), indicating that it can be moved.

3. Use the UP ARROW and DOWN ARROW keys to move the bracketed field to another position in the 
list.

4. Select Reorder Fields again to get out of move mode.

Saving your structure
When you attempt to exit the structure you’re working on, Repository prompts you to save your 
changes.

To save your structure when exiting,

1. From the General menu, select Exit as many times as necessary. (For example, from the Field 
Definitions window, you’ll need to select Exit twice.)

2. Select Yes when prompted to save your changes.

You can either define another structure in the Structure Definitions list or you can select Exit again 
to return to Repository’s main menu.
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Defining User Interface Characteristics
The data fields you define in Repository can be read into Composer as predefined input fields. Such 
centrally defined defaults simplify the process of supporting an application: when you modify a 
repository definition (and rebuild the applications that use that repository), that change is inherited 
by every object that refers to the original definition—regardless of which application the object is 
in. As a result, not only are the data definitions consistent from one application to another, but the 
user interface is consistent as well. In addition, many changes required to localize or customize an 
application can be accomplished by making changes in the repository, which enables you to 
customize your user interface more quickly, with less chance of error.

When you define fields for use in Composer, you’ll want to define not only the fields themselves 
but also the fields’ attributes and formats. Then, once you’ve added the fields to an input window in 
Composer, you can modify the fields and add features in the interface designer’s visual, 
WYSIWYG environment.

Here’s what the primary input window in our example application is going to look like:

Defining a structure
Just like when you defined data fields for use by the Synergy compiler, the first step is defining a 
structure, as described on page 3-3.

Instead of defining another new structure here, you can use the structure you created on page 3-3 
for our example user interface.

 From the Modify menu, select Structures.
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Defining how input is redisplayed in a field
When you define your fields’ display attributes, you will have the option of selecting a predefined 
format to use when data is entered. For example, in our sample user interface, we’d probably want 
to assign a display format for the telephone number fields, Phone, Fax, and Modem.

So, to plan ahead, you can define two types of formats:

 Global

 Structure-specific

A global format can be used by a field definition in any structure. A structure-specific format is 
defined for a particular structure and can only be used by the fields in that structure.

To define a structure-specific format,

1. Highlight the structure for which you want to define a format in the Structure Definitions list.

2. From the Structure Functions menu, select Edit Attributes.

3. From the Attributes menu, select Formats.

4. From the Format Functions menu, select Add Format.

The Format Definition input window is displayed. (See figure 3-3.)

5. Enter the desired information in each input field and then exit the input window.

6. Repeat steps 4 and 5 for each additional format you want to define.

7. From the General menu, select Exit.

If you want your format to be global instead of structure-specific, simply define it by selecting 
Formats from the Modify menu in Repository’s main menu. Steps 4 through 7 are the same, 
regardless of the type of format you defined.

Figure 3-3. Defining a format.
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Defining fields
The next step in creating a user interface is to define the required input fields. In our example, we’re 
going to use the same fields we defined on page 3-4. 

1. With your structure highlighted, select Edit Attributes from the Structure Functions menu. (If the 
Attributes menu is already present on your menu bar, go directly to step 2.)

2. From the Attributes menu, select Fields.

3. To view or edit the definition for an existing field, highlight that field and press ENTER. 

4. Make sure the Excluded from Toolkit field is not checked for any of the fields; you will need to be 
able to access the fields you define later.

Defining field attributes
Because we are designing a user interface, we need to define the appearance of each field on the 
screen as well as the field’s behavior.

Determining how the field will look
Repository refers to the field’s appearance as “Display information.” To specify display information 
for a field from the Field Definition input window,

1. On Windows, click the Display tab or press CTRL+TAB until the Display tab is displayed. On UNIX 
or OpenVMS, press TAB until the Display tab is displayed. (See figure 3-4.)

2. Enter the desired information in each input field and then exit the dialog box or move to a different 
tab in the dialog box to define additional information.

(You can also get to the Display tab from the Field Definitions list. Highlight the field you want to 
modify, and select Edit Display Information from the Field Functions menu.)

Determining how the field will behave
Repository breaks down the field’s behavior into the categories “Input,” “Validation,” and 
“Methods.” Input information determines how input must be entered and how it will be displayed 
and interpreted. Validation information defines what input is considered valid. Method information 
specifies any arrive, leave, drill, hyperlink, or change method subroutines associated with a field. 

Specifying how input will be entered and displayed

To specify how input will be entered and displayed, do the following from the Field Definition 
input window:

1. On Windows, click the Input tab or press CTRL+TAB until the Input tab is displayed. On UNIX or 
OpenVMS, press TAB until the Input tab is displayed. (See figure 3-5.)

2. Enter the desired information in each input field and then exit the dialog box or move to a different 
tab in the dialog box to define additional information.
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(You can also get to the Input tab from the Field Definitions list. Highlight the field you want to 
modify, and select Edit Input Information from the Field Functions menu.)

Specifying how input will be validated

To specify how input will be validated, do the following from the Field Definition input window:

1. On Windows, click the Validation tab or press CTRL+TAB until the Validation tab is displayed. On 
UNIX or OpenVMS, press TAB until the Validation tab is displayed. (See figure 3-6.)

2. Enter the desired information in each input field and then exit the input window or move to a 
different tab in the dialog box to define additional information.

(You can also get to the Validation tab from the Field Definitions list. Highlight the field you want 
to modify, and select Edit Validation Information from the Field Functions menu.)

Figure 3-4. Defining display information.
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Specifying method subroutines for a field

You can assign the following types of method subroutines to an input field:

 Arrive method

 Leave method

 Drill method

 Hyperlink method

 Display method

 Edit format method

 Change method

Figure 3-5. Defining input information.
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An arrive method subroutine is called to perform special processing before an input field is 
processed, while a leave method subroutine performs additional processing after an input field is 
processed (for example, validating the input).

If a drill method subroutine is specified, a drilldown button is displayed after the field in 
Windows environments. The subroutine is called when the user clicks the drilldown button 
(in Windows) or selects a drilldown menu entry (in Windows or non-Windows 
environments). A drill method is primarily used to look up additional information or 
display an input window.

Figure 3-6. Defining validation information.
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A hyperlink method subroutine is called when the user clicks on an input field prompt. When a 
prompt is associated with a hyperlink method, that prompt is a hyperlink and the foreground color 
of the prompt is green.

A change method function is called after a field is validated by the UI Toolkit I_INPUT subroutine. 
It performs additional processing after an input field is changed (for example, validating radio 
button and check box fields).

A display method function is called before UI Toolkit displays the contents of an input field. Your 
display method can modify the display format of the input field, as well as its color and attributes, 
thus enabling you to override Toolkit’s display format for the field.

An edit format method function is called before UI Toolkit has formatted the contents of an input 
field to be edited. Your edit format method can modify the edit format of the input field, as well as 
its color and attributes, thus enabling you to override Toolkit’s edit format for the field.

To specify method subroutines for a field, do the following from the Field Definition input window:

1. On Windows, click the Method tab or press CTRL+TAB until the Method tab is displayed. On UNIX 
or OpenVMS, press TAB until the Method tab is displayed. (See figure 3-7.)

2. Enter the desired information in each input field and then exit the input window or move to a 
different tab in the dialog box to define additional information.

(You can also get to the Method tab from the Field Definitions list. Highlight the field you want to 
modify, and select Edit Method Information from the Field Functions menu.)

Figure 3-7. Defining method information.
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Defining Files for ReportWriter
Repository seamlessly supplies information to Synergy/DE ReportWriter for creating reports. 
When you define fields for use in ReportWriter, you need to define not only the fields themselves 
but also the way the field will be used and displayed in a report, the keys that determine the 
relationships between files and how those keys will be linked with keys from other structures, and 
which files use which structures.

Defining a structure
As when you were defining data fields for use by the Synergy compiler, the first step is defining a 
structure.

1. From the Modify menu, select Structures.

2. Select the structure you defined on page 3-3.

Defining fields
The next step in creating a user interface is to define the required input fields. In our example, we’re 
going to use the same fields we defined on page 3-4.

1. With your structure highlighted, select Edit Attributes from the Structure Functions menu. (If the 
Attributes menu is already present on your menu bar, go directly to step 2.)

2. From the Attributes menu, select Fields.

3. To view or edit the definition for an existing field, highlight that field and press ENTER. 

4. Make sure the Excluded by ReportWriter field is not checked for any of the fields; you will need to 
be able to access the fields you define later.

Determining how each field will be displayed in a report
In addition to defining the field’s general appearance, which we did on page 3-9, “Display 
information” contains field data that affects how the field is used and displayed in a report.

To specify display information for a field,

1. Highlight the field you want to modify in the Field Definitions list.

2. From the Field Functions menu, select Edit Display Information.

The Display Information input window is displayed. (See figure 3-8.) 
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3. Enter the desired information in the Report hdg, Format name, and Report just input fields and then 
exit the input window. (See page 3-15 for instructions on predefining a format.)

4. Repeat steps 1 through 3 for each field you want to define. 

Defining a format
When you specify display information for a field, you can specify a predefined format to use with 
that field in a report generated by ReportWriter.

If you defined a format for an input field on page 3-8, you can use that same format here. 
Otherwise, follow the instructions on page 3-8 to define a display format.

Defining a key to your record
A key is the portion of the data record that identifies the record and is used to access it. For 
example, if you define a company name field as a key with no duplicates, a record can be uniquely 
identified based on the company name. The keys you define in Repository also determine what 
relationships you can set up between database files, which in turn determine what additional 
information ReportWriter can access outside of a particular file. 

Figure 3-8. Defining how a field will be displayed in a report.
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The first key you define (or the first key in the list) is the primary key. A primary key must be an 
access key. 

To define a key, 

1. Highlight the structure you want to define a key for in the Structure Definitions list.

2. From the Structure Functions menu, select Edit Attributes.

3. From the Attributes menu, select Keys.

4. From the Key Functions menu, select Add Key.

The Key Definition input window is displayed. (See figure 3-9.) 

Figure 3-9. Defining a key.
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5. Enter the desired information in each input field and then exit the input window.

6. Repeat steps 4 and 5 for each key you want to define.

7. When you’re finished defining keys, select Exit from the General menu. 

Defining a relation between two structures
To enable ReportWriter to cross-reference data between files, you must create relations between 
structures. A relation enables you to link the keys of one structure with the keys of another 
structure. For example, if you relate a company name key in a contact management file with a 
company name key in a sales transaction file, ReportWriter can access sales information for each 
company when you create a report of your business contacts. We recommend that you set up every 
relation you can think of that a ReportWriter end user might possibly need. 

To define a relation, 

1. Highlight the structure you want to define a relation for in the Structure Definitions list. (If the 
Attributes menu is already present on your menu bar, skip steps 1 and 2 and go directly to step 3.) 

2. From the Structure Functions menu, select Edit Attributes.

3. From the Attributes menu, select Relations.

4. From the Relation Functions menu, select Add Relation.

The Relation Definition input window is displayed. (See figure 3-10.) 

5. Enter the desired information in each input field and then exit the input window. 

6. Repeat steps 4 and 5 for each relation you want to define.

Figure 3-10. Defining a relation.
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Defining a file
Defining your database files through Repository enables you to access those files from 
ReportWriter. Once you define a file you can assign one or more structures to it, thus specifying 
which structures can be used to access that file.

To define a file,

1. From the Modify menu in Repository’s main menu, select Files.

2. From the File Functions menu, select Add File.

The File Definition input window is displayed. (See figure 3-11.)

3. Enter the desired information in each input field and then exit the input window.

4. Assign a structure to this file by following the instructions in “Assigning a structure to a file” on 
page 3-19.

Figure 3-11. Defining a file.
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Assigning a structure to a file
You must assign a structure to a file in order for the file to be able to use that structure. You can only 
assign a structure that has the same file type as the file to which you’re assigning.

1. From the File Definitions list, select Assign Structures from the File Functions menu.

2. From the Structure Functions menu, select Add Structure.

3. Enter the name of a structure to assign to the file.

4. Repeat steps 2 and 3 for each structure you want to assign.

5. From the General menu, select Exit twice to return to Repository’s main menu.
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Defining a Database Schema for xfODBC
A component of xfODBC, the dbcreate utility, uses repository data definitions to generate a system 
catalog, which prepares a Synergy database for ODBC access. A system catalog describes a 
Synergy database in a way that the xfODBC driver can understand. You can run dbcreate either 
from the command line or from within the xfODBC Database Administrator (DBA).

When you define data for use by xfODBC, your repository should contain a complete set of 
structures, tags, fields, and file information; templates for similar fields; and well-chosen keys and 
relations. See “Setting Up a Repository” in the “Preliminary Steps” chapter of the xfODBC User’s 
Guide for detailed instructions.
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4
Designing Your User Interface

Now that you’ve set up your repository, you can start designing your user interface. This chapter 
introduces you to S/DE Composer, UI Toolkit’s visual user interface designer for Windows 
environments. We will take you through the steps of designing an input window and several of the 
objects it can contain. 

Important Terminology 4-2

Defines several of the terms used in this chapter.

What Is Composer? 4-3

Describes what Composer is, what it looks like, and how to run it.

Using Composer 4-8

Walks you through the design of an input window that contains predefined input fields imported 
from your repository, radio buttons, check boxes, selection list fields, a drilldown to a second input 
window, lines, standard input fields, and command buttons. This section also describes how to save 
and close a script file, close a project, and compile your script.
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Important Terminology

What is an object?
In this manual, when we refer to an object we mean any window, list class, menu column, window 
field, input field, selection window entry, menu entry, text, line, box, or button. Each object is an 
independently designed element that has certain characteristics and values and exhibits certain 
behavior.

What is a window?
The term window refers to the window you’re designing and encompasses general windows, input 
windows, and selection windows. 

 A general window usually conveys information, such as error or informational messages.

 An input window contains one or more defined input fields into which the user can enter data. 

 A selection window contains a group of predefined selections from which the user can choose.

What are attributes and properties?
An attribute is a characteristic of an object, and a property is the value of an attribute. For example, 
color is an attribute, and red is a property. 

What is a script file?
A script file is an editable text file that contains special script commands to define and control user 
interface objects and their characteristics. When you design your user interface in Composer, the 
script commands are generated into a script file for you. Once your script file is created, it must be 
compiled.

The advantage of using script files is that your user interface objects are defined outside of your 
programs. You can modify object properties without changing or recompiling your Synergy DBL 
subroutines.

What is a project?
Composer organizes your script files in projects. A project is a collection of one or more related 
script files (for example, all of the script files for a particular application).
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What Is Composer?
S/DE Composer is a powerful user interface designer that enables you to create the elements of 
your interface graphically using the mouse and keyboard on Windows systems. You can easily 
move, resize, and change the characteristics of your interface objects in a WYSIWYG environment. 
Then, after you interactively design your general windows and input windows, Composer will 
generate the appropriate window scripts.

Starting Composer
To start Composer, do one of the following:

 From the Workbench toolbar, select Composer.

 At a command prompt, type 

dbr SYNBIN:composer

If you are not in the directory that contains dbr.exe, DBLDIR\bin must be in your path. 
Likewise, the SYNBIN environment variable must be in your path, and it must be set to the 
directory in which Composer is installed.

What’s on your Composer screen?
Composer consists of four windows: 

 The Control Bar window

 The Application window

 The Properties window

 The Object Manager window
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The Control Bar
The Control Bar manages the entire Composer application. It contains Composer’s menu bar and 
toolbars. To exit Composer, close the Control Bar window.

Composer has two toolbars, separated by a line:

 The Standard toolbar

 The Object toolbar

The Standard toolbar gives you quick mouse access to the most common project management, 
object editing, and window and tool access functions. It has two tab sets: Composer and Tools.

The Object toolbar enables you to create and manipulate user interface objects quickly. It consists 
of an arrow pointer button and a tabbed toolbar. The arrow pointer button enables you to select 
objects in the Application window. The toolbar has three tab sets: Objects, Input, and Window.

To display the name of a toolbar button, hold your mouse pointer over the button for two seconds.

Figure 4-1. The Control Bar window.

Standard toolbar Object toolbar
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The Application window
The Application window provides an area 
in which you can design your user 
interface. This design area contains a grid 
that represents cell-based rows and 
columns. When you move or size user 
interface objects, they snap to the grid. 
Objects created in the design area also 
contain grids, so that objects created within 
those objects will snap to row/column 
boundaries as well. You can turn off the 
grids if you need to (for example, when 
you want to print your screen). 

The title bar for the Application window 
contains the name of the current script file. 

Figure 4-2. The Application window.

The Properties window
The Properties window contains a list of design object 
attributes, followed by the property, or value, for each 
attribute. The attributes and properties displayed 
always belong to the object that’s currently selected in 
the Application window. If no object is selected in the 
Application window, the properties displayed are 
those of the active script file.

Some attributes have subattributes and must be 
expanded before you can view or modify the 
subattributes. Such attributes are preceded by a plus 
sign (+). When the attribute is expanded, it is 
preceded by a minus sign (–). To expand or collapse 
an attribute, double-click on it.

Figure 4-3. The Properties window.
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The Object Manager
The Object Manager window displays a visual 
representation of the project file, script file(s), and 
user interface object hierarchy in the following 
order:

  Project file

  Script file

  Containing object

  Contained object

From Object Manager, you can move, copy, delete, 
or rename objects.

The Object Manager window has its own menu bar, 
which contains functions available in Object 
Manager. It also has a status bar at the bottom to 
indicate the activity being performed.

Figure 4-4. The Object Manager window.

The order in which the objects are listed is the order in which they are generated when the script file 
is written or updated. Files or objects that can be expanded are preceded by a plus sign (+). 
Expanded files or objects are preceded by a minus sign (–). To expand or collapse a file or object, 
double-click on it. Script files or objects that have not been fully compiled display the letter U (for 
“unprocessed”).

Using Help
Composer has an extensive online Help system to give you instructions for just about anything 
you’ll need to do. If you can’t find the information you need in this guide, you can search the online 
Help for additional options and procedures:

 From the Help menu, select Composer Help Topics, or click the Help Topics button on the 

toolbar.  

From the Help Topics screen (see figure 4-5), you have three ways to search for information:

 Click the Contents tab to browse through topics by category.

 Click the Index tab to see a list of index entries. Either type the word you’re looking for or 
scroll through the list.

 Click the Find tab to do a full-text search of words or phrases that may be in a Help topic.
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Composer also provides help that is specific to the currently selected or highlighted item. To 
display context-sensitive help for a Composer window, dialog box, property, or object, do one of 
the following:

 Select the item and press F1. (From a dialog box, you can also click the Help button.)

 Point to the item with the arrow pointer, click the right mouse button, and select Context Help 
from the displayed context menu.

To display help for a menu command,

 Pull down the menu, highlight the command (without selecting it), and press F1.

Figure 4-5. Using Composer Help.
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Using Composer
While this manual is not a tutorial, we believe that the quickest way to get you designing with 
Composer is for you to set up a sample user interface screen. As an exercise, you can use the same 
application for which you set up a repository in chapter 3, “Setting Up Your Repository.”

Here’s the primary input window you’re going to design:

We recommend that you run Composer and actually create this input window (or one of your own) 
as you read through the procedures below. Don’t be afraid to experiment and make mistakes: you 
can always click the Undo (or Redo) button if you change your mind.

Designing an input window using repository fields

Creating an input window
When you create any object in Composer, you can either let Composer place the object in a default 
location, or you can specifically place it where you want it to go. These instructions tell you how to 
create an input window of the size and in the location you desire:

1. Click the Input window button on the toolbar.
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2. Click and drag on the desired location in the Application window until the window is large enough 
to hold the fields shown in the screen above.

To create an input window of a default size in a default location, simply double-click the Input 
window toolbar button.

Adding a window title

To specify a title to be displayed in the window’s title bar,

1. Select the window by clicking on it in the Application window.

2. Click the Title property in the Properties window and enter the name of the title you desire (Contact 
Folder, in our example).

Adding predefined repository fields
You can add input fields you’ve defined in S/DE Repository to the input window you just created.

1. Select the input window in the Application window if it’s not already selected.

2. Click the Repository field button on the toolbar.

The Repository Fields dialog box is displayed. Because this is the first repository field you’re 
adding, you need to add a repository structure before you can place any fields. (If you were adding 
a second or any subsequent repository fields, you could skip steps 3 through 7 below.)

3. Click the Select button.

The Select Repository Structure dialog box is displayed.  (See figure 4-6.)

Figure 4-6. Selecting a Repository structure.
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4. In the Name field, select the name of the structure that contains the fields you want to add to your 
input window.

5. Click OK to return to the Repository Fields dialog box. (See figure 4-7.)

6. From the list of input fields, either double-click on each field you want to add or click the Select All 
button to add all input fields in the list. 

Arrayed fields are indicated by a + or – in the untitled column. Click on the + or – to expand or 
collapse an array. When an array is expanded, you can select individual elements of the arrayed 
field to add to the input window.

7. When you’re finished adding fields, exit the dialog box.

Figure 4-7. Adding Repository fields.
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Fine-tuning your input fields 

Moving fields

Now that you see how the fields are laid out, you might want to change their positions. To move one 
or more fields,

1. Select the field or group of fields you want to move in the Application window. (To select a group 
of fields, click on the first field and then CTRL+click on all additional fields you want to include in 
the group.)

2. Click and drag anywhere on the field or on any field in the group (except on a sizing handle) until 
the field’s outline is in the location you want.

Changing a prompt

To change the prompt for an input field,

1. Select the input field in the Application window.

2. Click the Prompt property in the Properties window and type the desired text of your prompt.

Creating a line
To add a line to your input window,

1. Select the input window by clicking on it in the Application window.

2. Click the Line button on the toolbar.

3. Click and drag on the desired location in the Application window until the line is the desired 
orientation and size. (Drag vertically if you want a vertical line or horizontally if you want a 
horizontal line.)

Creating a command button
To add an OK button to your input window,

1. Select the input window by clicking on it in the Application window.

2. Double-click the Button button on the toolbar.

3. In the Properties window, Text is already displayed as the Face property, so click the Text 
subattribute and enter the text OK.

4. Click the Name attribute and enter the menu entry you want this button to generate, in this 
case I_OK.
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You can repeat these steps to create Cancel and Help buttons or any additional buttons you desire. 
The Name properties for standard Cancel and Help buttons should be O_ABANDON and O_HELP. 
For nonstandard buttons, you can assign functionality in one of two ways:

 In the Name property, enter the name of a menu entry (as instructed in step 4 above).

 In the Method property, enter the name of a method routine that will perform special 
processing, or click the drilldown button to display the Choose Method File dialog box in 
Workbench so you can select or create a source file that contains or will contain the method 
routine code. (See “Using code templates” on page 2-31 for more information.) You can also 
enter the name of an executable subroutine library in the Library subproperty.

If you want to create a button that displays a bitmap graphic instead of text, simply select Bitmap 
as the Face property and then enter the name of the bitmap file, including the full directory path or 
logical.

A button can also have a quick-select character, which enables the user to simulate clicking the 
button in your application by pressing ALT+character. If you want the button to have a quick-select 
character, click the Select character attribute and enter the quick-select character. If the button 
contains text, the first occurrence of the quick-select character will be underlined.

Designing an input window from scratch
Now we’re going to create an input window whose fields have not been predefined in Repository.

Creating a “drilldown” input window
The Last field has a drilldown button, so we’re going to create a second input window that’s a 
drilldown from the first. In our application, our drilldown method for the field will display and 
process this second input window. Here’s what it looks like: 

To create the second input window in a default location,

1. Double-click the Input window button on the toolbar.

2. Click the Title property in the Properties window and enter the name of the title you desire 
(Personal Info, in this example).
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Creating new input fields
We haven’t defined any input fields for this window in the Repository, so this time you’ll need to 
create the fields from scratch. To add several new input fields to your input window,

1. Select the input window by clicking on it in the Application window.

2. SHIFT+click the Input field button on the toolbar.

3. For each field you want to create, click and drag on the desired location in the Application window 
until the field is the desired size.

4. Repeat step 3 until you’ve created as many input fields as you like.

5. Click any other Object toolbar button to cancel creation mode.

Setting input field properties

Specifying a prompt

1. Select the input field in the Application window.

2. Click the Prompt attribute in the Properties window and type the desired text of your prompt.

If you want your prompt to be a hyperlink that calls a subroutine to perform special processing 
whenever the prompt is clicked, double-click the +Methods attribute to display the Hyperlink 
method attribute. Then click the Hyperlink method attribute and type the name of a hyperlink 
method subroutine you’ve written or plan to write, or click the drilldown button to display the 
Choose Method File dialog box in Workbench so you can select or create a source file that contains 
or will contain the method routine code. (See “Using code templates” on page 2-31 for more 
information.) Hyperlink prompts are displayed in green.

Setting size

You’ll probably want to make sure your input fields are the right size. To size a field,

1. Select the field by clicking on it in the Application window.

2. In the Properties window, look at the Size property.

3. If the size is not what you want, type a new size or click and drag on one of the field’s sizing 
handles in the Application window. 
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Adding a check box

You can either display an existing input field as a check box or create one from scratch using the 
Check box toolbar button.

To display an existing input field as a check box,

1. Select the input field by clicking on it in the Application window.

2. In the Properties window, under the Type property, set the View as subproperty to Check box.

Adding a selection list field

Two of the fields in our example are selection list fields (sometimes referred to as “combo boxes”). 
You can either display an existing input field as a selection list field or create one from scratch 
using the Selection list toolbar button.

To create a selection list field using the Selection list button,

1. Select the input window in the Application window.

2. Double-click the Selection list button.

3. Click the Selections attribute in the Properties window and then click the drilldown button.

4. In the Selections dialog box, select Selection list in both the Type and View as fields. (If you have a 
predefined selection window, you can select Selection window as the Type.)

5. Replace Entry 1, Entry 2, and Entry 3 with the selection items of your choice, pressing ENTER after 
each.

6. Exit the dialog box.

Adding an editable text field

The Comments field in our example is an editable text field, which is a real alpha array. When the 
user enters input into a text field, the text wraps automatically.

To create an editable text field,

1. Create an input field or select an existing input field in the Application window.

2. Set the Dimension subproperty (under Type in the Properties window) to a value greater than 1.
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Specifying information line text

You can display instructions or other text on the information line of your application screen when 
the user moves the cursor to a field. For instance, in our Personal Info example, you might want to 
display the text “Select the marital status of this contact” for the first selection list field.

To specify information line text for a field,

1. Select the input field in the Application window.

2. In the Properties window, set the Information line property to the text you want to display when this 
field is active.

Specifying methods

You can specify routines to be called in the following situations:

These method routines enable you to perform additional processing, such as validating or 
formatting the input. If you don’t specify these subroutines, no special action is taken.

To specify method routines,

1. Double-click the +Methods attribute to display the method attributes.

2. Click the desired method attribute, and either type the name of a method routine you’ve written or 
plan to write or click the drilldown button.

3. If you click the drilldown button, Workbench will be launched (or brought  to the top), and the 
Choose Method File dialog box will be displayed if the specified method is not in any of the source 
files in the current project. In the Choose Method File dialog, select or create a source file that 
contains or will contain the code for the method you are specifying. 

(In chapter 6, “Implementing Your User Interface with UI Toolkit,” you will write sample arrive 
and leave method subroutines.)

To specify a routine to be called Use this method

Before an input field is processed Arrive

After an input field is processed Leave

When the field contents are being edited Edit format

When the field’s contents have been validated Change

Before the field’s contents are displayed Display

When the user clicks on the field’s prompt Hyperlink

When the user clicks the field’s drilldown button Drill
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Saving your work
When you’re finished defining the input windows in our exercise, you have several options:

 Close your project.

 Save or close the current script file.

 Continue defining user interface objects in this script file or create and modify other script files 
for additional practice.

Closing your project
When you close your project, Composer will prompt you to save any unsaved script files, as well as 
the project itself. To close the active project,

1. From the File menu, select Close Project.

2. When prompted as to whether you want to save changes to your script, click Yes.

Because your script still has a temporary name, you are prompted to enter a permanent name.

3. In the Save <Scriptn.wsc> As? dialog box, select the desired drive and directory, and type the 
desired script filename in the File name field.

4. Click OK.

Composer generates a script file with the name you specified. You are also prompted to save 
changes to your project.

5. In the Save <Project.psc> As? dialog box, select the desired drive or directory and type the desired 
project filename in the File name field.

6. Exit the dialog box.

Saving a script file
To save a new or existing script file,

 Click the Save Script button on the toolbar. 

If the script has the temporary name <Scriptn.wsc> (where n is a number), you are prompted to 
enter a script filename. 

Closing a script file
When a script file is closed, all of its open objects are removed from the Application window. To 
close your script file,

 From the File menu, select Close Script.

If the script has not been saved since the last time you made changes, you are asked whether you 
want to save changes to your script.
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Compiling your script
You must compile your script before you can use it in your application. To specify compilation 
options,

1. From the File menu, select Compile Scripts Setup.

The Compile Scripts Setup dialog box is displayed. (See figure 4-8.)

2. Select the scripts you want to compile and enter the desired information in the other input fields. 

3. If you want to compile the selected scripts right now, click Compile. If you want to compile later, 
click OK to exit the dialog box.

When you compile, the Script compiler reads the selected script files and converts them to a 
window library (ISAM file). 

To compile scripts later, 

 From the File menu, select Compile Scripts.

If you have not set up any script compilation options, this command compiles the default set of 
scripts (which is all scripts in the project).

Figure 4-8. Compiling a script.

Type or select the name of the library file to useSelect Overwrite to overwrite 
the existing library file on 
compilation or Append to 
append the current 
compilation to the existing 
library file

Type or select the name of a 
file to which the compiler will 
write any errors encountered 
during compilation

Click Compile to compile all 
of the specified script files

Either select the Select all 
check box to select all script 
files in the project for 
compilation OR select the 
script files you want to 
compile by checking the box 
to the left of each script. 
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Exiting Composer
To exit Composer, do one of the following:

 Click the Control Bar’s Close button.

 From the File menu, select Exit.
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5
Programming in Synergy DBL 

This chapter introduces Synergy DBL and steps you through building and running a simple 
application. It also acquaints you with features of DBL that will help you optimize performance and 
simplify maintenance.

What Is Synergy DBL? 5-2

Defines what Synergy DBL is and briefly describes the structure of a Synergy program.

Compiling, Linking, and Running Your Program 5-5

Describes the procedures required to transform your source modules from text files into object files 
and finally into an organized structure that is executed by the Synergy runtime. This section also 
provides a short explanation of object libraries and executable libraries.

Debugging Your Program 5-9

Explains how to include and use the debugger in your application.

Advanced Features 5-12

Describes how to use dynamic memory and how to dispatch routines dynamically.

Programming Tips 5-18

Provides a variety of suggestions and introduces several capabilities of Synergy DBL that will help 
your programs run more efficiently and make them easier to maintain.
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What Is Synergy DBL?
The fundamental component of Synergy/DE is Synergy DBL. Most of the other elements are 
intended to work as layered tools on this basic component. Synergy DBL provides the framework 
for integrating all other required components of Synergy/DE into a seamless development 
environment that will ultimately help you develop your total business solution. Its comprehensive 
capabilities and features make it easy to develop, maintain, and extend your applications.

One of the most significant benefits of Synergy DBL is the fact that applications written in DBL are 
source-code portable to a multitude of hardware and software platforms, including Windows, 
OpenVMS, and popular flavors of UNIX. (Contact your Synergy/DE account manager for a full list 
of currently supported platforms.) In many cases, recompiling is not even necessary; in others, 
compiling and linking are the only requirement. 

Synergy DBL provides many system-level functions directly from within the language. This means 
you don’t have to worry about getting system-level expertise to do things like set system 
environment variables; perform sorts; obtain system values; and create, delete, or rename files. 
Each of these functions is performed from within the program through a call to a system-supplied 
external subroutine with a standard interface that does not change between platforms. By using 
these routines, you can standardize your installation procedures and simplify your maintenance 
overhead.

In addition to providing you with a mechanism for having a single set of sources for multiple 
platforms, Synergy DBL provides you with an excellent methodology for making data portable 
across platforms. If you use the Synergy DBMS utilities and take advantage of the system-supplied 
subroutines for ISAM file creation, creating multikeyed access files on any supported platform is 
quite painless. You do not need expertise in creating files on the target platform; simply run your 
creation program and populate your database files with the supplied utilities. The process is the 
same on any supported platform. Synergy/DE makes porting an opportunity, not a problem.

Creating a source file
If you are creating your source files for the first time, it is important that you do it correctly, as you 
may be able to use some of these routines as templates for future development. 

Selecting an editor
Professional Series Workbench includes a Synergy DBL–sensitive visual editor that automates 
code formatting and provides keyword recognition and completion, popup argument lists for 
Synergy routines, and integration with the Synergy compiler. If you’re developing on Windows, we 
recommend you use this visual editor to simplify your editing process.
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If you do not use the Workbench visual editor, you may use any popular word processing or text 
editing software (such as Microsoft Word or Notepad) or an editor from the command line. It really 
does not matter, as long as the editor you use is capable of writing out the final result as an ASCII 
text file, with no additional formatting or header information embedded in the file. Most word 
processing products will generate this type of file if you save your document as text only. 

If your editing tool appends its own extension to your files, you may want to change that at the 
system level to take advantage of the defaults of the Synergy/DE components or to adhere to 
standards in your development organization. We recommend using the default extension .dbl for 
Synergy DBL source files.

Creating your modules
Once you have chosen your editing tool, you can begin creating or modifying your source code. 
Establishing a standard for your development is an important part of the decision process for a 
successful development effort. Once development has been ongoing for some time, it is difficult to 
retrofit standards into existing code. Choose some standard methodology and try to stick to it. You 
can obtain our suggested coding standard by contacting your Synergy/DE account manager.

A major benefit of Synergy DBL is that you can group multiple routines in a single source module. 
This enables you to combine subroutines that are unique to a program within the same source 
module, thus reducing the number of compilations required to generate program objects. All of 
your definitions are maintained across the routines, requiring you to put definitions in only one 
place.

Structure of a Synergy program
A Synergy program contains one or more prototype imports, structures, namespaces, classes, and 
routines. A Synergy DBL routine is composed of two main parts: a data division and a procedure 
division. The data division contains most of the declarations, directives, and statements necessary 
to identify the various data structures that will be referenced by the program statements. The 
procedure division contains all of the operational statements that act on the data structures 
contained in the data division. Any data structure that is referenced in the procedure division must 
either be defined in the data division of the routine with which it is associated or in the procedure 
division as a stack local variable. You can define data structures that are not referenced in the 
procedure division, but you cannot have references in the procedure division that are not previously 
defined in the routine.

Identifying your routine
Your routine should start with a statement that identifies what type of routine you are creating. The 
statements that identify routine types are MAIN, SUBROUTINE, FUNCTION, and METHOD. 
Each one of these statements tells the compiler that this is the beginning of the data division or 
parameter section for this routine. For a more comprehensive discussion of these statements, see the 
“Synergy DBL Statements” chapter of your Synergy DBL Language Reference Manual.
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Data division
A data division contains classes, structures, records, fields, groups, literals, temporary definitions, 
references to data segments located outside of the program, and possibly definitions of external 
functions that are referenced in the procedure division. In addition, we highly recommend that each 
routine contain comments that describe the purpose of the routine and define any interactions with 
other routines. If the routine is an external subroutine, function, or method, the arguments that are 
passed to and returned from the routine should also be defined. 

The end of the data division and the start of the procedure division is defined by the PROC 
statement. 

Procedure division
The procedure division contains the logic and operational statements that will be executed to make 
your program perform the task you desire. Each statement will be executed according to the syntax 
and semantics defined in the Synergy DBL Language Reference Manual. Synergy DBL allows for 
data manipulation, file and terminal I/O, program logic control, arithmetic operations, and 
conditional execution. By combining these capabilities, you should be able to create a routine (or 
group of interacting routines) that solves any business problem.

The end of the procedure division is defined by the END, ENDMAIN, ENDSUBROUTINE, 
ENDFUNCTION, or ENDMETHOD statement. These statements tell the compiler that the routine 
is complete and prepares it to deal with the next routine. 

See also
Your Synergy DBL Language Reference Manual, which contains the syntax and specifications for 
every statement and system-supplied subroutine in Synergy DBL. Refer to this manual for further 
information.
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Compiling, Linking, and Running Your Program
Once you’ve written your source modules, you must compile, link, and run your programs. Here 
are the steps you should follow:

1. Compile each source module. See “Compiling your program” below.

2. If desired, combine your compiled routines in an object library. See “Creating object libraries” on 
page 5-6. Creating an object library simplifies the linking process (as well as your distribution 
strategy).

3. Link your compiled routines or object library, generating an executable library if desired. See 
“Linking your program” on page 5-6.

4. Test your program by running it. See “Running your program” on page 5-8.

Compiling your program
The Synergy compiler interprets the ASCII code you have written in your source modules and, 
using the rules of Synergy DBL, creates another file that contains the instructions to perform the 
program actions you have specified. The output from the compiler is called object code and is 
sometimes referred to as an object file. Most applications are composed of many of these individual 
object files that are bound (or linked) together into a single executable program.

By default, the compiler expects the input source module to have the extension .dbl. If your 
programs follow this convention, you will not have to specify a filename extension in your compiler 
commands. The compiler creates output files with the following default extensions:

We recommend using these default filename extensions so that other tools (for example, Windows 
Explorer) will know what type of file it is.

For instructions on compiling your program, refer to the “Building and Running Synergy 
Applications” chapter in Synergy Tools. You can also compile your program directly from 
Professional Series Workbench by doing the following:

1. Make sure the file you want to compile is open.

2. From the Project menu, select Compile.

Extension File type

.dbo Generated object file

.lis Listing file

TIP
There are many other ways to request a source compile on various platforms. For example, 
Serena ChangeMan Builder’s make command is an excellent choice for program builds.
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Creating object libraries
Once you’ve created a number of related external subroutines and have tested them thoroughly, you 
may want to group them together so you can reference them as a single entity. Instead of having to 
remember to include all of the object files that are referenced in each program every time you link 
the application, you can create an object library using the Synergy librarian.

An object library is a collection of object files that have been compiled and stored in a special file 
that can be referenced by the Synergy linker. Any routines that are included in the object library 
will be extracted from the library at link time. Thus, instead of distributing hundreds of .dbo files, 
you can distribute a single .olb file that contains all of the compiled source code routines. 

For instructions on creating an object library, refer to the “Building and Running Synergy 
Applications” chapter in Synergy Tools.

Linking your program
After you’ve compiled your source code into object files, you must gather the object files into a 
cohesive unit so they can be executed as a single program. This gathering is done by the linker 
program. The linker also performs many other functions, such as resolving addresses for global 
symbols, figuring out where external data references are located, identifying the exact location of 
external routines so your program can call them, and associating all program information with the 
required system resources for your system. The output from the linker is an executable program: a 
complete, self-contained group of instructions capable of being executed by the runtime. 

By default, the Synergy linker expects your object files to have the extension .dbo. If your 
programs follow this convention you will not have to specify a filename extension in your linker 
commands. The linker creates output files with the following extensions:

If any of your object files have been changed, you must recompile them before relinking your 
application for the changes to take effect. You do not need to recompile object files that have not 
been changed. When you relink your application, your changes will be incorporated into the new 
executable program.

Extension File type

.dbr Executable file

.map Map file

.elb Executable library
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For instructions on linking your program, refer to the “Building and Running Synergy 
Applications” chapter in Synergy Tools. You can also link your program directly from Professional 
Series Workbench by doing the following:

1. Make sure the file you want to link is open.

2. From the Project menu, select Build. 

If the file was not previously compiled, selecting Build will compile it.

Creating executable libraries
As useful as object libraries are, they have limitations. If your source code changes, not only do you 
have to recompile the module, but you also have to relink every application that included that 
particular object file. This could be time-consuming if your application is large and the object file 
you have changed is common to most of your programs.

To address this issue, as well as others, Synergy DBL provides a feature called executable libraries. 
An executable library is different from an object library in that the object file is not included in the 
executable program. Instead, the linker includes a referencing pointer to where the routine is 
located in the executable library. When the Synergy runtime executes your program and the routine 
is called, the runtime knows how to execute the code from the executable library.

Four advantages of using an executable library instead of (or in addition to) an object library are

 smaller programs. If you have a subroutine that is called by several programs and you’re not 
using an executable library, each executable program contains a complete copy of the compiled 
subroutine. As a result, your programs are larger in size and use more memory when executing. 
Using an executable library can significantly reduce the size of your program images.

 time savings. As with an object library, if you change an object file, you have to recompile the 
file and replace the old object file with the new one. However, you don’t have to do anything 
else. Because your programs contain only a pointer to the object file to be executed, and the 
executable library keeps track of where the new object is located, you don’t have to relink your 
programs to take advantage of the change. When your program is executed, the Synergy 
runtime merely gets the new copy from the executable library.

 more efficient distribution process. Because your executable program contains only a 
referential pointer to another program image, you can simply replace the executable library, 
instead of redistributing an object library and the commands necessary to relink the 
application. When the new executable library is installed, your changes are already in effect.

 creation by the Synergy linker. You can either use an existing object library and create an 
executable library that contains all of your object files, or you can have the linker put the object 
files directly into an executable library.

For instructions on creating an executable library, refer to the “Building and Running Synergy 
Applications” chapter of Synergy Tools.
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Restrictions

Once an image is inserted into an executable library, it cannot be removed. If you want to delete 
some images from an executable library, you must delete the library and rebuild it from scratch.

Running your program
Now you’ve come to the easiest part: actually running your program. This is the final step in 
program development. If you’ve done your job completely, you will have a working program. If 
not, you will have to figure out where changes need to be made, change the source code, and then 
recompile, relink, and retest your program.

By default, the Synergy runtime expects your programs to have the extension .dbr. If your 
programs follow this convention, you will not have to specify a filename extension in your runtime 
commands.

For instructions on running your program, refer to the “Building and Running Synergy 
Applications” chapter in Synergy Tools. You can also run your program directly from Professional 
Series Workbench by doing the following:

1. Make sure the file you want to run is open.

2. From the Project menu, select Execute. 

TIP
To facilitate the process of rebuilding an executable library, you might want to keep an 
object library from which you can regenerate your executable library. The Synergy librarian 
provides the necessary tools for managing individual object files in an object library.

Executable libraries are not implemented on OpenVMS systems. On those systems, the 
functionality has been implemented as OpenVMS shared images.
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Debugging Your Program
No one writes perfect code, at least not all of the time. Because almost every program has a few 
bugs that need to be fixed, a debugger is a valuable tool. 

Built into Synergy DBL is a powerful utility that enables you to interactively control program 
execution, examine the data structures referenced by your program, modify those data structures to 
contain whatever values you choose, and validate memory references for correctness. You can 
instruct the debugger to “watch” a variable and report when its value changes, what the old value 
was, and what the new value is. You can identify a particular statement (or multiple statements) as a 
stopping place. You can decide whether to step through routines or execute them in their entirety.

To run a program under the control of the Synergy debugger,

1. Compile your program with the -d option.

2. Link your program with the -d option.

3. Run your program with the -d option.

You can also run a program in debug mode directly from Professional Series Workbench by 
selecting Debug from the Project menu. 

Much of debugging is common sense: finding out where the program is going wrong and stopping 
the execution before the problem happens, then stepping through the program one statement at a 
time, looking at variables that affect the processing, changing values to create conditions that are 
potential problems, and trying to validate your program logic by tracing the program flow. As you 
interact with your programs, you’ll get a sense of what kinds of mistakes cause what classes of 
problems, and identifying the source of problems will become easier.

See also
The “Debugging Synergy Programs” chapter of Synergy Tools. We highly recommend reading this 
chapter to become familiar with the different commands and capabilities of the debugger, and for 
instructions on running the debugger remotely. The debugger is a tool that will save you a lot of 
time if you use it correctly.

Saving and restoring debugger settings
You can save the current break points, watch points, and option settings of the debugger so these 
settings can easily be restored the next time you run the debugger.

Use the SAVE file debugger command to save debugger settings to the specified file. Use the @ file 
debugger command to restore the saved settings. See the “Debugging Synergy Programs” chapter 
of Synergy Tools for details about these commands.

For information about saving and restoring the current debugger state to a file from Professional 
Series Workbench, see “Debugging a project” on page 2-36. 
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Debugging with bounds checking
Bounds checking is a very powerful feature of the debugging capabilities in Synergy DBL. 
Running your application with bounds checking enabled will identify any situations in which data 
is being stored into structures that are referenced beyond the “bounds” of their normal definition. 
Trying to monitor situations like this manually is a debugging nightmare. 

Many of the legacy languages (ANSI DIBOL and Synergy DBL) take advantage of the capability 
that allows you to reference subsequent data structures as a subscripted array element of a previous 
data structure. While this may have been a solution to some problems, it opened the door to a much 
bigger problem: unknowingly writing or referencing data beyond expected limits. In some cases 
these data reference operations are detected by the system when the program is run, resulting in 
errors. In other cases the reference operation goes undetected and remains in the application like a 
time bomb, waiting for the most inopportune time to overwrite a critical variable that will cause 
another routine that depends on that value to malfunction. Debugging one of these “transient” error 
conditions is one of the hardest and most frustrating exercises in software engineering.

Synergy DBL will find this class of error for you automatically if you compile your application 
with bounds checking enabled. When the program is run, it will report any and all references that 
result from an “out-of-bounds” condition. 

When you compile your programs with bounds checking enabled, all pseudo arrays (such as a field 
defined as 10d5) are converted to real arrays (for example, [10]d5). While you are in development 
mode, you should build all routines in your application with bounds checking enabled. When you 
are ready to release your application to production, simply compile without bounds checking 
enabled, and the size of the image will be reduced significantly. Below are examples of conditions 
that will be reported when a program is compiled with bounds checking enabled.

Examples
When the following program is run, the runtime will report an out-of-bounds condition, because the 
code is actually referencing var[1](1,10), the first element of the array, which has a “real” length 
of 2. Because you are trying to write 10 characters into a two-character field, the runtime will report 
an error.

main myroutine
record
    var ,[10]d2

proc
    var(1,10) = "0001020304"
endmain
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The following example will report an out-of-bounds condition if the subroutine is compiled with 
bounds checking enabled and the calling routine is compiled with bounds checking disabled. This 
example illustrates why it’s important to compile all your routines with bounds checking enabled.

record
    var   ,10d2
    .
    .
    .
    xcall subr(var)
    .
    .
    .
subroutine subr
    arg   ,d
    .
    .
    .
    arg(2)  = 10

The first statement below will generate an out-of-bounds condition, because ivar is defined as 
being i4. The correct way to clear both of these integer variables at the same time is to reference the 
named record as an integer, as the second statement does.

record name
    ivar   ,i4
    ivar2  ,i4
    .
    .
    .
    clear ivar(1,8)
    clear ^i(name)

Both of the statements below will generate an out-of-bounds condition. While both types of data 
reference are common techniques in many legacy programs, they are references outside the bounds 
of the definition of var and, as such, will be reported.

record
    var ,d2
    var2 ,d2
    .
    .
    .
    var(1,4) = 1010
    var(2) = 10
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Advanced Features

Using dynamic memory
Most applications need to allocate space to store varying amounts of data. In the past, this was 
accomplished by considering what the “worst case” would be and defining sufficient storage space 
to accommodate this situation. This is quite inefficient for two reasons. The first is that it causes the 
program to require more memory at runtime and more storage space on the disk. The second is that 
if the application at some point in time exceeds the original estimate of the “worst case,” the code 
has to be changed, with all of the inherent inconvenience associated with code change.

A better solution is to allocate memory dynamically as it is required by the program. When the 
program requires memory, it simply tells the system how much it needs. The system allocates the 
memory and returns a pointer to the base of the memory segment. We refer to this pointer as a 
handle. All future references to this memory will use this handle. There is no practical restriction 
on the amount of memory available, and once used, the memory can be released back to the system. 
The amount of memory is totally dynamic: it can grow or shrink as required by the application. As 
new memory is allocated, it is logically appended to the existing memory, and as memory is 
released, it is logically truncated from the existing memory. 

Defining data handles
The pointer for each memory segment must be allocated in the data division. Multiple segments are 
allowed, but each segment must have its own handle. A handle is an i4 integer and should be 
aligned on an even longword boundary for maximum performance:

.align long
record
    handle1  ,i4 ;The handle for one segment
    handle2  ,i4 ;The handle for another segment

Defining memory structures
Memory allocation and reference is done in conjunction with structures. Structures are defined in 
the data division using the STRUCTURE statement and function the same as the Synergy DBL 
RECORD statement, except they do not allocate any space in the program. Structures can be 
.INCLUDEd from the repository, .INCLUDEd from files, or hard-coded in your application.

structure cards
  value ,i4
  suit ,a1
  rank ,a1
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Manipulating dynamic memory
Dynamic memory is manipulated by the %MEM_PROC function, which performs four operations:

 Allocation

 Resizing

 Deallocation

 Registration

Allocating memory

Memory allocation is performed by specifying the DM_ALLOC value as the first argument to the 
%MEM_PROC function and any decimal expression as the second argument. The function value is 
assigned to the i4 variable defined as the handle for the memory segment. The second argument is 
the number of bytes of memory that will be allocated. For example:

handle1 = %mem_proc(DM_ALLOC, ^size(cards)*52)

Using the structure definition from the previous example, this code will allocate 312 bytes of 
memory (6*52) and return the pointer to the memory in the integer named handle1. The contents of 
the memory segment are undefined.

Resizing memory

Existing memory segments can be expanded or collapsed by specifying the DM_RESIZ value as 
the first argument to the %MEM_PROC function, a decimal expression representing the new size 
of the memory segment as the second argument (either greater than the original or smaller than the 
original), and the handle of the original memory segment as the third argument. The return value 
will be the new handle of the memory segment. Here’s an example of expanding memory:

handle1 = %mem_proc(DM_RESIZ, ^size(cards)*52*4, handle1)

Using the previous definitions, this code will allocate 1248 bytes of memory and take the contents 
of the original 312-byte memory segment and copy it to the first 312 bytes of the new memory 
segment. The contents of the remaining memory in the segment is undefined. The pointer to the 
new memory segment will be returned in the variable handle1.

To return unwanted memory to the system, simply specify a lesser value as the second argument. 
For example:

handle1 = %mem_proc(DM_RESIZ, ^size(cards)*52*2, handle1)

This code will remove the last 624 bytes from the memory segment. The size of the memory 
segment will now be 624 bytes. Any information that existed in the returned memory will be lost. 
The pointer to the memory segment will be returned in the variable handle1. Do not assume that 
this pointer will be unchanged.
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Deallocating memory

To return memory to the system, specify the DM_FREE value as the first argument to the 
%MEM_PROC function and the handle of the memory segment as the second argument. The 
function value will be returned as zero (0), and we recommend that this value be assigned to the 
handle. Any data reference operations against a handle with a zero value will generate an error 
condition that can be trapped. For example:

handle1 = %mem_proc(DM_FREE, handle1)

This code releases the memory that was previously allocated and sets the value of handle1 to zero.

Registering memory

Your program may call external routines written in other languages or system functions that return 
pointers to memory segments that were allocated outside of Synergy DBL. You can reference these 
segments from within your program if they are registered within your program. The process of 
registration does not allocate memory; it makes memory segments that are allocated externally 
available to your program as if they had been allocated by your program. 

To register memory, specify the DM_REG value as the first argument to %MEM_PROC, a decimal 
expression that represents the size of the memory segment as the second argument, and a 
platform-specific-sized integer address of the memory segment as the third argument. The value of 
the function will be the handle of the memory segment. For example:

.align quad
record
    addr ,D_ADDR
    size ,i4
    .
    .
    .
proc
    .
    .
    .
    xcall some_routine(%val(size),%ref(addr))   ;Call an external routine
    handle1 = %mem_proc(DM_REG, size, addr)     ;Register the memory

This code will register the address that was passed into the variable addr. Expressing the type and 
size of this variable by referencing the .DEFINEd value D_ADDR ensures that this variable will 
match the system requirement of all platforms. On 64-bit systems it will allocate an i8 field; on 
32-bit systems it will generate an i4 field. D_ADDR is conditionally defined for you by the 
compiler. After the %MEM_PROC function call, the memory segment will behave exactly as if it 
were allocated from within this program.
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Accessing memory
Once memory has been allocated, we use the ^M data reference operation to address the memory 
locations. In effect, a memory segment can be considered to be a dynamic array that can be 
addressed in the same manner as a multidimensioned group.

The following example uses the %MEM_PROC dynamic memory function to allocate a 
dynamically sized array, which will be resized as needed. The routine reads the records from a 
customer file into memory and then sorts the records in memory and prints them out in sorted order. 
This example presumes that the developer can supply the local routine “print” and the QSORT sort 
routine “sort_by_past_due.” (Refer to QSORT in the “System-Supplied Subroutines and 
Functions” chapter of the Synergy DBL Language Reference Manual for more information.) Note 
that this routine does no error trapping, so it presumes that the customer records will all fit into 
available memory.

.align

.define D_INITIAL_ALLOC ,10 ;Initially allocate for 10 records max

.define D_INCR_ALLOC ,5 ;If we need to resize, go up by 5

.define D_CUST_CHAN ,12 ;Customer channel number

.define D_FMT_MONEY ,"Z,ZZZ,ZZZ,ZZX.XX-"

record
    handle ,i4 ;Handle to dynamic memory
    nmalloc ,i4 ;Number of records allocated
    nmloaded ,i4 ;Number of records actually loaded
    ix ,i4 ;A scratch index

structure customer ;Customer record structure
    group rec ,a
      number ,d6
      name ,a30
      address ,[3]a30
      current_due ,d12.2
      over_30 ,d12.2
      over_60 ,d12.2
      over_90 ,d12.2
    endgroup

record pline ;Print line buffer
    pcust ,a6
    ,a2
    pname ,a30
    ,a2
    pover90 ,a17
    ,a2
    pover60 ,a17
    ,a2
    pover30 ,a17
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proc

;First, allocate an array and read in the customer records
    nmalloc = D_INITIAL_ALLOC ;Allocate for 10 records
    handle = %mem_proc(DM_ALLOC, nmalloc)
    clear nmloaded ;None loaded yet

    open(D_CUST_CHAN, "I:I", "DAT:customers") ;Open customer file
    repeat
      begin
        if (nmloaded .ge. nmalloc) ;Need to increase array size?
          begin
            nmalloc += D_INCR_ALLOC ;Bump it by 5
            handle = %mem_proc(DM_RESIZ, nmalloc, handle)
          end
        incr nmloaded;Loading one now
        reads(D_CUST_CHAN, ^m(customer[nmloaded].rec, handle), eof)
      end
eof,
    close D_CUST_CHAN ;Close customer file
    decr nmloaded ;EOF on the last one

;Now do an in-memory sort based on some complex criteria
    xcall qsort(^m(customer.rec, handle), nmloaded, "sort_by_past_due")

;Now print them out in that order
    for ix from 1 thru nmloaded
      begin
        clear pline
        pcust = ^m(customer[ix].number, handle), "XXXXXX"
        pname = ^m(customer[ix].name, handle)
        pover90 = ^m(customer[ix].over_90, handle), D_FMT_MONEY
        pover60 = ^m(customer[ix].over_60, handle), D_FMT_MONEY
        pover30 = ^m(customer[ix].over_30, handle), D_FMT_MONEY
        call print
      end

    xreturn ;Because the allocation was not static, this releases it
end

Static vs. volatile handles
Handles are classified as one of two types, static or volatile: 

 Static handles are persistent and do not get released when the activation level of the generating 
routine is exited. They are stored as positive numbers.

 Volatile handles are dynamic and go away along with the routine activation level. They are 
stored as negative numbers.

Both static handles and volatile handles go away when the entire program is exited or the handle is 
explicitly released.
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Dispatching routines dynamically
Synergy DBL provides a system routine (XSUBR) that enables programs to determine at runtime 
what external routine will be called. This capability provides a multitude of opportunities for the 
application developer to provide flexibility in routines. Consider the case where the name of a 
routine to be called is returned to a UI Toolkit program with a special prefix. You could add a 
completely new feature to the code simply by changing the menu column in the window library and 
adding the routine to an associated executable library. You wouldn’t have to change any code or 
even relink the application. 

Consider the following script definition:

.column functions, "Functions"

.entry s_rolodex, "Rolodex

.entry s_calculate, "Calculator"

.entry s_diary, "Diary"

.entry s_mailbox, "Mail"

.end

The code to process this script could be as simple as the following:

xcall m_process
if (g_select)                    ;Menu selection
    case g_entnam of
      begincase
"O_EXIT":  exitloop
"O_ABOUT": xcall u_about(TITLE, VERSION,%datecompiled)
"S_":      xcall x_subr(g_entnam - "S_")
      endcase

Adding a new routine would not require changing this code at all. For instance, an application could 
have matched sets of window libraries and executable libraries, distributed as pairs, that would 
work with the same executable image but provide very different capabilities. If the application went 
one step further and built the menu columns on-the-fly, simply updating a database file and the 
executable library would allow calls to the new routines.
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Programming Tips

Referencing data indirectly
Environment variables (or logicals) give your application tremendous power to reference data in an 
indirect manner. You should use environment variables to simplify your coding and standardize the 
way you address the location of the files that are opened by your application. In most cases, 
environment variables are a convenience, but in some cases they are a necessity. For instance, there 
is a 31-character restriction on the file specification for the executable library that is passed to the 
Synergy linker. If your full path exceeds this limitation, your link command will return an error. 

In terms of convenience, environment variables enable you to reference different file locations 
without having to change your source code, which brings with it the associated overhead of 
recompiling and relinking your code. In addition to the time lost, there is always the possibility that 
you may have made a typographical error, executed an erroneous compile or link command, or 
forgotten to include a required file. Using environment variables enables you to adjust where the 
database files are located and then execute your program, with the same program referring to a 
different set of data.

Three cases for environment variables
One of the most powerful uses of this tool is that you can code your application to point to a data set 
that is referenced by an external environment variable and test your application against a test data 
base. When you’re done testing, you simply reset the environment variable; the application now 
points to the real data, without the need for you to touch the application in any way. 

Another great feature of this paradigm is that your application may be installed at multiple 
customer sites. Instead of having to go into each program module that contains a file specification 
and customize the file references to the individual site, you can just use a set of environment 
variables in your application and set them at each customer site. Not only do you have a faster and 
more standard installation procedure, but you also have a single set of sources for multiple 
installations.

A third reason to use environment variables is that on different operating systems the file 
specifications are formatted differently. Consider the following actual file specifications that 
reference a Synergy ISAM file that must be opened in an application on three different platforms:

System File specification

Windows c:\myapp\finance\gen_ledg.ism

UNIX /usr/apps/myapp/finance/gen_ledg.ism

OpenVMS user$disk1:[myapp.finance]gen_ledg.ism;20



Programming in Synergy DBL
Programming Tips

Getting Started with Synergy/DE 10.3.3 (5/16) 5-19

You could take advantage of environment variables by coding the OPEN statement to refer to this 
file on all systems in a generic manner. Your application would address this file with a statement 
like the following:

open(chan_no,"I:I","FINAPP:gen_ledg")

By simply setting an environment variable named FINAPP on each system, your application would 
open the correct file regardless of the difference in format for each system. Note also that we have 
taken advantage of the default file extension capabilities and have not specified an extension for 
the file.

Setting environment variables
How environment variables are set is system-dependent, as each operating system requires a 
somewhat different syntax, but the basic concept is the same. On each system, we tell the operating 
system the name we are going to use as the environment variable, and we also tell it what we want 
the environment variable to mean when we use it in our application or command line references. 

In the example above, we would set the environment variables in the following manner:

As you can see, depending on your system, you will need to set the environment variables in 
different places and using slightly different syntax. Consult the “Environment Variables” chapter of 
Environment Variables & System Options for a more comprehensive discussion on how to set 
environment variables on your system. Where you set your environment variables is usually a 
function of the scope that your environment variables must have. If they are going to be needed by 
everyone who is on the system, it may be useful to set them in some system initialization file. If 
they are going to be used by just a few individuals, it may be better to define them in individual 
log-in command (or .profile) files. Talk with your system administrator to decide where and how 
environment variables should be set in your particular environment.

System Environment variable definition

Windows set FINAPP=c:\myapp\finance

UNIX FINAPP=/usr/apps/myapp/finance ;export FINAPP

or
setenv FINAPP /usr/apps/myapp/finance

OpenVMS define FINAPP user$disk1:[myapp.finance]
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Comparing data
Two separate groups of relational operators are available to the Synergy DBL developer to evaluate 
the relationship of alpha data. Most developers know of the first group but are not aware of the 
significant difference in the behavior of the second group. The two groups and their operators are as 
follows:

The difference in behavior between these groups is based on the length of the comparison that is 
made. Relational operators perform their comparison based on the shorter of the two operands. 
String relational operators perform their comparison based on the longer of the two operands, with 
the shorter being logically extended with blanks (spaces) until the shorter operand is the same size 
as the larger operand. This means that comparing “A” to “ABC” with .EQS. is logically equivalent 
to comparing “A   ” to “ABC”, and the resulting truth value is FALSE. Performing the same 
comparison with .EQ. is logically equivalent to comparing “A” to “A”, and the resulting truth value 
is true. This behavior holds for all of the string relational operators.

This distinction is most important when considering how the CASE and USING statements are 
evaluated. These statements use the relational operator .EQ. in performing their comparisons. This 
is a double-edged sword: your application may take advantage of this feature to generate matches 
for multiple values with a single entry, or your application may not behave as expected and may 
match on values that were not intended. Consider the following sample code:

case value of 
  begincase
"A": call a_process ;Catches every entry that starts with "A"
"AB": call ab_process ; That means you can never get here!
"ABC": call abc_process ; Or here!
  endcase

Relational operators String relational operators

.EQ. .EQS.

.LT. .LTS.

.GT. .GTS.

.NE. .NES.

.GE. .GES.

.LE. .LES.
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The CASE and USING statements perform evaluations in a top-down manner. Therefore, in the 
above code, any value that would match the second or third case would by definition have to match 
the first. To make this work correctly, the order of the cases must be reversed as follows:

case value of
  begincase ;Matches the following values
"ABC": call abc_process ; ABC, ABCC, ABCD, ABCDE...
"AB": call ab_process ; AB, ABD, ABE, ABB...
"A": call a_process ; any remaining values starting with A
  endcase

Understanding the behavior of the different relational operators will enhance your productivity and 
provide you with more options as you code your application.

Manipulating dates
Synergy DBL provides the capability to transform dates to and from a numeric representation, 
which enables you to perform mathematical operations on the dates. Adding and subtracting 
periods of time, determining differences between dates, and determining what day of the week a 
particular date falls are simple function calls. The algorithm is based on the Gregorian calendar and 
calculates the days since December 31, 4713 BC. 

Four function calls provide this capability:

 %JPERIOD converts a date to a numeric value.

 %DATE converts a numeric value to DD-MMM-YY (or YYYY) alpha format.

 %NDATE converts a numeric value to YYYYMMDD numeric format.

 %WKDAY returns the ordinal number of a weekday (Sunday is 1).

Converting dates to a numeric value using %JPERIOD
%JPERIOD accepts either an alpha representation of the date in the form DD-MMM-YYYY or 
a numeric representation of the date in the form YYYYMMDD. If a date is not passed as an 
argument, the system date is taken as the default. 

Consider the following statements:

integer = %jperiod("25-DEC-1997")
integer = %jperiod(19971225)
integer = %jperiod
xcall jperiod(integer, 19970101)

Both the first and second statement are functionally equivalent and would store 2451125 in the 
integer variable. The third statement would store the numeric value of the current system date in the 
integer variable. The fourth statement is an example of how this function can be called as an 
external subroutine, specifying a variable as the first argument. The integer variable would contain 
2450767. 
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Converting numeric values to alpha dates
%DATE transforms any numeric value to its equivalent alpha representation of the date formatted 
as DD-MMM-YYYY, DD-MMM-YY, or a truncated version of the latter. If no value is passed, it 
will return the current system date as the default. If the length of the alpha variable is too small to 
contain the entire date, it will be truncated.

record
    avar11 ,a11
    avar9 ,a9
    avar6 ,a6
.
.
.
avar11 = %date(2450767) ;avar11 = 01-JAN-1997
xcall date(avar9,2451125) ;avar9 = 25-DEC-97
xcall date(avar6,2451125) ;avar6 = 25-DEC

Converting numeric values or alpha dates to numeric dates
%NDATE transforms any numeric value to its equivalent numeric representation of the date 
formatted as YYYYMMDD or YYMMDD. Alternatively, it converts an alpha formatted date to a 
numeric formatted date. If no value is passed, it returns the current system date as the default. If the 
length of the destination is too small to contain the entire date, the date will be truncated.

record
    avar4 ,a4
    avar6 ,a6
    avar9 ,a9
.
.
.
avar4 = %ndate(2451125)        ;avar = 1225
avar6 = %ndate("25-DEC-1997")  ;avar = 971225
xcall ndate(avar9,2451125)     ;avar = 19971225

Converting numeric and alpha dates to a day of the week
%WKDAY takes either a numeric formatted date or an alpha formatted date and returns the ordinal 
day of the week for that date. If the alpha format is used, any portion of the date that is omitted will 
default to the system date.

record
    day ,[7]a*,   "Sunday", "Monday", "Tuesday", "Wednesday",
  &           "Thursday", "Friday", "Saturday"
    group crimbo ,d8
      year ,d4
      month ,d2
      crimbo_day ,d2
    endgroup
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proc
    open(1, o, 'tt:')
    crimbo = %ndate("25-DEC")
    incr year
    writes(1, "Christmas is on a " + %atrim(day[%wkday("25-DEC")]) +
  &        "; next year it is on a " + %atrim(day[%wkday(crimbo)]) + ".")
end 

If this program were run in the year 1997 (the current year is assumed because the year is omitted), 
the result would be “Christmas is on a Thursday; next year it is on a Friday.”

Using compile-time definitions
Your application can take advantage of compile-time definitions to provide a level of indirection in 
your code as well as make the code much more self-documenting. An additional benefit is that 
compile-time definitions do not allocate any space in the data division. These definitions can be 
contained in external files that you can conditionally include into your programs or code directly 
into your source programs. Thus, you can edit your code by modifying the value of the definition in 
a single-source module that is included in your source programs. 

Using integer data
For performance reasons, we recommend that you use longword-aligned i4 variables for any 
variable in your program that won’t be stored on disk. This includes, but is not limited to, variables 
for things like loop counters, values that are tested for conditionals, and variables used in 
mathematical computations. Many RISC platforms do not provide native math instructions that 
deal with nonaligned integers, so Synergy DBL uses emulated math operations if the integers are 
not on a longword boundary. By using aligned integers, you will realize a significant improvement 
in performance. We strongly recommend that you do not store integer data in your data records, as 
this could impede your ability to migrate your software to other platforms in the future.

Using CASE vs. USING
Synergex recommends using the USING statement, which always generates the most efficient 
code. The structures that are available (matching on ranges, matching on multiple values, matching 
on expressions, matching the null case, matching on variables) in the USING statement have 
always made it more powerful and more functional; now the performance matches the 
functionality. 

Using the CASE statement is only practical when the match strings are a series of alpha literals. A 
further restriction on the CASE statement is that it must be bounded by a BEGIN-END block if it is 
nested within an IF-THEN-ELSE structure. Even if a CASE statement is not currently within an 
IF-THEN-ELSE structure, Synergex recommends encapsulating all CASE statements within a 
BEGIN-END block to prevent possible confusion should an IF-THEN-ELSE be introduced into the 
code or that code segment be moved or copied to another location.
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6
Implementing Your User Interface 
with UI Toolkit 

This chapter introduces S/DE UI Toolkit and its relationship to application development with 
Synergy/DE. It explains features, describes programming techniques, and provides sample code 
that can be used as a template for your own development. S/DE Repository is used to define the 
data for our sample application that we began in chapter 3.

What Is UI Toolkit? 6-2

Provides an overview of the capabilities of UI Toolkit.

Starting UI Toolkit 6-3

Explains the UI Toolkit screen and the initialization of the Toolkit environment, as well as the style 
of programming necessary for application development with UI Toolkit, how to let Toolkit manage 
your files, and using variables and defined values.

Managing Display Levels with Environment Processing 6-7

Defines Toolkit environments and describes techniques to save and restore program displays.

Managing Window Libraries to Store and Retrieve Display Components 6-9

Describes the definition, creation, and use of window libraries.

Creating Script Files and Window Libraries 6-10

Explains how to create menu columns, windows, and lists and how to write code to process them.

Implementing Online Help 6-33

Explains how to add online help to your application.

Organizing Your Display with Tabbed Dialogs 6-37

Describes how to create and process tab sets from within a UI Toolkit application.

Using Composite Windows to Combine Windows and Lists 6-40

Describes how to combine multiple windows and/or lists into a composite window.

Using Methods 6-43

Defines methods and how to apply them to add power and flexibility to your UI Toolkit application.
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What Is UI Toolkit?
S/DE UI Toolkit is a collection of external subroutines and functions that can be called from your 
programs. It is not another language but rather an extension to Synergy DBL that enables you to 
create and process screens for your applications. The Toolkit is involved in every aspect of the 
terminal user interface. Enhanced capabilities include data presentation, interactive data input and 
editing, Windows pull-down menu processing, demand-loaded dynamic lists, and tabbed dialogs. 
On Windows systems, the UI Toolkit manages mouse interactions, providing your application with 
a truly native “Windows” look and feel. (For more information about Windows-specific UI Toolkit 
features, refer to the “Windows Development” chapter of your Professional Series 
Portability Guide.)

Your application is still a Synergy program. UI Toolkit features are contained in an executable 
library (WND:tklib.elb on most systems) against which your application is linked. These Toolkit 
routines perform the appropriate operation on each of the platforms supported by Synergy DBL. 
What this means to your application is that your screen I/O is platform independent. Regardless of 
where your application is run, your code does not have to change; it lets the Toolkit routines handle 
any system differences. It is even possible to create a single set of source files that runs as a 
Windows application on Windows systems and as a cell-based application in a non-Windows 
environment. 

UI Toolkit does not change your program logic beyond the terminal interface. Using Toolkit does 
not change the way you handle the data once it has been entered by your user. So if you plan to 
convert an existing application, much of your existing code may not need to be replaced.

Performing terminal I/O
To use UI Toolkit, you must change your perception about how terminal I/O is performed. All 
terminal I/O is done through the Toolkit routines. Instead of doing I/O at the field level, you will do 
it at the record level. Also gone is the need to position the cursor, take the input, refresh the screen 
after errors, and then process the data. Most data validation can be handled by Toolkit as well. Gone 
is the need to manipulate each field in a record on an individual basis. Your window definition can 
specify attributes for an entire record. When processing the window, you specify a data area and 
pass control to Toolkit. When Toolkit returns, you have a complete, correct data record, with all 
fields entered and verified for accuracy. All that remains for you is to process that complete record.
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Starting UI Toolkit
To use UI Toolkit, your program must call U_START, the Toolkit’s start-up routine. U_START 
initializes the Toolkit’s memory, opens the terminal, opens the window library where window 
definitions are contained, and establishes the parameters of the Toolkit screen. Other options set the 
size of the display regions, establish upper and lower bounds for Toolkit channel allocation, and set 
the maximum number of levels for environment processing.

The Toolkit screen
The Toolkit screen consists of five sections. The default parameters for a terminal screen are 80 
characters by 24 lines. 

The five screen sections are

 Header. On UNIX and OpenVMS, the screen header can be zero to four lines. On Windows 
platforms it should be set to one line and becomes the window’s “caption,” or title. The 
application name, customer name, date, or other application-specific information is often 
displayed in the header.

 Menu bar. The menu bar is a single-line mandatory region that appears just below the header. 
All active menu columns are placed on the menu bar. When a menu column is placed on the 
menu bar, it is placed immediately to the right of the existing columns. When a menu column 
is removed, other columns shift to the left to fill in the void.

Figure 6-1. A sample UI Toolkit screen.
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 Body. This region is where all of your windows, lists, and tabs are displayed. It occupies the 
entire area between the menu bar and the information line.

 Information line. This single-line section between the body and the footer is used to display 
dynamic, screen-specific information. For example, a brief description of the input required for 
the current input field might be displayed here.

 Footer. This is an optional section that is placed on the bottom of the screen, immediately 
beneath the information line. It can be zero to four lines. The footer is used in conjunction with 
the header and the information line to present information to your users. Like the header, the 
footer usually contains more static, application-specific information.

The following code is executed once, in the start-up routine. It initializes Toolkit and loads 
descriptive text into the header and the system date into the footer. No other Toolkit routine can be 
called until U_START has been called. As the chapter progresses, more code will be added to this 
start-up routine.

startup,
    xcall date(date)
    xcall u_start("cust_lib", 1, 1)      ;Initialize
    xcall e_sect("C U S T O M E R   P R O F I L E", 
  &              D_HEADER, D_CENTER)     ;Place text in header
    xcall e_sect(date, D_FOOTER, D_LEFT) ;Place text in footer
    return

Letting Toolkit manage your files
UI Toolkit needs to manage the files that are open on the system. Not only does it open your 
window library, it opens some files of its own as well. Toolkit keeps track of all your files and 
closes them automatically when you no longer need them. To take advantage of Toolkit’s file 
management capabilities, and to avoid conflicts with the files Toolkit opens, you need to go through 
Toolkit to open and close your database files.

UI Toolkit’s open routine is U_OPEN. U_OPEN opens your file on the next available channel and 
registers the file. When you are done with the file, you close it with the U_CLOSE subroutine. 
U_CLOSE closes the file and deallocates it (removes it from Toolkit memory).

Take a look at the sample code below. Notice the similarity between U_OPEN and Synergy DBL’s 
OPEN statement. (See the “Synergy DBL Statements” chapter of your Synergy DBL Language 
Reference Manual.) The first argument is the channel, but instead of specifying the channel, we 
pass a variable that is returned by U_OPEN with the next available channel. The second argument 
is an alpha literal that specifies the open mode. Next is the filename.

The primary difference between U_OPEN and OPEN is the way errors are handled. Because 
U_OPEN is an external subroutine, ONERROR or the I/O error list doesn’t work. Instead, open 
errors are handled by passing an error variable in the sixth position. If an error occurs on the open, 
it is trapped and the error number is returned in the error variable. The loop we have set up doesn’t 
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exit until the error variable returns false. If the error variable returns true, control returns to the top 
of the loop and a new file is created. All calls to U_OPEN should pass an error variable and test it 
before continuing.

do
  if (error)
    begin   ;Create data file only if it doesn't exist
      xcall isamc("cdat", ^size(customer), 2, "start=1, length=45", 
  &               "start=127, length=32, DUPS, MODIFY")  
      xcall u_open(customer_ch, "u:i", "cdat",,, error)
    end
until (.not.error)

U_CLOSE is refreshingly simple. To close the file we just opened, we call U_CLOSE and pass the 
file’s channel variable. If we had other files to close, we could pass their IDs here as well.

xcall u_close(customer_ch)

Using event-style programming
To realize the full benefit of UI Toolkit, you should incorporate an “event-driven” style of 
programming. Event-style programming means that after all the components are in place, your 
program will call a Toolkit routine to get its user input. This routine will manage all interaction with 
the user until one of a set of special events causes it to exit. Your program then tests to determine 
the event that occurred and takes the appropriate action. Usually, after the action has taken place, 
your program will want to return to the Toolkit routine that generated the event to get further input 
from the user. Therefore most Toolkit routines that get input from the user are placed at the top of a 
loop.

Including tools.def
Every UI Toolkit program must .INCLUDE “WND:tools.def.” Contained in tools.def are the 
global variables that enable your application to communicate with the Toolkit routines. With these 
global variables, your programs can test for the event that caused a Toolkit routine to exit, 
determine the current state of a Toolkit component, instruct a Toolkit routine to perform a task or 
function in a particular way, specify to a Toolkit load routine the channel on which the primary 
window library is open, and pass or retrieve many other pieces of valuable information. 

Also in tools.def are the defined values (with .DEFINE) used as arguments to the Toolkit routines. 
Most of these arguments are just a numerical value. If you examine tools.def, you can see most of 
the defined arguments consist of a descriptive name preceded by D_. For instance, the defined 
values for D_FOOTER, D_CENTER, and D_CLEAR are 3, 12, and 6. Using these definitions 
makes your code more self-documenting than if the corresponding numbers were used. 
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Consider the following:

xcall e_sect("Synergex", D_FOOTER, D_CENTER, D_CLEAR)

and

xcall e_sect("Synergex", 3, 12, 6)

Both of these statements do exactly the same thing: erase the footer region and center the text 
“Synergex” on the first line of the footer section. But the first example is much more expressive and 
far easier to maintain.

Using variables for identifiers
Just as channel numbers are assigned to designate files and devices in your Synergy DBL I/O 
statements, every UI Toolkit component (window, menu column, list, toolbar, or tab set) has a 
unique identifier. These identifiers are integer variables you define in the data division of your 
program. When a UI Toolkit component is loaded, the Toolkit load routine assigns the next 
available value to that component and returns it in the identifier you passed. From that point on, 
when your application needs to reference that component, you will specify its ID variable (not its 
name). For performance reasons, we suggest you use longword-aligned i4 variables for these 
identifiers.

TIP
In our sample programs, you will notice that we try to convey information about the type of 
variable and its use by the name we choose. Defined values are uppercased and begin with 
D_, global variables begin with g_, subroutine arguments begin with a_, menu column IDs 
have a _col suffix, input window IDs an _inp suffix, list IDs a _lst suffix and so on. We 
encourage you to adopt a similar approach in the applications you develop.
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Managing Display Levels with Environment Processing
Among the most tedious tasks an application programmer must deal with is writing the code that 
captures the current screen so it can be restored after some interruption has taken place. In fact, 
many applications simply do not allow any external interference with the display during input. But 
no matter what kind of application you write, there will be situations in which you would like to 
alter some or all of the screen to display information or perform input, and then, when done, return 
the screen to its former state.

This ability to take a “snapshot” of the screen and then clean up and restore its original state at 
some future point is called environment processing. Instead of writing hundreds of lines of code 
each time you need to alter the screen, you simply make a single Toolkit subroutine call to enter a 
new environment. When you enter a new environment, a snapshot is taken of the screen, saving all 
of the characteristics of the previous environment. In the new environment, you can alter the 
display—add or remove screen components, open files, get input, modify screen sections. When 
you’re done, another simple subroutine call exits the environment and restores the original screen.

What makes this capability so powerful is that you can “nest” this processing. If you need to save 
multiple layers, you simply take multiple snapshots. By encapsulating your code in callable 
routines with a single point of entry and a single point of exit, you can have display routines 
themselves save and restore the screen. It does not matter which routine calls a display routine; the 
routine starts by entering a new environment, thus preserving the existing screen. When the routine 
is done, it simply exits the environment, restoring the screen to its former state. 

You cannot skip environments. Environment levels are not identified; they are managed on a stack 
and are exited in the reverse order from which they were created. The routines that are used to save 
and restore environments are the simplest routines in UI Toolkit. 

To save a copy of the current screen and enter a new environment:

xcall e_enter

To exit an environment and restore the screen to its previous state:

xcall e_exit

These routines have no arguments. 
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Local and global screen components
By default, when you load a window or column, it is local to the current environment. This means 
that any subsequent environment cannot delete it from Toolkit memory (although it can be removed 
from the screen), and when the environment that loaded it is exited, the window or column is 
deleted. If you want any environment to be able to delete a window or column, or if you don’t want 
a window or column to be deleted when the environment that loaded it is exited, you can promote 
the window or column to global status by passing an argument to the Toolkit routine that loads it.

See also
The “Environment Routines” chapter of your UI Toolkit Reference Manual for more information 
about environment processing.
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Managing Window Libraries to Store and Retrieve 
Display Components
Much of what you will do as you develop with UI Toolkit is to separate your procedural code from 
your display information. The procedural code will remain in your program source, but the display 
information will reside in script files. These script files will be processed into special ISAM files, 
called window libraries, that store the definitions of Toolkit screen components: input windows, 
text windows, selection windows, menu columns, and list classes. These definitions are in a special 
binary format that is optimized for processing by Toolkit. 

Benefits of window libraries
Window libraries enable you to make changes to the visual portion of your application without 
having to rebuild the associated code. Because the joining of these two parts is not done until the 
program is executed, you can change the visual portion of your application by changing your script 
files and rebuilding the associated window library.

A further benefit of window libraries is that you can have multiple libraries that use the same 
procedural code. Your basic application can be exactly the same, but you can have a different 
window library for each customer or department. For example, your procedural code could process 
a module that determines a user’s security level. Based on this information, you could open a 
different window library that matches the security level associated with that user. One window 
library has an opening menu with 10 choices; another has an opening menu with 5 choices. Your 
application’s procedural code does not require any change to restrict access to choices that are not 
on the menu: the choices simply do not exist for a user if the associated menu entries are not 
displayed.

Specifying a window library
When you initialize UI Toolkit (using U_START), the first argument you specify is the name of 
your primary window library. The channel number on which this library file is opened is stored in 
the global variable g_utlib. Our examples contain many references to this variable. 

However, your application can also have other window libraries open. To do so, simply use 
Toolkit’s open routine, U_OPEN, to open the library in input mode. To access any secondary 
window library, simply pass the channel variable you passed to U_OPEN to the load routine.
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Creating Script Files and Window Libraries
Script files are text files created by Composer or a text editor. You can create window libraries 
using Composer, Script, or Proto. For information on how to use Composer, see chapter 4, 
“Designing Your User Interface.” For information on how to use Script and Proto, refer to the 
“Script” and “Proto” chapters of the UI Toolkit Reference Manual. 

Creating and processing menu columns
UI Toolkit provides windows-style pull-down menus in both Windows and non-Windows 
environments. 

A menu column is a list of entries that pull down from the menu bar. The menu bar can 
accommodate many menu columns, although only one can be pulled down at any given time. The 
menu bar (and its associated columns) are activated by pressing ALT (on Windows) or CTRL+P (on 
UNIX and OpenVMS). Navigation through the columns is controlled by the arrow keys and by 
each entry’s “quick-select” character. In Windows environments, full mouse support is enabled. In 
addition, when a menu column is not pulled down, special key shortcuts can be assigned to select a 
particular menu entry. 

1. Define menus

The first thing you must do to use Toolkit menu processing is define your menu columns. You can 
define menu columns with Composer or a text editor. When you have finished defining your menus, 
you need to add these definitions into a window library. See “Managing Window Libraries to Store 
and Retrieve Display Components” on page 6-9 for more information about window libraries.

Assigning shortcuts

An optional menu shortcut enables the associated entry to be selected when the menu column is not 
pulled down (for example, while the user is doing input or viewing a list). Pressing a shortcut is the 
equivalent of pulling down a menu column, highlighting an entry, and pressing ENTER. For an 
entry’s shortcut to be accessible to the user, its menu column must be “placed” (visible) on the 
menu bar. Valid shortcut keys include control, function, and arrow keys.

Assigning quick-select characters

When a menu column is pulled down, pressing an entry’s quick-select character selects that entry if 
the quick-select character is unique. If the quick-select character is not unique, the entry will be 
highlighted. By default the quick-select character is the first character in the displayed text. 
Multiple entries can use the same quick-select character; the entries will be dealt with sequentially. 
Thus, in the sample menu script below, pressing an “a” (or “A”) when the first menu is pulled down 
would position you to the “Abort” choice. Pressing “a” again would position you to the “About” 
choice. 
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Using reserved entry names

The menu entries described so far return as events to be processed by your program. But another 
class of entries is handled automatically by UI Toolkit, without ever exiting the Toolkit routine 
from which they were selected. These are called reserved entries. When any menu selection is 
made, Toolkit checks the entry name before returning to your program. If it recognizes the entry as 
one of the set of reserved entry names, Toolkit performs the associated task and then resumes 
processing without returning to your program.

These reserved entries are used to activate many of the standard functions of UI Toolkit, so you 
don’t have to. Commands to control text editing, field navigation, context-sensitive help, and list 
navigation are among those enabled by reserved entries. 

To take advantage of these capabilities, choose the functions you want to enable, include the 
appropriate reserved entry name in a menu column, and then place the column on the menu bar. 
You don’t have to write any code, you don’t have to call any routines—just activate the feature by 
enabling your user to select it from the menu bar.

Below is a list of reserved prefixes to avoid when naming a menu entry that you want to return as an 
event to your program. A detailed list of each reserved entry and its associated function can be 
found in Appendix B of the UI Toolkit Reference Manual.

C_ Composite window functions

E_ Editing routine functions

I_ Input routine functions

O_ Key mapping or renditions

S_ Selection window and list navigation functions

T_ Text window viewing and display functions

TS_ Tab set functions

U_ Hot-entry processing

Sample menu script

The following commands define three menu columns. This code would reside in a script file.

.column general,  "General"

.entry o_help,    "Help",  key(F1)

.entry o_exit,    "Exit",  key(F4)

.entry o_abandon, "Abort", key(^A)

.entry g_about,   "About"

.end

.column main,    "Main"

.entry customer, "Customers"

.entry vendor,   "Vendors"

.end
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.column input,   "Input"
.entry i_prev,   "Previous field", key(UP)
.entry i_next,   "Next field",     key(DOWN)
.entry e_left,   "Move left",      key(LEFT),select(l)
.entry e_right,  "Move right",     key(RIGHT),select(r)
.end

The first three qualifiers in each menu column definition (the command, the name, and the text) are 
required and must be specified in order. In each .COLUMN line, the first qualifier after .COLUMN 
is the column name. This name is used in the program to load the column. The second qualifier (in 
quotation marks) is the header text. This text is visible on the menu bar when the column is placed, 
or made available to your user. 

In the .ENTRY line, the qualifier in the second column is the entry name. When an entry is 
selected, the entry name is returned in uppercase to the program (using the Toolkit global variable 
g_entnam) so the program can determine the event that caused the Toolkit routine to exit. The third 
qualifier in the .ENTRY line contains the text that is displayed in the menu column. The entry 
options begin in the fourth column and can be specified in any order. The key keyword indicates the 
shortcut to be associated with the menu entry; select is the entry’s quick-select character.

In most applications, a general menu column is available at all times to provide the basic functions 
the user can enter at any time (Help, Exit, Abandon, About, and any application-specific functions 
you choose). The first column in the sample script is an example of a general menu column.

The third menu column in our example (input) contains only reserved menu entries. When 
selected, these entries are processed automatically by UI Toolkit without returning to the program.

Note that each column definition is terminated with a .END. This is required.

2. Load the menus

To use menus in your program, you first have to load their definitions into UI Toolkit’s memory 
using the M_LDCOL subroutine. This Toolkit routine locates the specified menu column in the 
window library and loads its definition into the Toolkit memory area. It then returns a value in the 
variable you have passed as the first argument. From this point on, every reference to this menu 
column is accomplished by referencing this variable. Like all other identifiers used by Toolkit, 
column and window IDs should be i4 variables. 

The following code loads several menu columns:

startup,
    xcall date(date)
    xcall u_start("cust_lib", 1, 1)        ;Initialize--1 header line, 
                                           ; 1 footer line
    xcall e_sect("C U S T O M E R   P R O F I L E", 
  &              D_HEADER, D_CENTER)       ;Place text in header
    xcall e_sect(date, D_FOOTER, D_LEFT)   ;Place text in footer
    xcall m_ldcol(gen_col, g_utlib, "general",,, D_GLOBAL)
    xcall m_ldcol(options_col, g_utlib, "options")
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    xcall m_ldcol(input_col, g_utlib, "input", D_NOPLC)
    xcall m_ldcol(select_col, g_utlib, "select", D_NOPLC) 
    return

U_START places the channel for the primary window library (the first argument) in the global 
variable g_utlib. All of the columns loaded above reside in cust_lib. In this example, the input and 
select menu columns are loaded but not placed on the menu bar. Because this is the only place in 
the application that loads these columns, and this code is only executed once, there is no need to 
pass the optional search argument.

Notice too that the general column is promoted to global status. All global menu columns are 
placed on the menu bar to the left of local columns, regardless of their placement order. By making 
the general column global, we can also take advantage of UI Toolkit features that allow placement 
and removal of columns by their local or global status.

3. Process menus

The following sample code demonstrates basic menu processing. While placed menu columns and 
their entries are accessible in almost every UI Toolkit routine that receives input from the user, 
M_PROCESS is the Toolkit routine that forces the menu bar to process. Below is one method for 
giving your user a list of options at the start of an application. It assumes that the entry names 
returned by M_PROCESS match the name of the programs they activate.

do
  begin
    xcall m_process("[customer]")
    if (g_select)
      begin
        xcall e_enter
        xcall m_column(D_REMOVE, D_LOCAL)
        xcall xsubr(g_entnam)
        xcall e_exit
      end 
  end
until (done_flg)

The code starts a loop that explicitly processes the menu bar until the user makes a selection. When 
the menu bar is first activated, the customer menu entry is highlighted. Until a selection is made, 
UI Toolkit controls the interface. When a selection is made, M_PROCESS exits and the program 
needs to determine the event that occurred. 

We start by testing the global variable g_select. If this variable is true (in other words, nonzero) 
UI Toolkit is telling us that the reason it returned from M_PROCESS was that a menu entry was 
selected. Next we enter a new environment and prepare for the new program to be called by 
removing all local columns (those columns that are no longer valid now that a selection has been 
made). Since a new environment has been entered, whatever program gets called by the XSUBR 
subroutine can modify the Toolkit screen in any way necessary; these changes are reversed when 
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the program exits and E_EXIT is called. When the user is done, he or she selects “Exit,” which 
returns O_EXIT in g_entnam. Our external subroutine O_EXIT sets the global variable done_flg 
equal to true, and the program exits the loop.

Another way of processing a menu column is with a CASE or USING statement. Consider the 
following example:

repeat
  begin
    xcall m_process("[customer]")
    if (g_select)
      begin
        xcall e_enter
        xcall m_column(D_REMOVE, D_LOCAL)
        using (g_entnam) select
          ("CUSTOMER, VENDOR"), xcall customer
          ("OTHER"), xcall other
          ("O_EXIT"), exitloop
        endusing
        xcall e_exit
      end 
  end

Each of the menu selections has a corresponding match value except o_help. O_help is a reserved 
entry that UI Toolkit processes directly. We will discuss help in “Implementing native Toolkit help” 
on page 6-34.

Note that the “OTHER” label has no corresponding menu entry. This entry can never be accessed 
by this program while the menus are defined as they are in this example. To enable this selection, a 
menu choice would have to be added to an existing menu column, or another menu column that 
contains this entry would need to be placed on the menu bar. This is a prime example of how you 
can distribute a complete application and only enable certain portions of the code, based solely on 
the composition of the window libraries. If your customer wanted to pay for the additional features, 
you would simply have to provide a window library with a column that contains the additional 
entry—the customer would have access to that entry, and you wouldn’t need to change any code.

While the CASE or USING approach may require a little more code, it is more self-explanatory: 
anybody looking at this code can see exactly what happens with each menu event. Of course, if the 
number of possible menu selections is large, the selection statement can become quite unwieldy, 
making the XSUBR approach more desirable. XSUBR is also more flexible, enabling you to create 
a generic menu processing routine and also to add an unlimited number of menu entries without 
modifying your code.

UI Toolkit uppercases the return values before moving them to g_entnam. If you specify 
your match values in lowercase, they will not match. 
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What has been discussed here is only a portion of the capabilities of UI Toolkit menu processing. 
Consult the “Menu Routines” chapter of your UI Toolkit Reference Manual for a comprehensive 
description of the Toolkit routines that affect menu processing. Additional options offer such 
features as menu creation at execution time, manipulation of menus in environments, and 
submenus. Because menu processing drives all Toolkit processing, a thorough understanding of 
how menus work is essential.

Creating and processing input windows
With an understanding of menu processing, we are ready for the next logical step. How do we 
display and retrieve information from our users? The answer: input windows.

To use a UI Toolkit input window, your perspective has to change. In your old style of 
programming, you had to deal with each field as a separate entity, taking care to position the cursor 
correctly, display the prompt, and then read the data. Once your program had the data, you had to 
decide if the data was valid and perhaps reformat it. If an input error was detected, you had lots of 
code to erase the screen section, reposition the cursor, acquire the input again, redo the edits—until 
you got acceptable data. Only when this process was complete could you move on to the next field.

With UI Toolkit input windows, you no longer have to think in terms of processing individual fields 
in a record. Instead, you deal with them as a group that is managed by Toolkit on your behalf. 

Field information originates as an input window definition in a script file. The script file can either 
define field options locally, pull information from the repository, or do a combination of both. Since 
most fields in an input window have a corresponding field in the data area of your program, it 
makes sense to define this data once, in the repository, and reference the definition in both your 
source and script files. If you have input fields that will be used in more than one window, it’s also 
helpful to use S/DE Repository to store field information (such as position, prompt, and validation). 
UI Toolkit’s ability to extract information from Repository is one of its most useful features.

Most of the edits that you are used to making on input data can now be done automatically by 
UI Toolkit’s input processor. For instance, you can specify that a particular field is decimal and 
must contain a value between 100 and 1000. If the user enters a value that is outside that range, or 
that is not decimal data, Toolkit will detect the error, display the appropriate message, erase the 
field, and reposition the cursor for input. For alpha fields, you can create a list of correct entries to 
be displayed for the user; the user will be able to select only from that list of valid options. 

Of course, many other data validation options are available: you can require nonblank or nonzero 
input to a field, specify the help window for the field, provide text to be displayed on the 
information line when the field is processed, define a field’s paint character, specify a field’s 
display format string, identify routines to call when the user enters or leaves a field, and more. (For 
more information on arrive and leave methods, see “Using Methods” on page 6-43.)

With Repository you can define a field’s characteristics once, and all input script references to that 
field definition are assured the same characteristics. If you need to change a field attribute (for 
instance, you have a department field that has an associated selection list and you want to add 
another department) all you need to do is add that department to the selection list in your repository 
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and rebuild your window library. The next time your application is run, every instance of that field, 
on every screen in the application, will contain the additional department. You can also override any 
Repository characteristic (except the data type and size) in your script file.

1. Load navigation columns 

To handle interfield and intrafield movement in a non-Windows environment, UI Toolkit provides 
you with a number of reserved menu entries. The three primary reserved entry types are those that 
apply to every field (I_ and some E_), those that apply to selection windows and lists (S_), and 
those that apply to text fields (E_). Define a separate menu column for each of these entry types. 

Load (but don’t place) each of these columns at start-up. When you call I_INPUT, pass the ID for 
the “input” column in the fourth argument position, the “select” column in the fifth position, and 
the “text” column as the sixth argument. I_INPUT will place and remove each column when 
appropriate, and when a selection is made from any of these columns, it will perform the designated 
task without returning to your program.

Because these tasks are handled automatically on Windows, UI Toolkit on Windows does not place 
these menu columns. If you plan to run your application as both Windows and non-Windows, don’t 
mix reserved and nonreserved (to be returned as events to be processed by your application) menu 
entries in a column to be placed by I_INPUT. If you do, that column will not be placed on 
Windows, and events your program expects will never be generated.

2. Define input windows

Like all other UI Toolkit screen components, input windows are defined in script files and 
processed into window libraries. To define an input window, you can use Composer or a text editor. 
The following is a script file definition of an input window. In this example, all the field 
information is defined locally. This approach gives you the ability to view the entire structure of the 
input window, including the .FIELD options, at a glance.

.input customer, 14, 71

.placement 3, 5

.title "Customer Folder", color(3)

.line WndLin1, 65, pos(5, 4)

.line WndLin2, 65, pos(10, 4)

.line WndLin3, 65, pos(14, 4)

.repository_structure CUSTOMER

.field cmpny, a45, prompt("Company "), pos(2, 8), fpos(2, 16), break, -
     drill_method("cmpny_drill"), hyperlink_method("hyperlink")
.field address, a45, prompt("Address "), pos(3, 8), fpos(3, 16), - 
     hyperlink_method("hyperlink")
.field city, a25, prompt("City "), pos(4, 8), fpos(4, 16), -
     hyperlink_method("hyperlink")
.field state, a2, prompt("State "), pos(4, 44), fpos(4, 50), -
     hyperlink_method("hyperlink")
.field zip, d5, prompt("Zip "), pos(4, 55), fpos(4, 59), -
     hyperlink_method("hyperlink")
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.field a4, salutation, fpos(6, 3), -
     select(0, 0, 4, "Mr. ", "Mrs.", "Miss","Ms. "), radio, -
     select(0,0,1, "Mr.", "Mrs.", "Miss", "Ms.", -
     hyperlink_method("hyperlink")
.field lname, a16, prompt("Last "),  pos(6, 11), fpos(6, 19), -
     help("h_lname"), drill_method("contact_drill"), -
     hyperlink_method("hyperlink")
.field fname, a16, prompt("First "), pos(6, 41), fpos(6, 47), -
     hyperlink_method("hyperlink")
.field phone, d10, prompt("Phone "), pos(7, 11), fpos(7, 19), -
     hyperlink_method("hyperlink"), format("XXX/XXX-XXXX")
.field fax, d10, prompt("Fax "), pos(7, 33), fpos(7, 37), -
    hyperlink_method("hyperlink"), format("XXX/XXX-XXXX")
.field modem, d10, prompt("Modem "), pos(7, 51), fpos(7, 57), -
     hyperlink_method("hyperlink"), format("XXX/XXX-XXXX")
.field email, a47, prompt("E-mail "), pos(8, 11), fpos(8, 19), -
     hyperlink_method("hyperlink")
.field notes, a47, prompt("Notes "), pos(9, 11), fpos(9, 19), -
     hyperlink_method("hyperlink")
.field type, a10, fpos(11, 4), hyperlink_method("hyperlink")
.field status, a10, fpos(13, 4), hyperlink_method("hyperlink")
.field sl, d1, prompt("Licensed for SL "), fpos(11, 22), checkbox
.field tk, d1, prompt("Licensed for Tk "),  fpos(12, 22), checkbox
.field rps, d1, prompt("Licensed for RPS "),  fpos(13, 22), checkbox
.field pvcs, d1, prompt("Licensed for PVCS "), fpos(11, 42), checkbox
.field odbc, d1, prompt("Licensed for ODBC "), fpos(12, 42), checkbox
.field dte, d1, prompt("Licensed for DTE"), fpos(13, 42), checkbox
.button I_OK, text("OK")
.button O_ABANDON, text("Cancel")
.button O_HELP, text("Help")
.button_set bottom(3)
.set customer, CUSTOMER, cmpny, address, city, state, zip, salutation, -
     lname, fname, phone, fax, modem, email, notes, type, status, sl, -
     tk, rps, pvcs, odbc, dte
.set nokey, CUSTOMER, address, city, state, zip, salutation, lname, -
     fname, phone, fax, modem, email, notes, type, status, sl, tk, rps -
     pvcs, odbc, dte
.end

Take a look at the input window below. It’s the same input window, but in this example its field 
information is pulled from the repository. The advantage to defining your fields in Repository is 
that all the qualifiers for each field are defined only once, no matter how many times the field is 
referenced. There is no need for the .STRUCTURE command, because the structure information is 
part of the repository definition. If you include the repository definition in your program as well (as 
you should), a match between the data in your program and the fields in your window definition is 
ensured: the input processor will automatically know where to put the data for each field, regardless 
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of the order specified or gaps left by the exclusion of any fields. A downside to the repository 
approach is that to view field information, you must select the structure in Repository and look at 
each field definition separately.

Notice in the example that the lname and fname fields have a required qualifier. Any qualifier not 
specified in the repository can be added in the script file. If any qualifiers conflict, the one in the 
script file takes precedence. You can also turn off repository qualifiers in the script file.

.input customer, 14, 71

.placement 3, 5

.title "Customer Folder", color(3)

.line WndLin1, 65, pos(5, 4)

.line WndLin2, 65, pos(10, 4)

.line WndLin3, 65, pos(14, 4)

.repository_structure CUSTOMER

.field cmpny

.field address

.field city

.field state

.field zip

.field salutation

.field lname, required

.field fname, required

.field phone

.field fax

.field modem

.field email

.field notes

.field type

.field status

.field sl

.field tk

.field rps

.field pvcs

.field odbc

.field dte

.button I_OK, text("OK")

.button O_ABANDON, text("Cancel")

.button O_HELP, text("Help")

.button_set bottom(3)

.set customer, CUSTOMER, cmpny, address, city, state, zip, salutation, -
     lname, fname, phone, fax, modem, email, notes, type, status, sl, -
     tk, rps, pvcs, odbc, dte
.set nokey, CUSTOMER, address, city, state, zip, salutation, -
     lname, fname, phone, fax, modem, email, notes, type, status, sl, -
     tk, rps, pvcs, odbc, dte
.end
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Note that both input window definition methods have some things in common. Anything that does 
not pertain to a field definition is specified entirely in the script file. A default screen position is set, 
a title is specified, and lines are drawn to organize the screen into logical sections. The .SET 
commands create input sets: groups of fields to be processed or accessed as a unit. And on 
Windows systems, three buttons, “OK,” “Cancel,” and “Help” will be displayed. The 
.BUTTON_SET command specifies that these buttons will appear horizontally at the bottom of the 
screen (three buttons per row). 

3. Load input windows

Just like we had to load our menu columns with UI Toolkit, we also must load our input windows. 
The routine that does this is I_LDINP. 

xcall i_ldinp(customer_inp, g_utlib, "customer", D_NOPLC)

Notice in the sample that the definition of the window is taken from the default window library (the 
file open on the channel contained in g_utlib), and that we are not placing it on the screen at this 
time (D_NOPLC). It is a common practice to load all windows and menu columns in your 
initialization code and then place them only when needed.

4. Display an existing record

To display read-only data to a user, use I_DISPLAY to “display” or load the data into the window. 
Then the U_POPUP routine can be used to hold the information on the screen until the user 
presses ENTER. 

display_record,
   xcall e_enter                             ;So we can restore the 
screen
   xcall u_window(D_REMOVE, D_ALL, D_PLACE, customer_inp)
   xcall e_sect("View customer info", D_INFO, D_CLEAR, D_LEFT)
   xcall i_display(customer_inp,, customer)  ;Fill the window with data
   xcall u_popup(g_utlib, "customer")        ;Freeze the screen
   xcall e_exit                              ;Then restore the screen
   return                                    ;Return to where we were

In this example, a new environment is entered to enable us to reverse screen changes when we are 
done. Next, U_WINDOW is called to remove all other windows and place the customer window. 
I_DISPLAY is then called to load the window with data. Once the window contains the data to 
display, U_POPUP is called to update and freeze the screen. When the user presses ENTER, the new 
environment is exited, returning the screen to the state it was in when display_record was called.
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5. Add a new record

An input window that is used to get user input is processed in a loop. Consider this example:

process_window,
    xcall e_enter
    xcall u_window(D_PLACE, customer_inp)     ;Place at default position
    do
      begin                                   ;Begin input loop
        xcall i_input(customer_inp, "customer", customer, input_col,
  &                   select_col, text_col)
        if (g_setsts) then                    ;Menu entry or break field
          begin

     if (g_select) then 
              call menu_choices               ;Menu selection

     else 
       call break_fields               ;Break field
   end                               

        else
          call record_complete                ;Input set complete
      end                                     ;End input loop
    until done
    clear done
    xcall e_exit
    return

break_fields,
    using (g_fldnam) select
      ("CMPNY"), begin                            ;Check after each field
                   if (C_LNAME.and.C_FNAME)       ;Is key complete?

              call test_for_duplicates
                     if (duplicate) then
                       call init                  ;Initialize for next 
input
                 end
    endusing
    return

init,
    xcall u_message(%atrim(cmpny)+" already exists")
    xcall i_init(customer_inp, "customer", customer)
    return

menu_choices,
    using (g_entnam) select
      ("O_EXIT","O_ABANDON"), done = TRUE
      ("G_ABOUT"),            xcall u_about(TITLE, VERSION, 
%datecompiled)
    endusing
    return
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record_complete,
    store(customer_ch, customer) [$ERR_NODUPS=store_error]
    call init
    return

Here the input processor has control of all input until one of three events occur: 

 The user makes a menu selection.

 A “break” field is processed.

 Every field in the input set has been input to.

After the call to I_INPUT, we test for one of these three events and call an internal subroutine to 
handle the event.

The key to understanding input processing is understanding the structure of the input processing 
loop and the tests performed to determine the exit event. As we did in menu processing, we use 
global variables provided by UI Toolkit to determine the event that caused I_INPUT to exit. In our 
example we first examine g_setsts to find out if input processing is incomplete. If the value is true 
(nonzero), we know input processing is incomplete—either a menu selection or a break has 
occurred. Next we test g_select. If it is true, we know the user made a menu selection. A USING 
statement determines the menu selection that was made. If g_select is false, the exit event was a 
break field; this time the USING statement determines the field that activated the break. If g_setsts 
is false, no further processing needs to be done on this input set. We store the completed record and 
initialize the window in preparation for the next record.

When I_INPUT exits, it retains the context for the next time it is called. The context is simply the 
next field to process. By default, it is always the field after the field that caused I_INPUT to exit. So 
after a break field is processed or a menu selection is made, when the program returns to the top of 
the loop and calls I_INPUT again, processing resumes right where it left off. I_NEXT (see the 
example below) changes the input context, and I_INIT resets the input window to its initialized 
state. The context for an initialized window is the first field in the input set.

See “Modify an existing record” below for another example of how to add a record.

6. Modify an existing record

To use your input window to modify an existing record, load the data into the window with 
I_DISPLAY. Use I_NEXT to set the context (the input field to be processed with the next call to 
I_INPUT).

process,
    xcall e_enter
    set = "customer"
    do
      begin
        xcall i_input(customer_inp, set, customer, input_col, select_col)
        if (g_setsts) then ;Check for incomplete input processing
          if (g_select) then ;Menu processing
            xcall xsubr(g_entnam) ;Entry name matches subroutine name
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          else
            begin ;Break processing
              using (g_fldnam) select
                ("CMPNY"), call dup_chck
              endusing
            end ;Break processing
        else
          begin ;Input set complete
            if (load_flg) then ;Either MODIFY mode...
              begin
                read(customer_ch, cmpny, cmpny) [$ERR_TOOBIG=cont]

cont,
                write(customer_ch, customer)
                clear load_flg
              end
            else ;... or ADD mode
              using (set) select
                ("customer"), store(customer_ch, customer) [ERR=updterr]
                ("nokey")   , write(customer_ch, customer) [ERR=updterr]
              endusing
            if (FALSE)
              begin ;Store failed

updterr,
                xcall u_message("Error updating customer file")
              end
            xcall init ;Initialize window, enable cmpny field
          end ;Input set complete
      end
    until (done_flg)
    xcall e_exit
    return

dup_chk,
    find(customer_ch, customer, cmpny) [$ERR_KEYNOT=newrec, 
  &      $ERR_EOF=newrec]
    reads(customer_ch, customer)
    xcall i_display(customer_inp, set="nokey", customer)
    xcall i_next(customer_inp, set, "*FRST*")

newrec,
    return

In this example we take advantage of multiple input sets to either add or modify data. If we 
determine in the dup_chk internal subroutine that the record exists, we read the data and load it 
into the input window with I_DISPLAY. Notice that we change the input set from customer to 
nokey. This is because we will be modifying an existing record and don’t want the user to modify 
the primary key. If you look in the script definition for the customer window, you’ll see that the 
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nokey input set contains all fields except the primary key, cmpny. Because I_DISPLAY flags every 
field as having input entered in it, I_NEXT is called to set the context to the first field in the nokey 
input set. When dup_chk returns to the input processing loop and re-executes I_INPUT, the input 
window will contain the data to modify, and the user will not be able to access the cmpny field.

If the FIND statement fails to find a matching record, it skips the code that updates the input 
window and returns to the input loop to continue “add” processing.

Creating and processing selection windows
Selection windows are a powerful way to present a set of valid options to your user. If you specify a 
list of values for a field (in either its script or repository definition), when that field is processed, a 
selection window containing those choices appears. Your user can only select from those choices. 

If several of your input windows contain fields that share a set of valid choices, you can create a 
single selection window and associate it with each of those fields. Thus, you maintain the list of 
choices in only one place, and by changing just that window, every field that uses the window is 
changed.

Note that although only static selection windows are discussed in this section, UI Toolkit also 
provides routines that enable you to build selection windows at runtime. This feature enables your 
application to create and modify selection windows based on factors that are not determined until 
the program executes. For example, selections can be loaded from a file, based on security or 
license status. See the “Selection Routines” chapter in the UI Toolkit Reference Manual for more 
information.

1. Define selection windows

Selection windows are quite simple to create and maintain. You can use Composer or a text editor 
to create selection windows. (Composer uses its own text editor to create selection windows.) The 
following sample code defines two selection windows:

.select yes_no

.placement 2, 2

.border on, color(1)

.item "Yes"

.item "no"

.end

.select marital_stat, 2

.placement 2, 2

.border on, color(1)

.item "Married"

.item "Divorced"

.item "Widowed"

.item "Single"

.end
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The first selection window is a generic window for yes or no answers. The choices are displayed 
vertically. In most applications, you would also create a no_yes selection window with the items 
reversed. This is because the default choice is the first one listed; assigning the appropriate 
selection window to your fields (with the selwnd .FIELD qualifier) makes your application more 
user-friendly. The second window is a marital status list. It has four entries. The “2” on the 
.SELECT command is the number of rows to display; the entries in this column are split into two 
two-row columns.

2. Process selection windows

To move about in your selection windows in a non-Windows environment (it is handled 
automatically on Windows), create a menu column that contains the selection window reserved 
menu entries (S_). In most cases, you will associate each entry with a shortcut. (The arrow keys are 
a logical choice.) If you pass the column ID as the fifth argument to I_INPUT, the column will be 
placed whenever a selection field is processed and removed as soon as that selection field is exited. 
The sample below uses the reserved entries and associates them with the arrow key shortcuts. It is 
to be loaded (but not placed) at start-up.

.column sel_col, "Selection keys"

.entry s_up, "Up", key(UP)

.entry s_down, "Down", key(DOWN)

.entry s_right, "Right", key(RIGHT)

.entry s_left, "Left", key(LEFT)

.end

Creating and processing text windows
One of the most difficult things to code is a text editor. Many applications require editing 
capabilities, whether it be to allow entry of comments on a purchase order, special instructions on a 
delivery order, or justification on a General Ledger entry. Some applications address the problem 
by calling a system utility to perform the editing. But what happens when you move to another 
platform and that utility is not available? Or you upgrade your system and the utility you previously 
used is not yet available on the new version? Your application doesn’t work, or its capabilities are 
severely diminished. To address this problem, and to give your application true platform 
independence, UI Toolkit provides text-editing capabilities through T_EDIT (and related text 
routines) and through U_EDIT.

T_EDIT is the original Toolkit text editing routine, and it’s part of a group of routines that work 
with text windows (windows set up with T_SETUP). For example, once text has been edited, you 
can use T_VIEW to display the text in read-only mode. U_EDIT on the other hand, was created for 
more Windows-like editing capabilities, so unlike T_EDIT, it preserves hard returns. It enables you 
to pass in multiple lines of text separated by hard returns when it starts, and it preserves hard returns 
in resulting text when control returns from U_EDIT. The following sections outline steps for using 
T_EDIT and other text routines to edit text in a text window. For information on U_EDIT, see 
U_EDIT in the “Utility Routines” chapter of the UI Toolkit Reference Manual, which includes an 
example that illustrates its use.
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1. Define menu columns for text functions

UI Toolkit enables you to edit or simply view text. Both capabilities are handled via text windows 
and reserved menu entries. Edit functions are activated by the E_ reserved entries, and the text view 
functions (scrolling) by the T_ reserved entries. Each set of entries should reside in its own column, 
with a unique shortcut key assigned to each entry. This script shows typical edit and view columns:

.column textedit, "Edit text"

.entry e_left, "Move left", Key(left)

.entry e_right, "Move right", Key(right)

.entry e_emov, "End of line", Key(end)

.entry e_bmov, "Beginning of line", Key(home)

.entry e_xup, "Move up", Key(up)

.entry e_xdown, "Move down", Key(down)

.line

.entry e_cdel, "Delete character", Key(del)

.entry e_lclr, "Clear line", Key(^X)

.entry e_edel, "Clear to EOL", Key(^E)

.entry e_ilin, "Insert a line", Key(ins)

.entry e_join, "Join lines", Key(^J)

.end

.column textview, "View text"

.entry t_top, "Top of window", Key(^T)

.entry t_bottom, "Bottom of window", Key(^B)

.entry t_lside, "Left side of window", Key(^L)

.entry t_rside, "Right side of window", Key(^R)

.line

.entry t_pagup, "Scroll up page", Key(prev)

.entry t_pagdwn, "Scroll down page", Key(next)

.entry t_scrup, "Scroll up half page", Key(f8)

.entry t_scrdwn, "Scroll down half page", Key(f7)

.end

2. Define the text window

The text window should be large enough to contain the text to be viewed or edited. If the window is 
too large for the screen, you must specify a display area that fits the screen. UI Toolkit will use the 
reserved entries your user selects to manage the scrolling of the display. This script window 
definition can be created in Composer or a text editor. 

.window text, 99, 73

.display_area 1, 1, 20, 73

.placement 2, 2

.end

The sample above defines a window that is 99 lines long and 73 characters wide. The display area is 
20 by 73, and starts in row 1, column 1 of the window. By default, the window will be placed at row 
2 column 2 of the display region. U_WINDOW can be used to change the default placement.
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3. Load the window and menu columns

Just as we have done with all of our other Toolkit objects, we need to load our window and our 
menu columns. The routine used to load a display (noninput) window is U_LDWND. Notice in the 
example below that neither the window nor the columns are placed. The window is placed when it 
is time to use it, and the UI Toolkit text routine places and removes the columns automatically.

xcall u_ldwnd(text_win, g_utlib, "text", D_NOPLC)
xcall m_ldcol(view_col, g_utlib, "textview", D_NOPLC)
xcall m_ldcol(edit_col, g_utlib, "textedit", D_NOPLC)

4. Convert the window

Once the window is loaded, it must be converted into a text window. T_SETUP establishes the 
controls for the display of the window and the default behavior for subsequent data that is loaded 
into the window. Display characteristics such as margin settings, paragraph treatment, display color 
and renditions, text wrapping, and display size can all be set with T_SETUP.

For our example, the window is placed as specified in the script file. We use the T_SETUP defaults 
and clear the window of any text that might have remained from the previous edit. 

xcall e_enter
u_window(D_PLACE, text_winid) ;Place at default position
xcall t_setup(text_winid, D_INIT) ;Initialize the window

5. Add data to the window

To edit the text window, we place the call to T_EDIT in a loop. Exit from the loop is controlled by 
menu entries in a column placed before the call to T_EDIT (a column that doesn’t contain any 
reserved menu entries). We allow T_EDIT to load our reserved entry menu columns for us. The 
example takes all of the default text processing modes (start at row 1, column 1; set insert mode; 
edit in a forward direction; allow lowercase input). By passing the variables in the row, column, 
insert, and case positions, we save the exit value for each. When the program returns to the top of 
the loop and calls T_EDIT, editing resumes in exactly the same place, in the same mode.

repeat
  begin
    xcall t_edit(text_win, row, col, insert, dir, case, edit_col, 
  &              view_col,, "text_help")
    if (g_select)
      case g_entnam of
        begincase
"SAVE":   begin ;Save and resume
            call write_data
            exitloop
          end
"O_ABANDON": exitloop
        endcase
  end
xcall e_exit
return 
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6. View the contents of the text window

Use T_VIEW to enable the user to scroll through the contents of a text window without editing it. 
The example below does not put T_VIEW in a loop because the only event that causes it to exit is 
“Exit.” When the user selects “Exit,” there is no reason to re-enter. Scrolling through the window is 
handled by the reserved menu entries contained in the view_col column.

view_text,  
    xcall e_enter
    u_window(D_PLACE, text_winid, 1, 1)
    xcall t_view(text_win, view_col, "view_help")
    xcall e_exit
    return

Extracting data from a text window
When text in a text window has been edited, we can do one of two things to save the input: 

 Store the contents of the window into a window library.

 Extract the information from the window into our program’s data area so it can be processed in 
some manner. 

The following extracts the data to the program. To store the window and its contents to a window 
library, see the U_SAVE subroutine in the “Utility Routines” chapter of the UI Toolkit Reference 
Manual.

1. Define a data structure to hold the window contents

The first thing needed to extract the data from a text window is an alpha array with at least as many 
elements as there are rows in the text window. The size of each element should match the number of 
columns in the window. In the example, we allocate an alpha array whose dimension is based on a 
compiler definition (NUMLINES). We use a .DEFINE so we can use the same value as an upper 
boundary when we unload the window data into the array. If at some point in the future the text 
window needs to change size, we only have to change the value in the .DEFINE; all references to 
this value will remain synchronized. 

.define NUMLINES,       99 ;Number of lines in text window
record
    textline        ,[NUMLINES]a73

2. Unload the data 

To unload the data, we call the UI Toolkit routine T_GETLIN. Our example routine transfers the 
data from the text window into the textline array, starting with line 1 and continuing through line 
99 (NUMLINES). Because the user may not have filled the entire window with text, it might be 
beneficial to know exactly how many lines were retrieved; this value is returned in the lines_input 
variable. This variable is used as the upper boundary in the routine that stores the data.

write_data,
    xcall t_getlin(text_win, textline, NUMLINES, start_line=1,
  &                lines_input) 
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    for ivar from 1 thru returned           ;Now store the data records
      begin
        entry_number = hold_entry
        entry_line = ivar
        entry_text = textline[ivar]
        store(text_ch, diary)
      end
    return

See the “Text Routines” chapter in your UI Toolkit Reference Manual for more information about 
other text processing features, including the ability to load text into a window and store data with 
the window in a window library.

Creating and processing lists
A list is a virtually unlimited collection of identically formatted items, its size limited only by the 
disk space available. In its most basic form, a list is a visual representation of a file. But a list 
doesn’t have to derive its contents from a single file—you can construct the items in a list of data 
from any source or any combination of sources. But, like the records in a file, while the contents of 
each item are different, each item is structured the same.

An input window defines the structure of a single list item. Usually you create this input window 
for the sole purpose of associating it with a list. To display the list on the screen, the list processor 
makes multiple copies of this input window, each with its own data.

Of course, you may want to do some things a little differently for your list input windows. If you 
want your application to be portable to Windows platforms and want to use multiline list items, you 
will need to use the ActiveX list control when processing your list. With a UI Toolkit list, you are 
restricted to single-line list items (and thus a single-line list input window). In most cases, your list 
will have a header, so having prompts in your window will not make much sense. Also, if you pull 
the field definitions from your repository and the repository contains default values for pos and 
fpos, make sure you override them in the script definition. 

In your script file you will also define the list class. While an input window defines the structure of 
a list’s items, the list class defines the characteristics for the entire list. Things like the number of 
items visible at one time, the list’s position on the screen, any methods (special subroutines called 
by the list processing routines) associated with the list, and the number of header and footer lines 
are all part of the list class.

When the list processor is called, it tries to perform the request your program passed to it. If this 
request requires an item that hasn’t been loaded onto the list, the list processor calls your load 
method. A load method is a subroutine written by you that the list processor calls each time it needs 
a new item. Once an item is loaded, the list processor manages that item itself, storing its 
information in its own temporary files. The load method is called only once per item, regardless of 
the number of times that item is accessed.
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A list item consists of two components: 

 The display component, which is the formatted information as it is displayed on the screen

 The data component, which is data that you associate with the item 

In the simplest case, the display component matches the data component, but there is no 
requirement that they be related. Your load method should load the list’s display component into its 
input window and the data component into its data area.

For more information, see the “List Routines” chapter in your UI Toolkit Reference Manual. List 
processing is truly the most powerful display tool in UI Toolkit. The example here demonstrates 
only the most basic aspects. The possibilities for managing the display of data, from doing input 
directly into an existing list to advanced search capabilities, are extensive. 

1. Define the display window

Our sample window contains a field that will be loaded (as the title indicates) with the company and 
contact names. The data to be loaded into this field is constructed in the load method, from the 
company, fname, and lname fields.

.input cstlst_inp, 1, 64

.placement 2, 2

.title "Company, Contact"

.field display, a64, fpos(1,1)

.end

2. Define the list class

As you can see, there isn’t much to a list class definition. In the sample below, we define a page as 
containing five items, reserve one line for the header, and specify the load method. The list will be 
placed at row 1, column 15.

.listclass customer_list, items(5), -
                          headers(1),  -
                          load_method("load_cust")
.placement 1, 15
.end

3. Create the load method

Because your application does not call the load method directly, you do not control the arguments 
passed to it—you must write the routine to conform to the arguments that the list processor passes. 
The arguments must match the format below exactly.

Communication between the subroutine and the list processor is accomplished through the request 
argument (a_request). A list can be expanded (a new item added) at the top, at the bottom, or at the 
top or bottom, depending on settings specified when the list is loaded from the window library. If 
the list is being loaded in both directions, your load method will check the request argument to 
determine whether the next new item is to be added to the top or the bottom.



Implementing Your User Interface with UI Toolkit
Creating Script Files and Window Libraries

6-30 Getting Started with Synergy/DE 10.3.3 (5/16)

In the example below, each new item is added to the bottom, so you don’t need to check a_request. 
Using a global variable for the input channel (the file was opened at start-up in the main routine), 
the load method reads sequentially through customer.ism from top to bottom (one record per call), 
constructs the display string, and calls I_DISPLAY to update the list’s input window with the 
display for each new item. 

In addition to the visible portion, data must also be associated with each item. A_data is the data 
area passed to the list processor (L_SELECT or L_PROCESS) and the list creation routine 
(L_CREATE). Once the item’s data has been returned by the load method to the list processor, your 
program can use it to search the list for a specific item, determine the current list item, perform file 
look-ups, load an input window for modification or viewing—just to name a few things. It is 
important that you pass the data area to be associated with the list to all the list routines and that you 
load it with the appropriate data in your load method.

When the load method READS encounters end of file, it skips the load logic and sets a_request 
equal to D_LEOF. This tells the list processor that no more items are to be added to the list. From 
this point on, the list processor will not call the load method again, and instead will manage all list 
items itself. 

subroutine load_customer
    a_listid ,n ;List ID 
    a_request ,n ;RETURNED - LP communication variable
    a_data ,a ;Data area (customer record)
    a_inpid ,n ;Input window ID 
    a_disabled ,n ;Flag for disabling an entry 
    a_itemindex ,n ;The item’s ordinal position in the list

.include "WND:tools.def"

.include "ids.gbl"

record
    display ,a65

proc
    begin
      reads(custload_ch, customer, eof)
      xcall i_display(a_inpid,,(display=%atrim(cmpny)+", 
  &                   "+%atrim(fname)+" "+lname))
      a_data = customer
      exit
eof,
      xcall i_init(list_inp)
      a_req = D_LEOF
    end
    xreturn
endsubroutine

Do not depend on the order in which items are requested when two-way loading is enabled, 
because the user can change the order in which items are loaded for any given list.
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Because load methods are just external subroutines, your application program can use all of the 
power of Synergy DBL to select or construct the items to add to the list. If you choose not to 
specify the load method in your .LISTCLASS definition, or if you want to use a different load 
method, the L_METHOD subroutine enables you to specify or change the load method at runtime. 

If your load method loads items sequentially from a file, the record pointer must be on the next 
record to be loaded. If the load method retrieves data on the same channel used to update the 
database file, there is no assurance that the pointer is on the correct record. Therefore, you must 
open the input file on a channel dedicated to the load method. No other I/O can occur on this 
channel. If the list is being expanded in both directions, the file must be opened twice: once for the 
forward READS, and once for the reverse READS. In other words, a channel must be dedicated to 
the list load method for each load direction.

4. Load the list input window and selection column

Before you can associate your list input window with a list, the window must be loaded. And, like 
other UI Toolkit routines that get input from the user, the list processor’s selection routine 
recognizes a set of reserved menu entries. The following statements to load both of these list 
components appear in the program’s start-up routine. Make sure you load your list input window 
and selection column with the D_NOPLC argument—the input window and selection column will 
be placed and removed with the list, automatically. 

xcall m_ldcol(lsel_col, g_utlib, "list_sel", D_NOPLC)   
xcall i_ldinp(customer_lst_inp, g_utlib, "cont_l_inp", D_NOPLC)

5. Create the list

All of the components are in place and ready to be assembled. We create our list with a call to the 
UI Toolkit routine L_CREATE. Although the syntax is different, L_CREATE can be compared to 
Toolkit’s load routines, in that it goes out to the window library, finds the specified definition, and 
loads it into memory. 

The creation of the list establishes the controls that will be used by UI Toolkit to manage the list. 
This is where the list’s display and data components are assigned—the second argument to 
L_CREATE is the ID of the list input window, and the third argument is the data area to be 
associated with the list. Each of these variables is passed by the list processor as arguments to your 
load method. 

xcall l_create(customer_lst, customer_lst_inp, customer, g_utlib, 
&            "listclass",,, D_NOPLC)

This sample code creates a simple list that will be loaded from top to bottom (the default). The list 
is loaded into UI Toolkit memory at start-up but is not placed on the screen. The customer record is 
established as its data area—it must be passed in all calls to the list processor as well.

L_CREATE also has additional arguments that control such things as the manner in which the list is 
loaded and its placement on the screen.



Implementing Your User Interface with UI Toolkit
Creating Script Files and Window Libraries

6-32 Getting Started with Synergy/DE 10.3.3 (5/16)

6. Process the list

The template for processing a list is quite similar to that for processing other UI Toolkit objects. 
A loop structure calls the Toolkit processing routine, L_SELECT. This routine processes the list 
selection-style. The first time L_SELECT is called, the list processor determines that it needs an 
item. It calls the load method, which returns with an item to be added to the list. The list processor 
adds the item, and because the list class says there are five items on a page, it repeats this step four 
more times. 

As soon as a page has been filled, L_SELECT puts a selection window on the screen. The user can 
move around through all the visible items (using the shortcuts associated with the reserved menu 
entries, or on Windows, using the mouse and arrow keys). With any request for an item not yet 
loaded—for example, if the user presses the shortcut to move down a page—the list processor once 
again calls the load method until the request has been filled. A request for an item (or page of items) 
that’s already loaded does not initiate a call to the load method. Instead the list processor retrieves 
the item (or items) from the file stack, a temporary file management system the list processor uses 
to manage the list.

repeat
  begin
    xcall l_select(customer_lst, request, customer,,,,,, lsel_col)
    using (g_entnam) select     
      ("G_ABOUT"),  xcall u_about(TITLE, VERSION, %datecompiled)
      ("O_EXIT"),   exitloop
      ("P_REMOVE"), call remove_entry
      ("P_MODIFY"), call modify_entry
      ("P_ADD"),    call add_entry
      (),           if (request) ;No menu entry
                      call process_request ;Process list request
                    else
                      call display_entry ;Display selection
    endusing
  end
return

L_SELECT exits when a menu selection is made or when the user selects an item by highlighting it 
and pressing ENTER. Though it isn’t displayed here, the display_entry routine determines the item 
selected by checking the data area passed to L_SELECT (as the third argument). It is essential that 
you pass to L_SELECT the same data area specified in the third argument to L_CREATE. If you 
don’t, there is no way to determine which item was selected.
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Implementing Online Help
Toolkit has routines that support three types of online help: native Toolkit help, HTML Help 
(.chm), and WinHelp (which is now obsolete). Native Toolkit help is the default mechanism for 
displaying context-sensitive help. It uses Toolkit windows to display autonomous help topics (as 
opposed to a help system). To implement native Toolkit help, you’ll associate help windows with 
fields and/or some routines, and you’ll use the O_HELP menu entry to activate help. See 
“Implementing native Toolkit help” below. 

With HTML Help and WinHelp, on the other hand, your help system can include a table of 
contents, index, and search (as well as different types of windows). Once the help system is open, 
users can use these and other features to navigate to other help topics. To implement HTML Help or 
WinHelp, you’ll call %U_HTMLHELP or %U_WINHELP. These routines wrap most of the 
functionality of the Microsoft HTML Help API and WinHelp API. The state of the help system 
when it opens depends on the options you pass in the call and the features available in the help 
system (table of contents, index, etc.).

No matter which of these help formats you use, you can use Toolkit’s built-in context-sensitive help 
features to associate a field and, in some cases, a routine with a help topic. These features include a 
replaceable help method, the O_HELP reserved menu entry, and context IDs for fields and some 
routines (as discussed in “Implementing native Toolkit help” below).

One way to implement HTML Help or WinHelp is to register your own Toolkit help method, and 
have that help method make the %U_HTMLHELP or %U_WINHELP call. If you do this, the 
O_HELP menu entry invokes your help method, and context IDs you’ve defined are automatically 
passed to the method. For example, with the following code an, HTML Help system (myhelp.chm) 
opens when the user presses F1 or selects Help from the menu. A context ID may be passed to the 
help method, so the help method has an argument that accepts a context ID. (For information on the 
cases in which a context ID is passed to the method, see EHELP_METHOD in the “Environment 
Routines” chapter of the UI Toolkit Reference Manual.) If a context ID is passed to the subroutine, 
the %U_HTMLHELP call displays the help topic for the context ID. If no context ID is passed (or 
if there’s no help topic for the context ID), the help system opens with the table of contents 
displayed.

proc

xcall e_method(D_METH_HELP, "help_method") ;This registers the help
                                           ; method defined below.
.
.
.
xcall mb_entry(cont, "O_HELP", "Help", F1_KEY) 
.
.
.
xcall ib_field(build_id, 'select1', D_FLD_SIZE, 10, D_FLD_TYPE, 
&              D_DECIMAL, D_FLD_POS, 2, 2, D_FLD_PROMPT, 
&              "Enter a number:", D_FLD_FPOS, 2, 19,
&              D_FLD_HELP, "Alink_B")
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.

.

.
;--------------------------------------------
;Help Method
 
subroutine help_method
    a_ident     ,a           ;Context ID. This is what you specify
                             ; with the help qualifier for .FIELD, 
                             ; the help_id argument for AX_INPUT, etc.
 
.include 'WND:tools.def'
 
 
proc
 
if (^passed(a_ident)) then
  u_htmlhelp(D_HH_HELP_CONTEXT, "myhelp.chm", a_ident)
else
  u_htmlhelp(D_HH_DISPLAY_TOC, "myhelp.chm")
 
xreturn
endsubroutine

Implementing native Toolkit help
Toolkit includes features that enable you to easily provide context-sensitive help in your 
application. You define your help windows in a script file and then compile them into a window 
library. Toolkit enables you to specify (with a .FIELD option or a Toolkit subroutine argument) 
which help window to display when your user requests help. When help is requested, UI Toolkit 
displays the help window specified for the context and removes it when the user clicks the close 
button on the help window.

1. Activate context-sensitive help

As we stated earlier, o_help is the reserved entry that activates the UI Toolkit help routine. You 
need to make this menu entry available wherever you want the user to have access to help 
information. We suggest that the O_HELP reserved entry be included in your General menu 
column.

2. Create the help windows

Creating the text for your help windows may be easier than you think. In fact, you may already 
have the bulk of the work done and simply need to reformat existing text into window definitions. 
For example, you may be able to borrow text directly from existing documentation, using an editor 
to place it in a UI Toolkit script window definition. As you will see from the example below, you 
can create a template for your help windows that will give all of them the same “look and feel” and 
yet allow for variable-length text in each window. Modifications can be made to the window 
contents without having to worry about reformatting the data for presentation.
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Note that your window script should contain a text window named h_general. This is a generic 
help window to be displayed when the UI Toolkit help routine can’t find the specified help window 
or when no help window was specified. This window should contain a generic message that is 
appropriate across the entire application. If Toolkit cannot find h_general, it displays an error 
message. Your application will have a more professional look if h_general is defined.

Below is an example of a general help window. Although it is defined to have 10 rows, the .TRIM 1 
command removes the empty lines at the bottom, leaving one blank line after the text.

.window h_general, 10, 40

.placement 10, 20

.text WndTxt2, position(1, 1)
There is no help available for this function.
.trim 1
.end

Two typical help windows are shown below:

.window h_lname, 10, 40

.placement 10, 20

.text WndTxt3, position(1, 1)
This field contains the contact’s last name. The last name is used to 
identify the record and therefore cannot be left blank. 
.trim 1
.end

.window h_tk, 10, 40

.placement 10, 20

.text WndTxt4, position(1, 1)
Check the Tk box if this customer is licensed for UI Toolkit.
.trim 1
.end

Notice that all of the help windows are defined as being 10 rows by 40 columns and are placed at 
location 10, 20 in the display region. Using the .TRIM command eliminates the need for you to 
determine how the text fits in the window. And if you ever modify the text in the window, the 
resizing will take place automatically when the script file is processed.

You may want to define your help windows in a separate script file, or you may choose to place 
them in the script file of the window with which they are associated. If you want to use UI Toolkit’s 
help routine as it is distributed, your help windows should reside in the library specified in 
U_START. Otherwise, you can replace Toolkit’s help routine with your own. See the 
EHELP_METHOD documentation in the “Environment Routines” chapter of the UI Toolkit 
Reference Manual for details.
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3. Associate help windows with fields

To simplify the association of help windows with the fields in your input windows, UI Toolkit 
provides the ability to identify the help window for each field. You can define this association once 
in your repository, and every instance of that field will inherit this information. Or you can specify 
it directly with the .FIELD help qualifier. The following is extracted from our previous input 
window script definition:

.field lname, a16, pos(1, 4), prompt("Last"), pos(6, 11), fpos(6, 19), -
    help("h_lname"), hyperlink_method("contact_drill")

If the window named h_lname exists in the primary window library and the user selects the o_help 
reserved menu entry while positioned on the field lname, the input processor calls the Toolkit help 
routine, which displays the appropriate help window and waits for a user response. When the user is 
done reading the help window, Toolkit removes it, restores the original screen, and resumes 
processing the input field.

Most UI Toolkit routines that prompt the user for input have a similar mechanism to activate the 
help routine and display a specific help window. For example, M_PROCESS, T_EDIT, T_VIEW, 
and L_SELECT all have an optional argument for the name of the help window to display if the 
user selects the help menu entry. I_INPUT uses the .FIELD help qualifier. You can even have a 
help window for each menu entry. 
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Organizing Your Display with Tabbed Dialogs
With UI Toolkit, you can organize windows and lists into a set of tabbed dialogs. While tabs are 
primarily a Windows feature, Toolkit makes tabs available on both Windows and non-Windows 
platforms. Each tab element or dialog contains an input window or list. All tabs in a group of tabs 
(called a tab set) are placed simultaneously, in an organized stack. Your user can select, via mouse 
or menu entry, any tab in the current set. The selected tab is brought to the front and its element is 
available to process. See the “Tab Set Routines” chapter of the UI Toolkit Reference Manual for 
more information.

1. Create a tab set

When a tab set is processed, each member tab and its associated element (a window or list) is 
accessible to the user. Before a tab can be created, you must define a tab set. The example below 
creates a tab set. The tab set ID is returned in contact_tab. Each tab will be 8 rows by 71 columns. 
No tab element can be larger than this.

contact_tab = %ts_tabset(DTS_CREATE, "contact_tab", 8, 71)

2. Load the input windows

Below we create three copies of the same input window, one for each of the three tabs to be created. 
(To create a copy of an input window, your call to I_LDINP must pass a window name in the eighth 
position; the load routine loads a copy of the window and assigns it the name passed in position 
three.) Of course a tab set doesn’t need to use the same window—it can consist of a mixture of 
completely unrelated input windows and lists. 

Next we call W_BRDR to create a title for the input window. This is important because the 
identifying text that displays on the tab is actually the title of the associated input window. Without 
a title on the associated input window, your user will have no way of distinguishing one tab from 
another (without selecting it).

for cntr from 1 thru 3
  begin
    xcall i_ldinp(contact_inp(cntr), g_utlib, "contact"+%string(cntr),  
  &               D_NOPLC,,, "contact")
    xcall w_brdr(contact_inp(cntr), WB_TITLE, cont_grp[1].c_lname)
  end

3. Populate the tab set

With the elements in place, we are ready to create a set of tabs. Below is the same code we used to 
load the input windows—with one addition. To the loop we added a 
%TS_TABSET(DTS_WINDOW…) function call. The DTS_WINDOW argument to 
%TS_TABSET creates a tab and associates an input window with it. (To create a tab and associate 
a list, use DTS_LIST instead.) When the user selects this tab, the window in contact_inp(cntr) is 
brought to the front, and our PROCESS_INPUT routine is called to process it. Since we have three 
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identical input windows, we can use the same process routine. If you need to process each tab 
differently (or are mixing different input windows or input windows and lists in the same tab set), 
you may want to specify a unique process routine for each tab.

for cntr from 1 thru 3
  begin
    xcall i_ldinp(contact_inp(cntr), g_utlib, "contact"+%string(cntr), 
  &               D_NOPLC,,, "contact")
    xcall w_brdr(contact_inp(cntr), WB_TITLE, cont_grp[1].c_lname)
  end
tabindx(cntr) = %ts_tabset(DTS_WINDOW, contact_tab,
  &                        contact_inp(cntr), "process_input")

4. Process the tab set

TS_PROCESS is the tab processing routine. It controls the placement of the current tab and calls 
the appropriate tab method. Like most UI Toolkit routines, TS_PROCESS is called in an event 
loop. When called, TS_PROCESS processes the current tab: it brings the associated window or list 
to the front and calls the tab method. When the user selects another tab, the tab method returns to 
TS_PROCESS, which brings the selected tab (and its associated element) to the front and calls that 
tab’s designated tab method. If a menu entry or button was selected, TS_PROCESS exits so your 
processing loop can test for and handle the exit event.

The sample below calls TS_PROCESS, and tests for an exit event. The cont_key method data is a 
group that contains an array of key values that identify the record to be loaded into each tab input 
window. See the code segment in step 5 for an example of how this method data is used.

If, in the tab method, the user selects the “Exit” menu entry or the “Cancel” button, TS_PROCESS 
loads g_entnam with the name of the selected event (O_EXIT or O_ABANDON) and returns 
immediately to this processing loop. If, on the other hand, another tab was selected, g_entnam is 
loaded with the name of the tab, in the form TS_TABxxxx, where xxxx is the tab number. 
TS_PROCESS moves that tab to the front and again calls the tab method, PROCESS_INPUT, this 
time without returning to the processing loop.

tab_num = 1
repeat
  begin ;Processing loop
    xcall ts_process(contact_tab, cont_key)
    if (g_entnam.ne."TS_TAB")
      exitloop
  end ;Processing loop

5. Create the tab method

The tab method below is called by TS_PROCESS for each of the tabs. We can use the same tab 
method because each tab contains a copy of the same input window, an input window that is 
processed in exactly the same way. PROCESS_INPUT starts by using the DTS_ACTIVE option to 
determine the current or “active” tab. (DTS_ACTIVE can also be used to change the active tab.) It 
uses the tab number or “index” to determine the appropriate key to the record to be processed in the 
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current input window. Once it has this data, PROCESS_INPUT loads it and calls the input 
processor. If the method determines that I_INPUT exited with the input set complete, it updates the 
record and returns to TS_PROCESS. Because the current tab set hasn’t changed, TS_PROCESS 
calls PROCESS_INPUT again with the same tab set active.

If the user selects another tab, I_INPUT exits with g_setsts and g_select true; g_entnam contains 
the name of the selected tab set. PROCESS_INPUT returns to TS_PROCESS, which calls 
PROCESS_INPUT again with the new tab active (at the front).

If I_INPUT exits because a menu entry or button was selected, again g_setsts and g_select are true, 
but this time TS_PROCESS doesn’t recognize the entry in g_entnam. It exits to the processing 
loop in the calling program.

subroutine process_input
    a_inpid         ,n
    group contkey   ,a
      key_val       ,9a77
    endgroup
.include "WND:tools.def"
.include "ids.gbl"
static record
    key             ,i4     ,1
record
    contact_dat     ,a198

proc
    key = %ts_tabset(DTS_ACTIVE, contact_tab)
    read(contact_ch, contact_dat, key_val(key), KRF=1)
    xcall i_display(a_inpid, "all", contact_dat)
    xcall i_next(a_inpid, "data", "*FRST*")
    xcall i_input(a_inpid, "data", contact_dat)
    if (.not.g_setsts)
      write(contact_ch, contact_dat)
    xreturn
endsubroutine
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Using Composite Windows to Combine Windows 
and Lists
UI Toolkit enables you to combine multiple windows and/or lists into a single window, called a 
composite window. For example, you could create a composite window that includes an input 
window, a table, an ActiveX control, and buttons. To the user, a composite window looks and 
functions as a single window. 

A composite window consists of a parent window (called the composite container window) and 
child windows or lists. A child can be any type of UI Toolkit window or list, including an ActiveX 
window, a tab set window, an ActiveX Toolkit list, or another composite window. This section 
contains the general steps for creating and using composite windows. For details on these steps, 
additional composite window tasks, and a complete example, see “Creating and Processing 
Composite Windows” in the “Composite Window Routines” chapter of the UI Toolkit Reference 
Manual.

1. Create the composite container window

Start by using the DC_CREATE subfunction for %C_CONTAINER to create the composite 
container window. The example below creates a composite container window that 

 has a Toolkit-assigned name. (Passing a null string for the name argument causes Toolkit to 
assign a unique name to the composite window.)

 fills the entire body of the application window. (Passing g_bdysiz, a global variable defined in 
tools.def, instructs Toolkit to use the number of rows in the body of the application window, 
and passing %W_INFO with WIF_SCOLS instructs Toolkit to use the number of columns in 
the application window.)

Additionally, this example returns the ID of the new composite container window in the id_contain 
variable.

id_contain = %c_container(DC_CREATE, "", g_bdysiz, %w_info(WIF_SCOLS))

2. Add child windows and/or lists

To add child windows and lists to the composite window, use the DC_ADD subfunction for 
%C_CONTAINER. In this call, you specify the ID of the container window as well as the ID of the 
window or list you want to add as a child. Additionally, you can set properties for the child, 
including placement, tabbing position, and a menu column to be loaded when the child is 
processed. For example, the following adds a list that starts on the first column of the first row of 
the composite window and loads a menu column with the ID id_selcol:

xcall c_container(DC_ADD, id_contain, DC_LIST, id_list, 1, 
1,,,,id_selcol)
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3. Place the composite window

To place a composite window, place its container window. Note, however, that when a container 
window is placed, only child windows and lists that have been placed are displayed in the window. 
Unplaced child windows and lists remain invisible. Additionally, when you place a child, it remains 
invisible until its container window is placed. For example, the following call places the composite 
window whose container window has the window ID id_contain. If a window or list was placed, 
the window or list will be visible in the composite window.

xcall u_window(D_PLACE, id_contain, 1, 1)

Note that there are a couple of ways to place child windows and lists. One is to pass the row and col 
arguments in the DC_ADD call for the child, as in the DC_ADD example above. This instructs 
Toolkit to automatically place the child. The other is to use the D_PLACE operation for 
U_WINDOW or to use L_PLACE after the window or list has been added to the container window.

4. Process the composite window

To process a composite window, call C_PROCESS. This routine calls the method for the active 
child. Toolkit includes default composite window processing methods, but you can create your own 
methods and specify one in the DC_ADD call for a child. The following is an example processing 
loop that tests for menu entries and calls C_PROCESS, which passes the variables chan_icontacts, 
chan_contacts, list_contact, and inp_contact to the method for the active child. 

;
; do_process - run input loop for composite window
do_process,
    xcall c_process(id_contain, chan_icontacts, chan_contacts, 
  &                 list_contact, inp_contact)
    if (g_select)
      begin
        using g_entnam select
("O_ADD "),     call add
("O_DEL "),     call delete
("O_SEL "),     call select
("O_EXIT "),    call update    ;leaves g_select == TRUE
        endusing
      end
    return
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5. Remove and delete windows   

To remove a composite window, remove the composite container window with the D_REMOVE 
operation for U_WINDOW. Use D_REMOVE to remove child windows as well. For a child list, 
use L_REMOVE. Note the following: 

 Removing a composite window doesn’t remove its child windows and lists; it makes them 
invisible.

 Removing a child with D_REMOVE or L_REMOVE removes the child from the display but 
doesn’t disassociate it from the composite window. To remove a child from the display and 
disassociate it from the container, use the DC_REMOVE subfunction for %C_CONTAINER. 
To delete a composite window, delete its container window. To delete a child, leave the 
environment it’s logged in, or use the D_DELETE operation for U_WINDOW. Note that 
deleting a composite container window removes all child windows and lists but does not delete 
them.
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Using Methods
A method is a program that you write and UI Toolkit calls. You generally do not call a method 
directly. Instead, you give Toolkit the name of the method and let it make the call. Methods are used 
for a number of things: by the list processor to load an item and do item entry and exit processing; 
by the input processor to do field display and change processing; and by U_START to do special 
initialization processing—just to name a few.

Using input methods
Input field methods are very powerful tools that enable you to set up a field prior to input or to 
validate input before continuing to the next field. While break processing will accomplish many of 
the things input methods are designed to handle, an application running on Windows cannot assume 
that fields will be processed sequentially. Your user could be on field A and click on field C, 
completely bypassing field B. If field C depends on a break activated by field B, your perfectly 
functional UNIX application doesn’t work on Windows. But an input method is specific to the field 
that activates it and is totally independent of any other field.

Input methods are useful in a non-Windows environment as well. While break processing is 
handled within the program that calls I_INPUT, your input methods are a function of the field that 
activates them, handled externally to the routine that called I_INPUT. In the method, you can 
determine the window and field that activated it and process accordingly. This means you can write 
a single method for a given field, to be called wherever that field is used. You can even write a 
single method to perform all of your file look-ups, attach the method to any field on which you 
need to do a look-up, and in the method itself, determine the data and file for the look-up.

.field cmpny, a45, prompt("Company "), pos(2, 8), fpos(2, 16), -
 change_method("lookup_lmeth")

Input methods are specified as .FIELD options in a script or are registered with IB_FIELD. The 
sample script definition above defines a change method for the company name field. When the user 
completes input to this field, the input processor calls the subroutine LOOKUP_LMETH, a generic 
function we have created to validate input data. When LOOKUP_LMETH returns to I_INPUT, 
input processing resumes without returning to your input program.

In the example below, the call to I_INPUT passes arguments that are passed on to the change 
method. Customer_ch tells the change method where to perform the look-up; cmpny is passed so 
the change method can disable this field if the find succeeds. The change method returns success if 
the find succeeds or an error if the find fails.

xcall i_input(customer_inp,, customer,,,,,,, customer_ch, "cmpny")

When an asynchronous input method is called, g_fldnam hasn’t been loaded with the name of the 
current field (the field that activated the method). Instead, an argument passed to your method 
contains information (and pointers to information) about the current field. (See Appendix D in the 
UI Toolkit Reference Manual for a description of asynchronous methods.)
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The following code demonstrates the method for receiving the arguments passed to your change 
method. A_inprec is the data area passed to I_INPUT. WND:inpinf.def contains a group layout 
that matches the data passed as an argument to your method. We use %I_GETSTRING to get the 
name of the set the data will be displayed in.

function lookup_lmeth, ^val
    a_data_entered  ,n ;Data entered by user
    a_data_stored  ,n ;Data in storage format
    a_pending_status ,n ;Result of Toolkit field validation
.include 'WND:inpinf.def' ;Structure for input information
    a_inprec  ,a ;Input record
    a_chn1  ,n ;Method data parameter from i_input call
    a_disfield  ,a ;Method data parameter from i_input call

.include "WND:tools.def"

proc
    if (a_pending_status .ne. D_OK)
      freturn(a_pending_status)
    fld_name = %i_getstring(inp_wndid, inp_fldnam)
    find(a_chnl, a_inprec, a_data_entered) [$ERR_KEYNOT=notfound,
  &                                          $ERR_EOF=notfound]
    reads(a_chnl, a_inprec)
    xcall i_display(inp_wndid, %i_getstring(inp_wndid, inp_setnam),
  &                 a_inprec)
    if ^passed(a_disfld)
      xcall i_disable(inp_wndid, a_disfld)   ;Can’t modify the key field
    freturn(D_OK)

notfound,
    xcall u_msgbox('Entry not found')
    freturn(D_EMITTEDERR)
endfunction

The contents of WND:inpinf.def are displayed below. 

group inputinfo ,a
  inp_wndid     ,i4 ;Input window ID
  inp_setnum    ,i4 ;Set number
  inp_setndx    ,i4 ;Set index (field number within set)
  inp_fldnum    ,i4 ;Field number within input window
  inp_nulinp    ,i4 ;Performing null input? (TRUE/FALSE)
  inp_fldtype   ,i4 ;Field type:

; D_ALPHA, D_DECIMAL, D_FIXED, D_TEXT,
; D_INTEGER, D_USERTYPE

  inp_empty    ,i4 ;Is the field empty?
  inp_setnam   ,i4 ;Pointer to name of current input set
  inp_fldnam   ,i4 ;Pointer to name of current input field
  inp_usertype ,i4 ;Pointer to user-defined data type
  inp_usertext ,i4 ;Pointer to user text string
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  inp_prc_atr  ,i4 ;Input processing attributes
  inp_prc_clr  ,i4 ;Input processing color
  inp_dsp_atr  ,i4 ;Field display attributes
  inp_dsp_clr  ,i4 ;Field display color
  inp_clr_atr  ,i4 ;Field clear attributes
  inp_clr_clr  ,i4 ;Field clear color
  inp_entered  ,i4 ;Data modified?
  inp_return   ,i4 ;RETURN key pressed?
  inp_navevent ,i4 ;Type of navigation occurring (see tools.def)
endgroup

For more information on Toolkit methods, including input methods, list methods, and environment 
methods, see the UI Toolkit Reference Manual.
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Developing with Synergy .NET

With Synergy .NET you can create .NET applications for Windows, Android, iOS, and Linux. (See 
“Synergy .NET Basics” on page 7-3 for details on support.) The sections listed below document the 
development processes for these platforms, including basic steps for using Synergy .NET with 
required third-party products, such as Visual Studio and Xamarin. Note, however, that these 
sections do not fully document third-party products or the development procedures required to use 
them. For information on third-party products, refer to the documentation for those products. 

Synergy .NET Basics 7-3

Introduces Synergy .NET and lists the platforms it supports. Discusses how it integrates with Visual 
Studio, where you can get help, other .NET Framework options for Synergy/DE, compiler-time 
defines for Synergy .NET, and how to set environment variables for Synergy .NET. 

Synergy .NET Requirements 7-10

Lists basic requirements for developing and deploying Synergy .NET applications, including 
information on runtime libraries and licensing.

Using Solutions, Projects, and Portable Class Libraries 7-14

Describes how Synergy projects can be configured to target multiple .NET platforms and how 
portable class libraries can be used for code that is common to more than one target platform.

Developing Windows Desktop and Server Applications 7-17

Outlines steps for developing desktop and server applications for .NET Framework on Windows. 

Developing for Universal Windows Platform 7-19

Outlines steps for developing applications for Universal Windows Platform (UWP). Includes the 
tutorial “UWP quick start (Hello World)” on page 7-21, which shows how to use the Blank App 
project template for UWP to quickly get a simple UWP application up and running on a mobile 
emulator.

Developing for Android 7-24

Outlines steps for developing applications for Android devices. Includes the tutorial “Android 
quick start (Hello World)” on page 7-28, which shows how to use the Android Application project 
template to quickly get a simple Android application up and running on an emulator.
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Developing for iOS 7-31

Outlines steps for developing applications for iOS devices. Includes the tutorial “iOS quick start 
(Hello World)” on page 7-39, which shows how to use the iOS Application project template to 
quickly get a simple iOS application up and running on a simulator.

Developing for .NET on Linux 7-42

Outlines steps for developing applications for Mono on Linux systems.

Developing Portable Class Libraries 7-44

Outlines steps for developing Synergy portable class libraries, which are class libraries that can 
target some or all platforms supported by Synergy .NET. 

Debugging Synergy .NET Code 7-46

Discusses how Synergy .NET uses the Visual Studio and Xamarin debuggers, and discusses 
debugging features and issues that are specific to Synergy .NET.

Using Data Files on Devices 7-51

Describes how to deploy and access data files on devices (UWP, Android, and iOS).

Performing Common Synergy .NET Coding Tasks 7-55

Describes how to perform common coding tasks for Synergy .NET applications.

Preparing Existing Code for Synergy .NET 7-66

Describes how to rework existing Synergy code for Synergy .NET, including how to convert 
xfServerPlus routines for native .NET access. 
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Synergy .NET Basics
.NET applications are made up of assemblies: executable assemblies (.exe) and class library 
assemblies (.dll). Synergy .NET enables you to create .NET executables and libraries for the 
following desktop/server platforms:

 Windows

 Linux 64-bit (Linux development is currently experimental and unsupported.)

It also enables you to create executables and libraries for the following device platforms:

 Universal Windows Platform (UWP) (UWP development is currently experimental and 
unsupported.)

 Android 32-bit ARM and Android 32-bit x86 (Android development requires Xamarin 
tools.)

 iOS 32-bit and 64-bit (iOS development requires Xamarin tools and Xcode.)

On Windows platforms, assemblies are interpreted and managed by the Microsoft .NET common 
language runtime (CLR). On Android, iOS, and Linux, assemblies are managed and interpreted by 
the Mono CLR.

With the exception of portable class libraries (PCLs), every Synergy .NET assembly targets only 
one platform. (For information on PCLs, which can target multiple platforms, see “Using portable 
class libraries and targeting multiple platforms” on page 7-16.)

Figure 7-1. You can develop Synergy applications for a number of .NET platforms.
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There are a number of advantages to developing with Synergy .NET. In addition to the benefits of 
managed code and the Visual Studio IDE, Synergy .NET assemblies can use .NET Framework 
classes, and they can interoperate with assemblies written in other .NET languages, such as C# or 
VB.NET. 

To develop Synergy .NET assemblies, you’ll use

 a subset of the Synergy DBL statements, routines, and so forth, that you would use for 
traditional Synergy.

 the Visual Studio IDE and standard Visual Studio development procedures to create and debug 
Synergy solutions and projects. 

 Visual Studio build features to compile and build executables and libraries.

For Android and iOS development you’ll also use Xamarin within the Visual Studio environment, 
and for iOS you’ll also use Xcode.

Synergy .NET components
Synergy .NET is not a Synergy/DE product. Rather, it is a term for the use of Synergy DBL with 
.NET. The primary Synergy/DE components used for Synergy .NET development are the Synergy 
.NET libraries and Synergy DBL Integration for Visual Studio.

Synergy .NET libraries

Even though Synergy .NET assemblies run under a common language runtime (rather than the 
Synergy Runtime), some Synergy-specific runtime functionality is required. This is supplied by 
runtime libraries, which are included in Synergy/DE and in the Synergex.SynergyDE.synrnt NuGet 
package (which is for device applications). See “Synergy runtime libraries” on page 7-11 for more 
information.

There are also libraries that enable you to use the XML API and the Repository subroutine library. 
See “XML API and Repository subroutine libraries” on page 7-9.

Synergy DBL Integration for Visual Studio

Synergy DBL Integration for Visual Studio (SDI) is a Synergy/DE product that enables you to use 
Visual Studio to develop Synergy applications and libraries. For Synergy .NET development, it 
includes the Synergy .NET compiler, which is invoked by Visual Studio build features (MSBuild), 
and it integrates with Xamarin tools for Android and iOS support. It enables you to use Visual 
Studio features, such as IntelliSense, colorization, and regions as you develop Synergy 
applications, and it hooks into and provides project wizards and designers. It also enables you to 
use the Visual Studio debugger to debug your Synergy .NET code for Windows applications, and it 
enables you to use the Xamarin debugger (which runs in Visual Studio) for Android and iOS 
development. (Debugging is not currently supported for Linux.) If a Synergy .NET assembly 
interoperates with code from other languages, you can step seamlessly from one language to 
another.
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See http://www.synergex.com/synergy_net.aspx for information on system requirements.

SDI also includes the following:

 Synergy/DE help for Visual Studio. Help topics for Synergy-specific features and issues are 
installed with Synergy DBL Integration. See “Synergy/DE help for Visual Studio” on 
page 7-6.

 Project and item templates. Templates give you a starting point for Visual Studio projects and 
items in projects. See the “Synergy/DE Project Templates” and “Synergy/DE Item Templates” 
topics in Synergy/DE WebDocs for more information.

 Synergy-specific Visual Studio settings, including project property settings, text editor 
settings, and a way to register file extensions other than the defaults (.dbl, .dbc, .def, and .rec). 
See the “Setting Options for Synergy/DE Projects” and “Synergy/DE Project Properties” 
topics in Synergy/DE WebDocs.

 Synergy-specific Watch and QuickWatch commands for debugging. See “Debugging 
Synergy .NET Code” on page 7-46.

 The C# to DBL Code Converter utility, which converts C# code snippets into Synergy .NET 
code. To open this utility, select “C# to DBL Code Converter” from the Tools menu in Visual 
Studio. 

 The C# to DBL Solution Converter utility, which converts C# solutions to Synergy DBL 
solutions. To open this utility, select “C# to DBL Solution Converter” from the Tools menu in 
Visual Studio.

 Synergy-specific code snippets, available in the Visual Studio Code Snippets Manager.

 The Build > Stop Build on First Error menu entry, which stops the build of a solution as 
soon as it encounters errors in a Synergy project.

 The Tools > Command Prompt (x86)/(x64)  menu entries, which open the standard Visual 
Studio command prompt. This prompt automatically sets environment variables for .NET 
Framework tools. See Microsoft documentation for information.

 The Tools > Synergy Repository menu entry, which launches Synergy/DE Repository.

 The Tools > Synergy Background Log File menu entry, which displays logging for use by 
Synergy/DE Developer Support.

 The Tools > Synergy Online Manuals menu entry, which launches PDF versions of the 
Synergy documentation.

 Initial support for traditional Synergy. See the “Traditional Synergy Development in Visual 
Studio” topic in Synergy/DE WebDocs for information.
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For more information…
For more information on developing with Synergy .NET, see the following:

 Synergy help topics for Synergy-specific features. See “Synergy/DE help for Visual Studio” 
below, and note that many of these topics are available in the “Visual Studio Integration” 
section of Synergy/DE WebDocs.

 REL_SDI.TXT, the release notes for Synergy DBL Integration for Visual Studio.

 The Synergy .NET requirements web page: http://www.synergex.com/synergy_net.aspx.

 The “.NET Development” chapter in the Professional Series Portability Guide for information 
on differences between traditional Synergy and Synergy .NET, as well as a list of unsupported 
features.

 The Synergy DBL Language Reference Manual and the Environment Variables & System 
Options manual for information on Synergy DBL features (routines, data types, environment 
variables, and so forth).

For help with Visual Studio, see Microsoft documentation, including Visual Studio help and 
Microsoft Developer Network (MSDN). For help with Xamarin, see Xamarin documentation. 

Synergy/DE help for Visual Studio

Some help topics for Synergy-specific features are installed with Synergy DBL Integration. These 
topics are integrated with local Visual Studio help topics, so they are available in the Microsoft 
Help Viewer when viewing local help. 

To access local help, select the following Visual Studio menu entry: Help > Set Help Preference > 
Launch in Help Viewer.

Synergy-specific topics are listed under the “Synergy/DE” node on the Contents tab of the 
Microsoft Help Viewer, but you can also access them from the index and search features in the Help 
Viewer and by

 pressing F1 in some project properties pages for Synergy/DE projects.

 pressing F1 in some options dialogs for Synergy DBL text editor options.

 pressing F1 or selecting View Help from the Help menu in the C# to DBL Code converter or in 
the C# to DBL Solution Converter.

 highlighting an error in the Visual Studio Error List and pressing F1.

 selecting Show Error Help from the context menu that displays when you right-click an error 
message in the Visual Studio Error List.
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Other options for .NET
Synergy .NET is the primary solution for Microsoft .NET Framework on Windows, and it makes 
UWP and Mono development possible. But there are other Synergy/DE options for .NET 
development for desktop and server applications on Windows:

 The Gennet40 utility and the Synergy .NET assembly API enable existing Synergy code to 
take advantage of .NET features on Windows while still using the traditional Synergy compiler 
and runtime on Windows. See “The Gennet40 Utility” in the “General Utilities” chapter of 
Synergy Tools and the “Synergy .NET Assembly API” chapter of the Synergy DBL Language 
Reference Manual for information. 

 UI Toolkit .NET routines enable you to embed .NET forms, .NET controls, and Windows 
Presentation Foundation (WPF) elements in Toolkit applications using the traditional Synergy 
compiler and runtime on Windows. See the “.NET Routines” chapter in the UI Toolkit 
Reference Manual.

 xfNetLink .NET Edition enables a .NET client to call Synergy routines residing on a remote 
server machine. Using the component generation tools, Visual Studio, and the .NET 
Framework, you can create an assembly that references Synergy routines. xfNetLink .NET is 
supported on Windows platforms only; however, you can create an assembly from Synergy 
routines that reside on UNIX or OpenVMS. See “Part IV: xfNetLink .NET Edition” in the 
xfNetLink & xfServerPlus User’s Guide. 

 The .NET Framework Data Provider for ODBC (which is included with the .NET 
Framework) enables you to access Synergy data from .NET applications on Windows. See 
“Accessing Synergy Data in a .NET Environment” in the “Accessing a Database” chapter of 
the xfODBC User’s Guide.

Compile-time defines
The following compile-time defines enable you to conditionally compile code for .NET:

 _DEBUG—Debug mode only. The compiler ignores code marked with this define unless the 
project is compiled in debug mode.

 DBLNET—Synergy .NET development only. The traditional Synergy compiler ignores code 
marked with this define. 

 D_MONO—Mono development only. The traditional Synergy compiler ignores code marked 
with this define. The Synergy .NET compiler also ignores this code unless the project is for 
Mono (i.e., Android, iOS, or Linux). 

 D_PORTABLE—Portable class library development only. The traditional Synergy compiler  
ignores code marked with this define. The Synergy .NET compiler also ignores this code 
unless the project is for a portable class library. 

For more information, see “Built-in compiler definitions” in the “Building and Running Synergy 
Applications” chapter in Synergy Tools. 
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Environment variables
Environment variables can be used for

 Synergy .NET development (e.g., for build-time settings)

 runtime settings for Synergy .NET desktop/server applications on Windows

Environment variable settings are not used at runtime for applications on device platforms (UWP, 
Android, and iOS),  except when set with the SETLOG routine or translated with the GETLOG 
routine. With any type of Synergy .NET application (including device and Linux applications), 
SETLOG and GETLOG can be used for internal program communication and for opening files.

The location of an environment variable setting determines when it will be used (for development 
tools, at build time, or runtime). For Synergy.NET, you can set environment variables 

 in synergy.ini or synuser.ini (Windows only). Environment variables set in these files are 
available to Synergy/DE development tools on Windows and are available at runtime for 
Windows desktop/server executables (but not UWP). If an environment variable is shared by 
multiple executables, we recommend setting it in one shared synergy.ini file and then setting 
the SFWINIPATH environment variable in the application configuration (App.Config) files to 
point to the synergy.ini file.

 on the Runtime Settings page of Project Designer and in the application configuration file,  
App.Config (which is renamed to ApplicationName.exe.config when the project is built). 
Environment variables set in application configuration files are available for Windows 
desktop/server applications (but not UWP) and override settings in synergy.ini and 
synuser.ini. You can edit App.Config files directly, or you can use the Runtime Settings page 
of Project Designer. Environment variable settings on the Runtime Settings page are written to 
the application configuration file. See the “Runtime Settings Page” topic in Synergy/DE 
WebDocs for more information. 

 on the Environment Variables page of Project Designer. Settings on this page are used when 
the project is built and when a Windows desktop/server (not UWP) application is run from 
Visual Studio. Environment variable settings on this page are written to the MSBuild project 
file (ProjectName.synproj), and they overwrite settings in synergy.ini and synuser.ini. 

Note that although settings on the Environment Variables page are specific to the project, if 
you build a solution that has multiple projects, these settings will remain in effect for 
subsequently-built projects in the solution. So if one of these settings overrides a global setting 
in synergy.ini or synuser.ini, be sure to set that environment variable individually in each 
project in the solution to make sure the setting is correct for all projects.
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XML API and Repository subroutine libraries
Synergy/DE includes libraries for the XML API and the Repository subroutine library (the DD_ 
routines). These are not supported for device platforms.

 To use the XML API, add a reference to Synergex.SynergyDE.synxml.dll. 

 To use the Repository subroutine library, add a reference to Synergex.SynergyDE.ddlib.dll.
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Synergy .NET Requirements
This section lists basic requirements for developing and deploying Synergy .NET assemblies. For 
details on versions and editions, as well as requirements for Synergy DBL Integration for Visual 
Studio, see http://www.synergex.com/synergy_net.aspx. 

Development system requirements
To develop with Synergy .NET, you’ll need a Windows development machine with the following:

 Visual Studio

 Synergy/DE

 Synergy DBL Integration for Visual Studio

This is basically all that is required for Windows development. For Android, iOS, or Linux 
development you will need a Windows development machine with the requirements listed above, 
and you will need the following:

 For Android development, the Windows machine must also have Xamarin tools. See 
http://www.synergex.com/synergy_net.aspx#android_notes for details 

 For iOS development, the Windows machine must have  Xamarin tools, and you must have a 
Mac development machine with Xamarin tools and  Xcode. See 
http://www.synergex.com/synergy_net.aspx#ios_notes for details. 

 For Linux development, you will also need a Linux system for testing. See 
http://www.synergex.com/synergy_net.aspx#linux_notes for details.

Application requirements
A Visual Studio solution that includes one or more Synergy assemblies must have a reference to 
Synergy runtime libraries and must use Synergy licensing. These requirements are discussed in this 
section (“Synergy runtime libraries” below and “Licensing” on page 7-12). For platform-specific 
application requirements, see 

 “Developing Windows Desktop and Server Applications” on page 7-17

 “Developing for Universal Windows Platform” on page 7-19

 “Developing for Android” on page 7-24

 “Developing for iOS” on page 7-31

 “Developing for .NET on Linux” on page 7-42

 “Developing Portable Class Libraries” on page 7-44
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Synergy runtime libraries 
Every Visual Studio solution that has a Synergy project must have a reference to Synergy runtime 
libraries. This reference must be in a project that is not for a portable class library. 

Runtime libraries for desktop and server applications

For desktop and server applications (Windows and Linux), this reference must be to synrnt. Most 
Synergy project templates for desktop and server applications automatically add this reference. The 
exception is Synergy portable class library projects. These do not include this reference, so if all 
Synergy projects in a solution are for portable class libraries, you must manually add this reference 
to a non-Synergy project. 

Synergy runtime libraries are included in the Synergy/DE Professional Series distributions for 
Windows and Linux. But on Linux systems, you must manually add the synrnt runtime library 
(located in dbl/bin) to the global assembly cache or make sure it is in the same folder as your 
application binaries. To add synrnt to the global assembly cache, use the following command:

sudo GACUTIL -i synrnt.dll

Runtime libraries for devices

For a device application (UWP, Android, or iOS), at least one Visual Studio project for the 
application must have a reference to the Synergex.SynergyDE.synrnt NuGet package. This 
contains the runtime libraries for devices. It is installed to a local NuGet repository when Synergy 
DBL Integration is installed, and it is available on the NuGet site: 
www.nuget.org/packages/Synergex.SynergyDE.synrnt. Note the following:

 The version installed with Synergy DBL Integration is used only for new projects created from 
Synergy templates for Android and iOS. These project templates automatically add a reference 
for this. 

 The version available from the NuGet site is used in two cases: if you manually add a reference 
to a project or if you instruct Visual Studio to update the version for a project. You can install 
this by running the following command in the Visual Studio NuGet Package Manager console:

Install-Package Synergex.SynergyDE.synrnt -Pre

When you create a project from a Synergy UWP, Android, or iOS template, a reference is 
automatically added to the project. When this reference is added, the version of the NuGet package 
installed with Synergy DBL Integration is copied to a repository for the project. From that point on, 
the package installed with Synergy DBL Integration is completely separate from the package for 
the project. Note the following:

 Updating Synergy DBL Integration will not update the package for the project. Instead, Visual 
Studio checks the NuGet site for updates, and when the package on the NuGet site is updated, 
you can use the NuGet Package Manager to update the package for the project.

 If a Visual Studio solution for a device platform has a Synergy project, but not a Synergy UWP,  
Android, or iOS project, you must manually add a reference to the NuGet package, and this 
reference must be added to a project that is not for a portable class library. For example, if a C# 
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application has a Synergy portable class library, you must manually add this reference to some 
other project (e.g., the project for the executable). Use the Visual Studio NuGet Package 
Manager to install the package; then add the reference. When the package on the NuGet site is 
updated, you can then use NuGet Package Manager features to update the package for the 
project.

Licensing
Synergy .NET assemblies (executables and class libraries) require either traditional Synergy 
licensing or Synergy device licensing. 

 Device licensing is required for UWP, Android, and iOS development. (Though the values for 
public key and GUID values are not validated when running on an emulator/simulator.)

 For Windows desktop and server development, you can generally use either traditional 
Synergy licensing or device licensing. However, device licensing is required if all Synergy 
DBL code for an application is in portable class libraries.

Note that if your application uses traditional Synergy licensing and the target machine has not 
been configured for local Synergy licensing, you must specify a license server name in the 
App.config file. See the “Runtime Settings Page” topic in Synergy/DE WebDocs for 
information.

 Traditional Synergy licensing is required for Linux development.  

To use device licensing, your application must have a device licensing implementation. Projects 
created from the following Synergy project templates include basic device licensing 
implementations, but you may need to modify these or create your own implementations to meet 
your licensing requirements:

 Blank App (Universal Windows)—To use the basic device licensing implementation, add 
public key and GUID values to the SynergyDeviceLicense code in the LicenseClass.dbl file. 
See “UWP quick start (Hello World)” on page 7-21.

 Android Application—To use the basic device licensing implementation, add public key and 
GUID values to the SynergyDeviceLicense code in the Activity1.dbl file. See “Android quick 
start (Hello World)” on page 7-28.

 iOS Application—To use the basic device licensing implementation, add public key and GUID 
values to the SynergyDeviceLicense code in the Main.dbl file. See “iOS quick start (Hello 
World)” on page 7-39.

In the project that includes the device licensing attribute (SynergyDeviceLicenseAttribute), select 
the “Enable Device Licensing” option on the Compile page of Project Designer. (See the “Compile 
Page” topic in Synergy/DE WebDocs for information.) Do not use this option for any other project 
in a solution.

For more information on licensing, see the “Configuring License Manager” chapter of the 
Installation Configuration Guide and “Device licensing (.NET)” in the “Welcome to Synergy 
DBL” chapter of the Synergy DBL Language Reference Manual. 
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Deployment requirements
To deploy a Windows desktop or server application (not UWP), the target Windows system must 
have .NET Framework and Synergy/DE Professional series, which includes the Synergy .NET 
runtime libraries. (With ClickOnce deployment, it is possible to deploy to Windows machines that 
do not have Synergy/DE, but this is not supported. See the “ClickOnce Deployment for Synergy 
.NET” topic in Synergy/DE WebDocs for more information.)

To deploy a UWP application, the target system must have a Windows 10 operating system (e.g., 
Windows 10 Mobile).

To deploy to an Android, iOS, or Linux application, the target system must have Mono. For 
Android, Xamarin includes a full or partial (linked) installation of Mono in deployment packages.  
Xamarin also includes Mono in iOS deployments. (See Xamarin documentation for information.) 
However, for Linux

 Mono must be installed separately

 the Linux system must have Synergy/DE Professional Series,

 you must manually add the synrnt runtime library to the global assembly cache (See “Synergy 
runtime libraries” on page 7-11 for information.) 
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Using Solutions, Projects, and Portable Class Libraries
.NET applications are made up of assemblies. An assembly can be an executable (.exe) or a class 
library (.dll), which is a collection of subroutines, functions, and/or classes that are invoked from 
other class libraries and executables. 

To develop Synergy .NET assemblies, you’ll use Visual Studio to create solutions and projects, and 
you’ll use Visual Studio build features (which automatically invoke the Synergy .NET compiler) to 
build assemblies from these projects. 

For each of the assemblies that will constitute your application, you’ll need to create a Visual 
Studio project from one of the Synergy/DE project templates. You’ll then add Synergy DBL code, 
references to other assemblies as necessary, and other items to your project. For details, see the 
following:

 “Developing Windows Desktop and Server Applications” on page 7-17

 “Developing for Universal Windows Platform” on page 7-19

 “Developing for Android” on page 7-24

 “Developing for iOS” on page 7-31

 “Developing for .NET on Linux” on page 7-42

 “Developing Portable Class Libraries” on page 7-44

Figure 7-2. Synergy .NET assemblies are built from Visual Studio projects.
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One of the advantages to using .NET is that Synergy assemblies can use .NET Framework classes 
and can interoperate with assemblies written in other .NET languages (e.g., C#; see figure 7-3 
below). So in addition to invoking .NET Framework functionality in your code, you can include 
Synergy projects in solutions for other .NET languages, and you can include projects for other 
.NET languages in Synergy solutions.

For more information, see the following:

 “Calling a routine in a Synergy assembly from another assembly” on page 7-60.

 “Performing Common Synergy .NET Coding Tasks” on page 7-55, which includes 
information on instantiating and using a .NET class, inheriting and overriding a .NET class, 
and so forth.

Figure 7-3. Synergy projects can be part of non-Synergy solutions and vice versa.
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Using portable class libraries and targeting multiple platforms
With Synergy .NET, you can target multiple platforms by including projects for each type of 
platform in your Synergy solution. It’s best to include common code in a portable class library and 
then put platform-specific code in platform-specific class libraries and executables. In figure 7-4 
below, projects for three target platforms are included in a single Synergy solution (with a portable 
class library project for common code):   

For information on creating portable class libraries, see “Developing Portable Class Libraries” on 
page 7-44.

Figure 7-4. Projects for all targeted platforms in one solution.
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Developing Windows Desktop and Server Applications
The following are the basic Synergy .NET development steps for Windows desktop and server 
applications. Most of these steps outline Visual Studio procedures, so see Visual Studio 
documentation for full information.

This section does not discuss Universal Windows Platform (UWP) development. For information 
on UWP, see “Developing for Universal Windows Platform” on page 7-19. 

1. Start by reviewing “Synergy .NET Requirements” on page 7-10. Your development machine and 
the Visual Studio projects you develop must meet the requirements listed in that section.

2. In Visual Studio, create a project for each assembly in your application. For example, to create a 
console application (an application that runs from the command line), select File > New Project, 
select Synergy/DE from the Installed Templates area of the New Project Dialog, and then select 
Console Application from the list of project types. You’ll then need to set a few options for the 
project (name, location, and so forth) in the New Project Dialog. Note the following:

 All Synergy project templates are available for Windows desktop and server development for 
Synergy .NET except Android, iOS, UWP, and traditional Synergy templates. See the 
“Synergy/DE Project Templates” topic in Synergy/DE WebDocs for information on templates.

 You can include Synergy projects in a solution for another .NET language (e.g., in a C# 
solution), and you can include projects for other .NET languages in a Synergy solution. See 
“Using Solutions, Projects, and Portable Class Libraries” on page 7-14.

 For portability, put as much logic as possible in portable class libraries. A portable class library 
can target the .NET Framework on Windows (including UWP), as well as Mono on iOS, 
Android, and Linux. See “Developing Portable Class Libraries” on page 7-44.

3. Add DBL code, references to needed assemblies, and other items to your project.

 For information on item templates, see the “Synergy/DE Item Templates” topic in Synergy/DE 
WebDocs. 

 For information on which Synergy features are supported see the “.NET Development” chapter 
in the Professional Series Portability Guide. And note that for Interop projects Synergy global 
structures used as attribute arguments  must be defined in an assembly outside of a namespace.

 Synergy projects for desktop and server applications include a reference to synrnt. This is 
required.

 To use device licensing, an assembly in your application must implement device licensing, and 
that assembly must be built with the “Enable device licensing” option on the Compile page of 
Project Designer. 

 To use the Repository subroutine library, add a reference to Synergex.SynergyDE.ddlib.dll. 
To use the XML API, you must add a reference to Synergex.SynergyDE.synxml.dll.
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 You are not limited to the standard file extensions for Synergy DBL files (e.g., .dbl for code 
files). You can add files with other extensions if you specify those extensions in the Visual 
Studio IntelliSense dialog box for the Synergy DBL text editor. See the “IntelliSense, Text 
Editor Options” topic in Synergy/DE WebDocs.

 To generate documentation from comments in code, use ;;; to identify documentation 
comments in your code, and select the “XML documentation file” option on the Build page of 
Project Designer. 

4. Set project properties, which include settings for licensing, deployment, and building/compiling. 
See the “Setting Synergy/DE Project Properties” topic in Synergy/DE WebDocs. For information 
on setting environment variables for a project, see “Environment variables” on page 7-8.

5. Build and debug the project in Visual Studio. See Visual Studio documentation for information on 
build features and the debugger, and see “Debugging Synergy .NET Code” on page 7-46.

6. Deploy your application. See Microsoft documentation (and for information on ClickOnce 
deployment see the “ClickOnce Deployment for Synergy .NET” topic in Synergy/DE WebDocs).
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Developing for Universal Windows Platform
The following steps outline the basic procedure for creating a Universal Windows Platform (UWP) 
application from Synergy templates. Most of these steps outline Visual Studio procedures, so see 
Visual Studio documentation for full information.

Note that Synergy .NET development for UWP is experimental and unsupported.

Developing for UWP is similar to developing Windows desktop and server applications (see 
“Developing Windows Desktop and Server Applications” on page 7-17), but there are different 
restrictions, special defines, templates, and so forth. Many of these are discussed below, but see  in 
the “.NET Development” chapter in the Professional Series Portability Guide for more 
information.

Additionally, any UWP solution with a Synergy project must implement Synergy device licensing. 
See “Licensing” on page 7-12. 

1. Start by reviewing “Synergy .NET Requirements” on page 7-10. Your Windows development 
machine and the Visual Studio projects you develop must meet requirements listed in that section. 

2. In Visual Studio, create a project for each assembly in the UWP application. The following Synergy 
templates can be used for UWP projects:

 Blank App (Universal Windows) 

 Class Library (Universal Windows) 

 Portable Class Library

For example, to create an executable assembly, select File > New Project, select Synergy/DE > 
Universal from the Installed Templates area of the New Project dialog, and then select “Blank App 
(Universal Windows)” from the list of project types. You’ll then need to set a few options for the 
project (name, location, and so forth) in the New Project dialog. Note the following:

 You can include Synergy projects in a solution for another .NET language (e.g., in a C# 
solution), and you can include projects for other .NET languages in a Synergy solution. See 
“Using Solutions, Projects, and Portable Class Libraries” on page 7-14.

 For portability, put as much logic as possible in portable class libraries. A portable class library 
can target the .NET Framework on Windows (including UWP), as well as Mono on iOS, 
Android, and Linux. See “Developing Portable Class Libraries” on page 7-44.

TIP
You can use the “Synergy Blank App (Universal Windows)” project template to quickly get a 
simple application up and running on a mobile emulator in Visual Studio. See “UWP quick 
start (Hello World)” on page 7-21
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3. Add DBL code, resource, controls, etc., to the Visual Studio projects, and make sure each project 
references needed assemblies. (For information on item templates, see the “Synergy/DE Item 
Templates” topic in Synergy/DE WebDocs.) Note the following:

 The project for the executable must have a reference to the Synergex.SynergyDE.synrnt 
NuGet package (see “Synergy runtime libraries” on page 7-11). 

 An assembly in your application must implement device licensing. See “Licensing” on 
page 7-12.

 For information on which Synergy features are supported see the “.NET Development” chapter 
in the Professional Series Portability Guide. And note that for Interop projects Synergy global 
structures used as attribute arguments  must be defined in an assembly outside of a namespace.

 Use the MVVM pattern to reduce platform-specific code.

 Use ASYNC routines for communication across networks and the Internet. See “Asynchronous 
processing” in the “Synergy DBL Statements” chapter of the Synergy DBL Language 
Reference Manual for more information.

 For information on accessing data files, see “Using data files for Universal Windows Platform” 
on page 7-51.

 You are not limited to the standard file extensions for Synergy DBL files (e.g., .dbl for code 
files). You can add files with other extensions if you specify those extensions in the Visual 
Studio IntelliSense dialog box for the Synergy DBL text editor. See the “IntelliSense, Text 
Editor Options” topic in Synergy/DE WebDocs.

 To generate documentation from comments in code, use ;;; to identify documentation 
comments in your code, and select the “XML documentation file” option on the Build page of 
Project Designer. 

4. Set project properties. (See the “Setting Synergy/DE Project Properties” topic in Synergy/DE 
WebDocs.) 

 In the project that includes the device licensing attribute (SynergyDeviceLicenseAttribute), 
make sure “Enable Device Licensing” is set on the Compile page of Project Designer. This 
option should not be set for any other project in the solution. 

 To minimize activation of device licensing during debugging and testing, go to the Debug page 
of Project Designer for the executable project and make sure the “Uninstall and then re-install 
my package...” option is not selected.

5. Build and debug the project in Visual Studio. See Visual Studio documentation for information on 
building and debugging, and see “Debugging Synergy .NET Code” on page 7-46. At build time, 
Visual Studio creates an .appxupload package, which is  what you will deploy. When you are 
ready to release the application, you will submit this package to the Windows Store. Note that these  
steps are common to all UWP applications, so see Microsoft documentation for information.
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UWP quick start (Hello World)
If your system meets the requirements for UWP development (see “Synergy .NET Requirements” 
on page 7-10) and you have a GUID and a public key from Synergex (see “Device licensing 
(.NET)” in the “Welcome to Synergy DBL” chapter of the Synergy DBL Language Reference 
Manual), you can have a simple UWP app running on a mobile emulator in Visual Studio in a 
matter of minutes.

1. Open Visual Studio and select File > New > Project. Then in the new Project Window, select 
“Blank App (Universal Windows)”  in Installed > Synergy/DE > Universal:

2. Set the options for the project (name, location, and so forth) in the New Project dialog, and then 
click OK.
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The new project opens in Visual Studio:

3. Open LicenseClass.dbl in the editor, find the assembly:SynergyDeviceLicense... line, and enter 
your public key and GUID values for device licensing. In other words, insert the public key and 
GUID values between the quotes that follow PublicKey= and AppGUID=. 

4. In the toolbar dropdown for emulation, select Local Machine:
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5. Select Build > Build Solution. The Output window should show that the build succeeded.

6. When the project has finished building, select Debug > Start Debugging.

7. Wait while Visual Studio deploys your application to the emulator, which may take a few minutes. 
When it’s finished, your application should be running on the mobile emulator, and the application 
will display a License Login screen:

Congratulations! You have just created a Synergy UWP application.  
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Developing for Android
The following steps outline the basic procedure for using Visual Studio and Xamarin tools to 
develop for Mono on Android devices. Most of these steps describe Visual Studio and Xamarin 
features and procedures (some of which change often), so see Visual Studio and Xamarin 
documentation for full information.

Synergy .NET support for Android is similar to its support for Windows desktop and server 
applications (see “Developing Windows Desktop and Server Applications” on page 7-17), but there 
are differences. Windows-specific code won’t work with Android (for example, file paths for 
Android must have forward slashes) and there are different restrictions, special defines, templates, 
and so forth. Many of these are discussed below, but see  in the “.NET Development” chapter in the 
Professional Series Portability Guide for more information.

Additionally, any Android solution with a Synergy project must implement Synergy device 
licensing, though licensing is not used when running on an emulator. See “Licensing” on 
page 7-12. 

1. Start by reviewing “Synergy .NET Requirements” on page 7-10. Your Windows development 
machine and the Visual Studio projects you develop must meet the requirements listed in this 
section. For testing and debugging, you will need to use an Android emulator within Visual Studio 
or an Android device connected to the Windows development machine. (See step 2 in “Building, 
debugging, and deploying Android applications” on page 7-27.)

2. In Visual Studio, create a project for each assembly in the Android application. The following 
Synergy templates can be used for Android projects: 

 Android Application

 Android Class Library

 Portable Class Library

TIP
You can use the Synergy Android Application project template to quickly get a simple 
application up and running on an Android emulator or device. See “Android quick start 
(Hello World)” on page 7-28.
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For example, to create an executable assembly, select File > New Project, select Synergy/DE > 
Android from the Installed Templates area of the New Project dialog, and then select Android 
Application from the list of project types. You’ll then need to set a few options for the project 
(name, location, and so forth) in the New Project Dialog. Note the following:

 You can include Synergy projects in a solution for another .NET language (e.g., in a C# 
solution), and you can include projects for other languages in a Synergy solution. See “Using 
Solutions, Projects, and Portable Class Libraries” on page 7-14.

 For portability, put as much logic as possible in portable class libraries. A portable class library 
can target the .NET Framework on Windows (including UWP), as well as Mono on iOS, 
Android, and Linux. See “Developing Portable Class Libraries” on page 7-44.

3. Add DBL code, resources, assets, controls, etc., to the Visual Studio projects, and make sure each 
project references all needed assemblies. 

 For information on item templates, see the “Synergy/DE Item Templates” topic in Synergy/DE 
WebDocs. 

 For information on which Synergy features are supported see the “.NET Development” chapter 
in the Professional Series Portability Guide. And note that for Interop projects Synergy global 
structures used as attribute arguments  must be defined in an assembly outside of a namespace.

 For user interface development, use AXML (XML user interface layout files for Android) or 
Xamarin.Forms. 

 Use the MVVM pattern to reduce platform-specific code. 

 The project for the executable must have a reference to the Synergex.SynergyDE.synrnt 
NuGet package (see “Synergy runtime libraries” on page 7-11). 

Figure 7-5. Components for Android development.
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 Use ASYNC routines for communication across networks and the Internet. See “Asynchronous 
processing” in the “Synergy DBL Statements” chapter of the Synergy DBL Language 
Reference Manual for more information.

 If your application accesses data files, you must use SETDFN to define the path to those files 
unless you explicitly specify the path in code. And if your application will access existing data 
files locally, you must add them as assets to the project. See “Using data files on Android” on 
page 7-52. 

 Make sure Xamarin types have finished initializing before using Xamarin properties and 
methods. Attempting to use a Xamarin property or method before it is initialized will cause a 
fatal error (e.g., a null reference exception). For example, ActivationDialog.dbl, a file 
included in the Synergy iOS Application template, includes code to ensure that the Xamarin 
UIApplication.SharedApplication property is initialized:

while(UIApplication.SharedApplication==^null)
await Task.Delay(100)

 To generate documentation from comments in code, use ;;; to identify documentation 
comments in your code, and select the “XML documentation file” option on the Build page of 
Project Designer. 

 The Add Service Reference dialog is not available in Synergy Android Application projects or 
Synergy Android Class Library projects. This is, however, supported for Portable Class 
Library projects, so use a Portable Class Library project for references to WCF services.

4. Set project properties. See the “Setting Synergy/DE Project Properties” topic in Synergy/DE 
WebDocs, and note the following:

 In the project for the executable, go to the Application page of Project Designer and set 
Android version options to at least API level 14. To use the Intel x86 Emulator Accelerator 
(HAXM), set them to level 15. 

 For a Synergy Android Application project, use the Android Options page in Visual Studio 
Project Designer to set the project to include all of Mono, include only needed parts of Mono 
(by using the Mono Linker), or rely on a shared Mono installation.

 In the project that includes the device licensing attribute (SynergyDeviceLicenseAttribute), 
select “Enable Device Licensing” on the Compile page of Project Designer. Do not use this 
option for any other project in the solution. 

To minimize activation of device licenses during debugging and testing, in the project for the 
executable, select the Xamarin option “Preserve application data/cache on device between 
deploys”. This option is available in Tools > Options > Xamarin > Android Settings. 
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Building, debugging, and deploying Android applications
For Android debugging, use one of the following:

 An ARM device 

 The Visual Studio Emulator for Android

 The Intel Atom (x86) emulator (may not work on virtual machines)

 The Intel HAXM Android emulator (works only with specific Intel, non-AMD, processors)

Note that the Google ARM emulator, which comes with Xamarin, is very slow to start (it generally 
takes several minutes).

Before you start, make sure debugging files are set up. See 
http://www.synergex.com/synergy_net.aspx.

1. Build the Visual Studio projects. For an Android Application, Xamarin creates an Android package 
(.apk) at build time. This package is what you deploy to devices.

2. For debugging and deployment testing, use an Android emulator or an Android device that’s 
configured for development (i.e., set to developer mode with USB debugging enabled) and 
connected to the Windows development machine. You can select the emulator (which must be API 
level 14 or higher) or the device in the Target Android Device toolbar dropdown.

For information on connecting to an Android device, see Synergex KnowledgeBase article 
100002189.

For more information on debugging, see “Debugging Synergy .NET Code” on page 7-46.

3. When testing is complete, follow Xamarin instructions for preparing an application for 
deployment: disable debugging, specify an application icon, version the application, configure the 
linker so that the shared runtime is not used, compile in Release mode, and so forth.

4. Deploy the application via a website, an email, or an Android deployment site (e.g., Google Play or 
the Amazon App store for Android), or just install it on target devices.

https://resourcecenter.synergex.com/devres/kb-details.aspx?id=1992
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Android quick start (Hello World)
If your system meets the requirements for Android development (see “Synergy .NET 
Requirements” on page 7-10), you can have a simple Synergy application running on an Android 
emulator in a matter of minutes.

1. Open Visual Studio and select File > New > Project. Then, in the New Project window, select 
Android Application (in Installed > Templates > Synergy/DE > Android):

2. Set options for the project (name, location, and so forth), and then click OK. 
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The new project will open in Visual Studio with the Activity1.dbl file open in the editor.

3. Find the assembly:SynergyDeviceLicense... line in Activity1.dbl, and enter dummy public key and 
GUID values for device licensing. In other words, add some characters between the quotes that 
follow PublicKey= and AppGUID=. In the following, for example, both are set to “abc”:

Although device licensing is not required when running on an Android emulator, the Android 
Application project template includes a full device licensing implementation, which requires 
PublicKey and AppGUID values. The application will not build without them.

4. In the Target Android Device toolbar dropdown, select MonoForAndroid_API_15.

5. Select Build > Build Solution. The Output window should show that the build succeeded. 

6. When the project has finished building, select Debug > Start Debugging. If a Launching Emulator 
window opens, click Yes.
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7. Wait while the emulator opens and installs your application. This may take a few minutes. When 
it’s finished, your application should be running on the Android emulator (though you may have to 
unlock the device):

Congratulations! You have just created a Synergy .NET Android application. On an emulator, 
clicking the About Device License button will open a window with licensing information. (On a 
device, it prompts you for a user, a password, and a description.)
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Developing for iOS 
The following steps outline the basic procedure for using Visual Studio, Xamarin tools, and Xcode 
to develop for Mono on iOS devices. Most of these steps outline Visual Studio and Xamarin 
procedures (some of which change often), so see Visual Studio and Xamarin documentation for full 
information. 

In general, Synergy/DE’s support for Mono on iOS is similar to its support for Windows desktop 
and server development (see “Developing Windows Desktop and Server Applications” on 
page 7-17), but there are differences. Windows-specific code won’t work with iOS (for example, 
file paths for iOS must have forward slashes), and there are different restrictions. Many of these are 
discussed below, but see  in the “.NET Development” chapter in the Professional Series Portability 
Guide for more information. And note that any iOS solution with a Synergy project must 
implement Synergy device licensing, though licensing is not used when running on the iOS 
Simulator. See “Licensing” on page 7-12. 

To develop a Synergy application for iOS, you must have an Apple developer account, and you 
must have Windows and Mac development machines that meet the requirements listed in “Synergy 
.NET Requirements” on page 7-10. For testing and debugging, you can use either the iOS 
Simulator or a provisioned iOS device connected to the Mac (see figure 7-6).

TIP
You can use the Synergy iOS Application project template to quickly get a simple 
application up and running on the iOS Simulator. See “iOS quick start (Hello World)” on 
page 7-39.

Figure 7-6. Components for iOS development.
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Step 1: Pairing
Before you can build an iOS project, you must pair your Windows development machine to the 
Xamarin Build Host on your Mac. Initially, this must be done manually using the following 
procedure. Subsequently, Visual Studio will automatically attempt this whenever you open the iOS 
project.

1. On the Windows development machine, select Tools > iOS > Xamarin Mac Agent from the Visual 
Studio menu. The Remote Login window for Xamarin Mac Agent opens.

2. On the Mac, click the Spotlight icon (the magnifying glass) on the menu bar for the desktop and 
search for Remote Login. The “remote login – sharing” window opens.

Figure 7-7. The Remote Login window for Xamarin Mac Agent (Windows development machine).

Figure 7-8. The “remote login – sharing” window (Mac).
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3. In the “remote login – sharing” window, double-click Sharing, which opens the Sharing window.

4. In the Sharing window, select the Remote Login option, and optionally select “Only these users” 
(under “Allow access for”) to limit users who can access your Mac remotely.

5. On the Windows development machine, click OK in the Remote Login window (see figure 7-7 on 
page 7-32), which opens the Xamarin Mac Agent window.

6. In the Xamarin Mac Agent window, select the entry for your Mac and click Connect, and then, in 
the “Connect to Mac” window, enter the user name and password for the Mac and click Login. 

The Xamarin Build Host on your Mac should now be paired with the Windows development 
machine. If you select Tools > iOS > Xamarin Mac Agent from the Visual Studio menu, the 
Xamarin Mac Agent window will display the name of the paired Mac machine (see figure 7-10 
below). 

Figure 7-9. The Sharing window (on Mac).
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Figure 7-10. Xamarin Mac Agent displaying the name of the paired Mac.
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Step 2: Coding and configuring
To create and configure a Synergy iOS project, follow these steps:

1. In Visual Studio, create a project for each assembly in the iOS application. The following Synergy 
templates can be used for iOS projects:

 iOS Application

 iOS Class Library

 Portable Class Library

For example, to create an executable assembly for an iOS application, select File > New Project, 
select Synergy/DE > iOS from the Installed Templates area of the new Project dialog, and then 
select iOS Application from the list of project types. You’ll then need to set a few options for the 
project (name, location, and so forth). Note the following:

 You can include Synergy projects in a solution for another .NET language (e.g., in a C# 
solution), and you can include projects for other languages in a Synergy solution. See “Using 
Solutions, Projects, and Portable Class Libraries” on page 7-14 for more information.

 For portability, put as much logic as possible in portable class libraries. A portable class library 
can target the .NET Framework on Windows (including UWP), as well as Mono on iOS, 
Android, and Linux. See “Developing Portable Class Libraries” on page 7-44.

2. Add DBL code, resources, assets, controls, etc., to the Visual Studio projects, and make sure each 
project references the assemblies it needs.

 For information on item templates, see the “Synergy/DE Item Templates” topic in Synergy/DE 
WebDocs.

 For information on which Synergy features are supported see  in the “.NET Development” 
chapter in the Professional Series Portability Guide. And note that for Interop projects Synergy 
global structures used as attribute arguments  must be defined in an assembly outside of a 
namespace.

 For information on adding data files, see “Using data files on iOS” on page 7-54.

 Use Interface Builder or Xamarin.Forms for interface development.

 Use the MVVM pattern to reduce platform-specific code.

 At least one project in an iOS solution must have a reference to the 
Synergy.SynergyDE.synrnt NuGet package (see “Synergy runtime libraries” on page 7-11).

 Use ASYNC routines for communication across networks and the Internet. See “Asynchronous 
processing” in the “Synergy DBL Statements” chapter of the Synergy DBL Language 
Reference Manual for more information.
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 If your application accesses data files, you must add them to the Resources folder for the 
application project, copy them to the “Documents” folder, and then use SETDFN to specify the 
path and extensions, unless you explicitly specify the path in code. See “Using data files on 
iOS” on page 7-54.

 Make sure Xamarin types have finished initializing before using Xamarin properties and 
methods. Attempting to use a Xamarin property or method before it is initialized will cause a 
fatal error (e.g., a null reference exception). For example, ActivationDialog.dbl, a file 
included in the Synergy iOS Application template, includes code to ensure that the Xamarin 
UIApplication.SharedApplication property is initialized:

while(UIApplication.SharedApplication==^null)
await Task.Delay(100)

 To generate documentation from comments in code, use ;;; to identify documentation 
comments in your code, and select the “XML documentation file” option on the Build page of 
Project Designer. 

 The Add Service Reference dialog is not available in Synergy iOS Application projects or 
Synergy iOS Class Library projects. This is, however, supported for portable class library 
projects, so use a Portable Class Library project for references to WCF services.

3. Set project properties, See the “Setting Synergy/DE Project Properties” topic in Synergy/DE 
WebDocs, and note the following:

 Set Xamarin options on iOS pages of Project Designer (e.g., the iOS Build page). See Xamarin 
documentation for information.

 In the project that includes the device licensing attribute (SynergyDeviceLicenseAttribute), 
select “Enable Device Licensing” on the Compile page of Project Designer. Do not use this 
option for any other project in the solution.



Developing with Synergy .NET
Developing for iOS

Getting Started with Synergy/DE 10.3.3 (5/16) 7-37

Step 3: Building and debugging
Before you start, make sure debugging files are set up. See 
http://www.synergex.com/synergy_net.aspx.

Synergy licensing is not required when running a Synergy iOS application on the iOS Simulator.

1. Connect the Windows machine to the Xamarin Build Host on the Mac. See “Step 1: Pairing” on 
page 7-32.

2. Build the application in Visual Studio. Note the following:

 If you are building for a physical device, build the application with the iPhone or iPad option. 
If you will use the iOS Simulator, use iPhoneSimulator or IPadSimulator. To access this 
setting, select Configuration Properties > Configuration in the property pages for the solution 
(not a project). See figure 7-11 below.

Note that iPhoneSimulator and iPadSimulator cause the solution to be built for X86, not the 
actual target environment. iOS devices have ARM-based processors, but the Simulator requires 
applications to be built for a CPU that is not ARM-based.

 If you get a “Connection to Xamarin.iOS Build Host failed” error, double-click the message in 
the Visual Studio Error List. This will open the Xamarin configuration wizard, which will 
enable you to select a Build Host. See “Step 1: Pairing” on page 7-32.

Figure 7-11. Specifying the device or simulator type.
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You should now be able to run and debug. You can debug by using the iOS Simulator running on 
the Mac, or you can use a provisioned iOS device connected to the USB port on the Mac. Note that 
it is generally better to test on a physical iOS device since this is the actual environment in which 
the application will run. 

 To debug using the iOS Simulator, make sure the simulator and Xcode are running on the Mac.

 To debug using a device, make sure the iOS device is provisioned, is turned on, and is 
connected to a USB port on the Mac. Make sure the Mac is running Xcode.

For more information on debugging, see “Debugging Synergy .NET Code” on page 7-46.

Step 4: Deploying an iOS application
The process for deployment depends on how you want to distribute the application. There are two 
methods: you can distribute the application package to users (e.g., to users in your enterprise), or 
you can make it available through the App Store.

Deploying within an enterprise
To deploy an iOS application within an enterprise, you must sign the application with a distribution 
certificate obtained from Apple’s iOS Provisioning Portal (this is tied to the Enterprise Developer 
membership) and then package the application with a provisioning profile, which must also be 
obtained from the Provisioning Portal. (The Enterprise distribution provisioning profile allows the 
application to be deployed to an unlimited number of iOS devices.) You can then distribute the 
package to users who will do the following to install it:

1. Run the iTunes app on a Mac machine associated with the device. To connect the device, select it 
on the Devices list, click the Apps tab, select the app to be installed, and then click the Apply 
button.

2. Choose “Add File to Library...” from the menu, and then choose the distribution package containing 
the application to be installed.

For more information, see the iOS Deployment Technical Reference, which is available from Apple.

Deploying through the App Store
To deploy an application through the App Store, the application must be signed with a distribution 
certificate, and a store distribution provisioning profile must be created using the Apple iOS 
Provisioning Portal (as discussed in “Deploying within an enterprise” above). This profile indicates 
that the application uses certain technologies and services and confirms that it was submitted by the 
developer. These technologies and services can include iCloud, location data, keychain 
(passwords), background processing, encryption, etc. These are set in Xcode in the project data. 
You then archive and validate the application and create an application record on iTunes Connect at 
itunesconnect.apple.com. Finally, you submit the application using Xcode. You can then check the 
approval status of the application on the iTunes Connect web site, and when it’s approved, it can be 
purchased from the App Store.

For more information, see the App Distribution Guide, which is available from Apple.
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iOS quick start (Hello World)
If you are set up for iOS development (see “Synergy .NET Requirements” on page 7-10), you can 
have a simple Synergy iOS application up and running in a matter of minutes. 

1. Pair the Windows development machine to the Xamarin Build Host on the Mac development 
machine. See “Step 1: Pairing” on page 7-32.

2. Open Visual Studio and select File > New > Project. Expand the Installed > Templates > 
Synergy/DE category in the new Project window, and select iOS, and then select the iOS 
Application template.

3. Set options for the project (name, location, and so forth), and then click OK. The new iOS 
application project will open in Visual Studio. 

4. Find the {assembly:SynergyDeviceLicense... line in Main.dbl, and enter dummy public key and 
GUID values for device licensing. In other words, add some characters between the quotes that 
follow PublicKey= and AppGUID=. In the following, for example, both are set to “abc”:

Although device licensing is not required when running on the iOS Simulator, the iOS Application 
project template includes a full device licensing implementation. This implementation requires 
PublicKey and AppGUID values. The application will not build without them.

5. Go to the property pages for the solution and set the Platform option to iPhoneSimulator.
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6. On the Visual Studio toolbar, set the “Solution Configurations” dropdown to Debug, set the 
“Solution Platforms” dropdown to iPhoneSimulator, and set the next dropdown (to the right of 
“Solution Platforms”) to an iPhone version—e.g., “iPhone 6 Plus iOS 8.1”.

7. Select Debug >Start Debugging. Starting a debug session while an iOS Simulator configuration is 
selected causes the application to be built, the iOS Simulator to start on the Mac machine, and the 
application to be deployed to the iOS Simulator. 
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8. Once the iOS Simulator is up and running, and the application has finished deploying, you should 
be greeted with a screen with the text “About Device License.”

Congratulations! You have just created a Synergy .NET iOS application. Clicking “About Device 
Licensing” will open a window with licensing information. (On a device, it prompts you for a user, 
a password, and a description.)
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Developing for .NET on Linux
The following steps outline the basic procedure for creating an application for Mono on Linux. 
Most of these steps outline Visual Studio procedures, so see Visual Studio documentation for full 
information.

Note that Synergy .NET  development for Linux is currently experimental and unsupported, and 
debugging is not available.

In general, Synergy/DE’s support for Mono on Linux is the same as its support for Windows 
desktop and server development, but there are some differences. Windows-specific code won’t 
work with Linux (for example, file paths for Linux must have forward slashes), there are different 
restrictions, and you must use traditional Synergy licensing. (Synergy device licensing is not 
supported for Linux.) See the “.NET Development” chapter in the Professional Series Portability 
Guide for more information.

1. Start by reviewing “Synergy .NET Requirements” on page 7-10. Your Windows development 
machine and the Synergy projects you create in Visual Studio must meet the requirements listed in 
this section.

2. For each assembly in your application, create a Visual Studio project from one of the following 
Synergy project templates:

Class Library
Console Application
Empty Project
Interop
Portable Class Library
WCF Service Library
Windows Forms Application
Windows Forms Control Library

For example, to create a console application, select File > New Project, select Synergy/DE from the 
Installed Templates area of the New Project dialog, and then select Console Application from the 
list of project types. You’ll then need to set a few options for the project (name, location, and so 
forth) in the New Project Dialog. Note the following:

 WPF is not supported.

 For Linux server development, use Service Stack or WCF.

 For Linux desktop client development, use GTK#, WinForms, or Xamarin.Forms.

 You can include a Synergy project in a solution for another .NET language (e.g., in a C# 
solution), and you can include projects for other languages in a Synergy solution. See “Using 
Solutions, Projects, and Portable Class Libraries” on page 7-14.
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 For portability, put as much logic as possible in portable class libraries. A portable class library 
can target some or all platforms supported by Synergy .NET. For Linux, select .NET 
Framework 4.5 (or higher) as a target, and optionally select one or both of the following:

Xamarin.Android
Xamarin.iOS

Although you can select target options that are not available for Synergy .NET portable class 
libraries, keep in mind that every target you select limits framework resources available to the 
project, so select only necessary targets.

3. Add DBL code, resources, etc., to the Visual Studio projects, and make sure each project references 
needed assemblies. For information on which Synergy features are supported see  in the “.NET 
Development” chapter in the Professional Series Portability Guide.

4. Set project properties and then build the solution. 

 Set each project to target .NET Framework 4.5 or higher.

 Make sure every Synergy project targets “Any CPU”.

See the “Setting Synergy/DE Project Properties” topic in Synergy/DE WebDocs.

5. For testing and deployment, set up a Samba share and do the following: 

 Use XCOPY, GAC, etc., to deploy executables and libraries to the Linux test system. See 
Mono documentation for details. 

 Manually add the synrnt runtime library to the global assembly cache, or make sure it is in the 
same folder as your application binaries. See “Synergy runtime libraries” on page 7-11.
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Developing Portable Class Libraries
The Synergy Portable Class Library project template enables you to create portable class libraries 
that can be added to .NET applications for multiple platforms. Note that Synergy device licensing is 
required for Android, iOS, Universal Windows Platform (UWP), and is optional for Microsoft 
.NET Framework on Windows. So if you include a Synergy portable class library (or any other 
Synergy .NET library) in an application (even a non-Synergy application) for one of these 
platforms, you’ll need to implement Synergy device licensing.

To add a portable class library to an application, follow these steps. And note that these steps 
outline Visual Studio procedures, so see Visual Studio documentation for full information.

1. In Visual Studio, open the solution for the application and select File > New > Project. 

2. In the New Project window, select Installed > Templates > Synergy/DE > Portable Class Library. 
Then, in the Solution field, select “Add to solution”. Set options in this window as necessary (e.g., 
set the .NET Framework version and select “Add to solution” in the Solution field), and then click 
OK. The Add Portable Class Library window opens.

3. In the Add Portable Class Library window, select the target platforms. The following are supported 
for Synergy .NET:

 .NET Framework x.x—This must be selected. For Windows and Linux desktop and server 
development, this is the only option on this window you need to select. For device licensing, 
you must select .NET Framework 4.5 or higher.

 Windows Phone 8.1—Select this for UWP.

 Xamarin.Android—Select this for Android.

 Xamarin.iOS—Select this for iOS.

Note that this window includes some target options that are not available for Synergy .NET 
development. Every target you select limits framework resources available to the project, so select 
only necessary targets. 

4. Add DBL code, resources, etc., to the portable class library project, and make sure it references 
needed assemblies. 

 For information on item templates see the “Synergy/DE Item Templates” topic in Synergy/DE 
WebDocs.

 For information on which Synergy features are supported see the “.NET Development” chapter 
in the Professional Series Portability Guide. And note that for Interop projects Synergy global 
structures used as attribute arguments  must be defined in an assembly outside of a namespace.

 Use ASYNC routines for communication across networks and the Internet. See “Asynchronous 
processing” in the “Synergy DBL Statements” chapter of the Synergy DBL Language 
Reference Manual for more information.
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 To use the Repository subroutine library, add a reference to Synergex.SynergyDE.ddlib.dll, 
and to use the XML API, add a reference to Synergex.SynergyDE.synxml.dll. Note that these 
are not supported for devices.  

 For information on deploying and accessing data files on device platforms, see “Using Data 
Files on Devices” on page 7-51.

 To generate documentation from comments in code, use ;;; to identify documentation 
comments in your code, and select the “XML documentation file” option on the Build page of 
Project Designer. 

5. Set project properties (see the “Setting Synergy Project Properties” topic in Synergy/DE 
WebDocs).

 In the project for the executable for an Android application, set Android versions options to at 
least API level 14 on the Application page of Project Designer. To use the Intel x86 Emulator 
Accelerator (HAXM), set them to level 15.

 If the application uses device licensing, in the project that includes the device licensing 
attribute (SynergyDeviceLicenseAttribute), select “Enable Device Licensing” on the Compile 
page of Project Designer. Do not use this option for any other project in the solution.

6. In the project for the executable assembly, add a reference to the Synergy runtime libraries. See 
“Synergy runtime libraries” on page 7-11.

7. You can now call routines in the Synergy portable class library from the non-Synergy code in the 
solution. See “Calling a routine in a Synergy assembly from another assembly” on page 7-60.

To minimize activation of device licenses during debugging and testing for UWP, or Android, 
do the following in the project for the executable:

 For  UWP, make sure the “Uninstall and then re-install my package...” option on the 
Debug page is not selected.

 For Android, select the Xamarin option “Preserve application data/cache on device 
between deploys”. This option is available in Tools > Options > Xamarin > 
Android Settings.

(iOS automatically preserves application data between deploys, so there is no option to 
select for this.) 



Developing with Synergy .NET
Debugging Synergy .NET Code

7-46 Getting Started with Synergy/DE 10.3.3 (5/16)

Debugging Synergy .NET Code
The Visual Studio .NET debugger is used for debugging applications for .NET Framework on 
Windows (including Universal Windows Platform), and the Xamarin debugger in Visual Studio is 
used for debugging applications for Android and iOS. (Debugging for Linux is not currently 
supported.) See Visual Studio and Xamarin documentation for assistance with these debuggers, and 
note the following:

 Local fields are not initialized until you step past the PROC statement.

 If the debugger is running slowly, it may be that too many variables are displayed in the Locals 
window (rather than being hidden in collapsed nodes of the Locals window). The debugger 
continually evaluates displayed variables, but doesn’t evaluate variables in collapsed nodes. 
For example, if the Globals node is expanded, the debugger may need to evaluate scores of 
variables, especially if there are a large number of unnamed common variables. (These are 
displayed directly under the Globals node rather than in subnodes, which could be collapsed.) 
To prevent this, keep Locals window nodes collapsed, and instead use the Watch or 
QuickWatch window or hover over a variable to get information about it. 

 When an assembly is built, the compiler creates a program database file, which is a .pdb file 
for .NET Framework development on Windows, or a .mdb file for Mono development. These 
files store debugging and project state information. If you want to obtain traceback information 
for a distributed assembly, you must distribute the program database file for the assembly. Only 
module traceback information is provided unless the assembly is compiled with the “Debug” 
or “Debug (full)” option set for “Debug/Optimize code” on the Build page of Project Designer.

 The _DEBUG system define enables you to include code based on whether a program is 
compiled in debug mode. See “Compile-time defines” on page 7-7 for more information.

 Synergy types have different names in the Visual Studio 2015 Memory Usage Tool. See 
“Synergy types in the Visual Studio Memory Usage Tool” on page 7-48.

 Remote debugging is supported for Visual Studio 2015. This means you can run and debug a 
Synergy .NET program on a remote Windows desktop system or server. To use remote 
debugging, your Windows development system must have Visual Studio 2015, and the remote 
system must have Remote Tools for Visual Studio 2015. To be able to examine Synergy 
variables as you debug remotely, you must also install the Synergy .NET Remote Debugger on 
the remote system. Synergy .NET Remote Debugger is not something you run. It is a set of 
libraries that enable the Visual Studio Remote Debugger to work with Synergy types. See 
Microsoft documentation for more information on remote debugging.

 If you set conditional breakpoints in a Watch window, only the == operator and value 
comparisons (not reference comparisons) are supported. 

 If a breakpoint doesn’t work, use Visual Studio’s Modules window to load necessary symbols, 
or at least find out why the symbols weren’t loaded. Select Debug > Windows > Modules from 
the Visual Studio menu (which opens the Modules window), and then find the entry for the 
missing symbols. If the path and filename are correct, but the status column indicates that the 
symbols aren’t loaded, you can instruct Visual Studio to load them by right-clicking the entry 
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and selecting Load Symbols from the context menu. If the Modules window indicates that the 
path or file isn’t correct, you’ll need to figure out why the file couldn’t be located and resolve 
the issue.

 Make sure both of the following Visual Studio debugging options (Tools > Options > 
Debugging > General) are selected: “Enable property evaluation and other implicit function 
calls” and “Call string-conversion function on objects in variables windows.” If either is 
unselected, local variables will be displayed with internal names.

 If the “Unwind the call stack on unhandled exceptions debugging” option is cleared (Tools > 
Options > Debugging), the pseudovariable $exception is displayed in the Locals window for an 
uncaught exception. Expand $exception to see more information.

 If a path to a static type contains a mix of imported and specified (manually entered) 
namespaces, it might not be evaluated in the Watch and QuickWatch windows. It may not be 
evaluated if a namespace is defined in a file, for example, because the namespace is assumed to 
be imported for the entire file.

 If you use the unsupported Synergy.SynergyDE.tklib.dll library, note that you cannot directly 
examine UI Toolkit globals such as g_select in the debugger. Instead, find the property name 
for the .define in tools.def, and enter that property name (case-sensitive) in the Watch or 
QuickWatch window. For example, the property name entry in tools.def for g_select is

.define g_select  Synergex.SynergyDE.UIToolkit.GlobalState.t_selection

So, to examine g_select you would enter the following in the Watch or QuickWatch window: 
Synergex.SynergyDE.UIToolkit.GlobalState.t_selection.

For information on the Synergy.SynergyDE.tklib.dll library, see “Using UI Toolkit with the 
.NET Framework” in the “Welcome to UI Toolkit” chapter in the UI Toolkit Reference Manual.

 No information displays for a define when you hover over it. (Note that this is true for any 
language that supports defines—for example, C++.)  

 C# literal suffixes are supported for Visual Studio 2015, which means that if you click on a 
local variable in the Locals window and its value is one of the following types, you’ll see the 
suffix (e.g., .m). Do not remove these suffixes. 

Literal Suffix

float .f

double .d

decimal .m

unsigned .u

long .l



Developing with Synergy .NET
Debugging Synergy .NET Code

7-48 Getting Started with Synergy/DE 10.3.3 (5/16)

Synergy DBL Integration includes several Synergy-specific commands for use in the Visual Studio 
Watch and QuickWatch windows:

Synergy types in the Visual Studio Memory Usage Tool
The Visual Studio 2015 Memory Usage Tool displays information on Synergy types, but it uses 
different names for these types:

 A Synergy alpha, integer, decimal, or implied decimal will be have a name with one of the 
following formats (where Type is Alpha, Integer, Decimal, or ImpliedDecimal):

Synergex.SynergyDE.TypeDesc
Synergex.SynergyDE.PinTypeDesc
Synergex.SynergyDE.RefTypeDesc

For example, a decimal will appear as either Synergex.SynergyDE.DecimalDesc, 
Synergex.SynergyDE.PinDecimalDesc, or Synergex.SynergyDE.RefDecimalDesc.

 Structures appear as GenBox<string1,string2> or GenCouple<string1,string2>, where string1 
and string2 are strings that include the structure name. For example, the following is for a 
boxed structure named struct1 in namespace ns1:

Synergex.SynergyDE.Gen_Box<ns1.$$_struct1, ns1.$$_wrap_struct1>

The next example is for a boxed structure named struct2 in namespace ns1:

Synergex.SynergyDE.Gen_Couple<ns1.$$_struct2, ns1.$$_wrap_struct2>

Command Information displayed

^ADDR(expression) The address for a descriptor type variable specified by expression. 
This works only for .NET types in Synergy records and i, d, and a 
Synergy types. It is used in a procedure that determines what 
changed a variable. See “SET WATCH functionality in Visual Studio” 
below.

^M([struct_field,] handle)
(not supported for Mono 
or Visual Studio 2015)

The value of the specified location in the memory handle. If the field 
is typed as a, d, i, or id, it is displayed as that type. If it’s an array, it 
is displayed as an array of appropriate types.

Show channels Channel information

Show handles Handle information
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SET WATCH functionality in Visual Studio
In traditional Synergy, if a variable’s value changes, you can find out what changed it by using 
WATCH variable or SET WATCH variable. But with the Visual Studio debugger, this functionality 
is not available as the default. Instead you must use the SOS debugging extension (which is 
installed with Visual Studio) as outlined in the following procedure. The SOS command 
!CLRStack dumps current stack traces for all threads at the point the variable changes. By 
examining these stack traces, you can find out which routine is writing to the variable. 

1. Open your Synergy project in Visual Studio, and locate or create a programmatic break or pause in 
execution (e.g., a point where the program waits for user input) that happens before the variable’s 
value is changed. You’ll need a programmatic break or pause to give you time to select Break All in 
step 7. 

2. Set a Visual Studio breakpoint at or before the programmatic break. 

3. Start debugging the program (Debug > Start Debugging). 

4. When the program breaks, use the ^ADDR() command in a Watch or QuickWatch window to get 
the address of the variable. For example, if the name of your variable is my_alpha, enter the 
following in a Watch or QuickWatch window: 

^ADDR(my_alpha)

Note (or copy) the address in the Value column of the Watch or QuickWatch window. You will use 
the hexadecimal form of this address to set a data breakpoint in step 8. (If a decimal value is 
displayed in the Value column, you can right-click on the value and select Hexadecimal Display 
from the context menu.) 

5. Detach from the process (Debug > Detach All). 

6. Reattach to the process in native mode: Select Debug > Attach to Process, select the process for 
your program in the Available Processes area of the Attach to Process window, and then click 
Select. In the Select Code Type window, select Native and clear all other options. Then click OK to 
close the Select Code Type window, and click Attach in the Attach to Process window. 

Detaching and reattaching is necessary because the debugger runs in managed mode by default but 
must run in native mode for the data breakpoint set in step 8 to work correctly. 

7. Select Debug > Break All. You may get an error (e.g., “The process appears to be deadlocked...”) 
and a “No Source Available” window. Ignore these; just click OK in the error message and close the 
“No Source Available” window. 

8. Set a data breakpoint (Debug > New Breakpoint > New Data Breakpoint) using the hexadecimal 
address you got in step 4. For example, if the hexadecimal address from that step is 0x0288F0C0, 
enter this in the Address field of the New Breakpoint window. 

9. When the breakpoint is set, continue program execution (Debug > Continue).

10. When the debugger breaks at the breakpoint, you’ll see the message “The following breakpoint was 
hit....” Click OK in this message box. 
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11. Select Debug > Save Dump As, and then use the Save Dump As window to save a .dmp file.

12. Stop the debugging session (Debug > Stop Debugging).

13. In Visual Studio, select File > Open > File, and then in the Open File window, select the file you 
saved in the previous step and click Open.

14. A window opens with the title of the .dmp file. In the Actions section of this window, select Debug 
with Mixed.

15. Enter the following in the Immediate Window:

.load sos

This loads the SOS debugger extension.

16. Enter the following case-sensitive SOS command in the Immediate Window: 

!CLRStack

This writes the stack traces to the Immediate Window.

Note that the program’s debugging session is over, so you won’t be able to continue debugging it. 

Figure 7-12. Set a breakpoint using  the hexadecimal address for the variable.
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Using Data Files on Devices
With device platforms, there is no “current directory.” Whether you create files on a device or copy 
them to a device, files must be in a location on the system that allows read/write access. You can 
then use SETDFN to specify this as the default location and to specify an extension for data files 
used by your device application. 

Terabyte files are not supported on devices. In addition to files created with the TBYTE option, the 
following are created as terabyte files:

 ISAM files created with the TRACK_CHANGES option

 ISAM files that support variable-length records larger than 64K

If you want to use one of these types of file on a device, you must explicitly define the file as a 
non-terabyte file—e.g., by using NOTBYTE with bldism or no48 with the address keyword for 
XDL.

Using data files for Universal Windows Platform
For Universal Windows Platform (UWP) applications, there are several data locations you can use 
for files—for example, the Roaming data store, the Local data store, and the Temporary data store. 
See Microsoft documentation on user and app data stores for more information, and note that for 
data files deployed with the application, you must put the files in a folder in the application project 
and then copy the files to the Local app data store.

1. In Solution Explorer, create a folder for the data files in the application project. 

2. Copy the data files (e.g., .ism and .is1) to the folder you just created.

3. Set the Build Action property for each data file to Content.

4. Add code to the application project to copy the data files from the Dat folder to the Local app data 
store. For example:

   ; **The next three lines should be one long line of code**
   data datFolder, @StorageFolder, await 
Windows.ApplicationModel.Package.Current.InstalledLocation.GetFolderAsync
("Assets\Dat")
   data localFolder, @StorageFolder, ApplicationData.Current.LocalFolder
   await CopyAsync(datFolder, localFolder) ;See CopyAsync code below.
   .
   .
   .
public static async method CopyAsync, @Task
   source, @StorageFolder 
   destination, @StorageFolder 
   endparams
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proc
   data targetFolder, @Windows.Storage.StorageFolder
   ; The next two lines are really one long line of code:
   targetFolder = await destination.CreateFolderAsync(source.DisplayName, 
CreationCollisionOption.ReplaceExisting)
   data files, @IReadOnlyList<StorageFile>
      files = await source.GetFilesAsync(CommonFileQuery.DefaultQuery)                  
   data storageFile, @StorageFile
   foreach storageFile in files
   begin
      ; The next two lines are really one long line of code:
      await storageFile.CopyAsync((@StorageFolder)targetFolder, 
storageFile.Name, NameCollisionOption.ReplaceExisting)
   end                  
endmethod

5. You can then use SETDFN to set a default location and extension for data files. For example:

xcall setdfn((A)(localFolder+".ism"),1)
open(1, "i:i", "syntxt")
close 1

Using data files on Android
For Android applications, you’ll put the data files in the Assets folder for the project, get the 
location of internal storage or the primary external storage directory for the device, and then copy 
the files to this directory.

1. Add the data files (e.g., .ism and .is1 files) to the Assets folder for the project that accesses the files, 
unless the files will be accessed over a network or created by the application. 

2. Select the files in Solution Explorer (under Assets), view file properties, and check the Build 
Action for the files. This should be set to AndroidAsset.

3. Add code to copy the files from the deployed package (.apk) to internal storage or to the primary 
external storage directory for the device. Use the BaseContext property for the Activity to get the 
location of internal storage, or use the Xamarin.Android Framework property 
Android.OS.Environment.ExternalStorageDirectory to get the primary external storage directory. 
You must have read/write access to the directory you use. (The application may crash if the 
directory is read-only.) 

For example:

; Copy the ism file to internal storage. Note that dbIsm and dbIs1 are 
; the names of the ism files, and "this" indicates that this code is
; inside an Activity class. 
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data ismPath, String
; "import System.IO" is required for Path.Combine.
ismPath = Path.Combine(this.BaseContext.FilesDir.AbsolutePath, dbIsm)
data is1Path, String
is1Path = Path.Combine(this.BaseContext.FilesDir.AbsolutePath, dbIs1)
data br = new BinaryReader(Assets.Open(dbIsm))
data bw = new BinaryWriter(new FileStream(ismPath, FileMode.Create))

data myBuffer, [#]byte, new Byte [100]
data len, int

if (File.Exists(ismPath))
begin

while ((len = br.Read(myBuffer, 0, myBuffer.Length)) > 0)
begin

bw.Write(myBuffer, 0, len)
end

end

bw.Flush()
br.Close()
bw.Close()

; Copy the is1 file to internal storage
br = new BinaryReader(Assets.Open(dbIs1))
bw = new BinaryWriter(new FileStream(is1Path, FileMode.Create))

if (File.Exists(is1Path))
begin

while ((len = br.Read(mybuffer, 0, myBuffer.Length)) > 0)
begin

bw.Write(mybuffer, 0, len)
end

end

bw.Flush()
br.Close()
bw.Close()

4. You can then use SETDFN to set a default location and extension for data files. For example:

xcall setdfn((A)(ismPath+".ism"),1)
open(1, "i:i", "syntxt")
close 1
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As an alternative, you can use the Android Device Monitor to deploy files to an Android emulator 
or an Android device that’s configured for development and connected to the Windows 
development machine (see “Building, debugging, and deploying Android applications” on 
page 7-27 for information).

1. Open the Android Device Monitor, which is included in the Android SDK tools.

2. On the Devices tab of the Android Device Monitor, and select the Android emulator or device.

3. On the File Explorer tab, select the data files (or a folder with the data files) you want to deploy. 
Then click the “Push file onto device” toolbar button:

Using data files on iOS
For iOS, put the data files in the Resources folder for the application project, copy the files to the 
Documents folder on the device, and then set SETDFN to this directory and the file extension(s):

1. Create a Resources folder in the application project, if one doesn’t already exist.

2. Put the data files (e.g., .ism and .is1) in the Resources folder.

3. Make sure the Build Action property for each data file is set to BundleResource.

4. Add code to copy the files to the “Documents” folder where the application has read/write access. 
(Without this code, the data files will be placed in the application’s root directory, which is 
restricted to read-only operations.) For example, to deploy a file named syntext.ism with your 
application, you could use the following:

;Copy syntxt.ism from application's root directory to "Documents"
DATA doc=Environment.GetFolderPath(Environment.SpecialFolder.MyDocuments)
DATA ismPath = System.IO.Path.Combine(doc, "syntxt.ism")
File.Copy("./syntxt.ism", ismPath, true)

;Copy syntxt.is1 from application's root directory to "Documents"
var is1Path = Path.Combine(doc, "syntxt.is1")
File.Copy("./syntxt.is1", is1Path, true)

5. You can then use SETDFN to set a default location and extension for data files. For example: 

xcall setdfn((A)(ismPath+".ism"),1)
open(1, "i:i", "syntxt")
close 1
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Performing Common Synergy .NET Coding Tasks
The following sections briefly describe how to perform coding tasks that are common when 
creating Synergy .NET applications and when enhancing traditional Synergy code for Synergy 
.NET. 

Instantiating and using a .NET class
To use functionality from a .NET Framework or Synergy .NET class in a Synergy .NET method,

1. In your source file, add an IMPORT statement to import the namespace that contains the .NET 
class to be used. 

import SomeNamespace

2. Declare a local variable of that class type using the following syntax within a method:

record
    var, @SomeClass

3. Instantiate the class by calling its constructor and assigning it to a local variable. For example,

var = new SomeClass(SomeParams)

4. Call an accessible method from the .NET class using the local variable. For example,

var.SomeMethod(SomeParams)

Inheriting and overriding a .NET class
To override a method in a .NET Framework or Synergy .NET class with different functionality,

1. In your source file, add an IMPORT statement to import the namespace that contains the .NET base 
class definition.

import SomeNameSpace

2. Add the .NET base class name to the class declaration using the EXTENDS keyword.

class MyClass extends System.Object

3. Add a method declaration and implementation to the class for any base class method to be 
overridden. The signature of the method must match the base class method signature.
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Creating a Synergy .NET interface
To create a new Synergy .NET interface and compile it into a Synergy application for use by .NET 
applications,

1. In your source file, declare an interface within a namespace declaration using the INTERFACE 
statement. For example,

interface IMyInterface ;Put interface members here
endinterface

2. Add one or more method prototype declarations within the class declaration. Each method 
prototype declaration specifies the method’s name, return type, and parameter signature. For 
example,

interface IMyInterface
    method mymethod, i4
        p1, i4
    end
endinterface

Writing an implementation for a .NET interface
To write an implementation for an interface described in a .NET assembly,

1. In your source file, add an IMPORT statement to import the namespace that contains the .NET 
interface to be implemented. For example, 

import SomeNamespace

2. Add the .NET interface to a Synergy .NET class declaration using the IMPLEMENTS keyword in 
the CLASS statement. For example,

class MyClass implements IDisposable, IDisposable2

3. Add methods to the Synergy .NET class to implement all methods of the .NET interface. The 
Synergy .NET method signature must match the signature as defined in the interface. For example,

class MyClass implements IDisposable,IDisposable2
    public method IDisposable.Dispose, void
    proc ;Add logic to release resources here
        mreturn
    endmethod
    public method IDisposable2.Dispose, void
    proc ;Add logic to release resources here
        mreturn
    endmethod
endclass
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Creating a Synergy .NET class that uses generics
Generics enable you to substitute types dynamically into parameters, fields, or anywhere else a type 
is used in a class. To add a new generic Synergy .NET class and compile it into a Synergy .NET 
assembly,

1. Create a new file, and add a generic class declaration. (Generic types are added as type parameters. 
In the example below, <T> is the type parameter.) 

class MyClass<T>

2. Add a method declaration that uses the generic type into the class declaration. The generic type can 
be used as a method’s return type, parameter type, or local variable type.

class MyClass<T>
    public mymethod, T
        p1, T
    proc
        mreturn p1
    endmethod
endclass

3. Add member fields that use the generic type to the class declaration.

class MyClass<T>
    public myfield, T
endclass

Using a generic .NET class
To use a generic .NET class in a Synergy .NET application,

1. In your source file, add code to use the generic class by first instantiating the generic class and 
providing another type as a substitute for the type parameter. This substitute type must meet all of 
the type parameter constraints declared in the generic class.

c1, @MyClass
c1 = new MyClass<SomeOtherClass> ()

2. Write code to use the instantiated class just like any other normal Synergy .NET class.
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Declaring and using a delegate
A delegate enables you to pass a method as a parameter value. To add a delegate to a Synergy .NET 
class and use it in an application,

1. Create a Synergy .NET class.

2. Add a delegate to the class by defining a delegate class member that defines a method prototype.

class class1
    public delegate mydelegate, i4
        p1, i4
    enddelegate
endclass

3. Define a method that uses the delegate as a parameter value. (See the Examples section for the 
DELEGATE statement for an example of steps 3, 4, and 5).

class class1
    public method mymethod, i4
        p1, @mydelegate
    record
        v1, i4
    proc
        v1 = p1(5) ;call the delegate passing in a 5
        mreturn v1
    endmethod
endclass

4. Define a method that will be passed as the parameter value in place of the delegate when calling the 
above method. The signature of this routine must match the delegate. For example,

class class1
    public method subthis, i4
        p1, i4
    proc
        mreturn p1 * 2
    endmethod
endclass

5. Call the routine in step 3, passing in the method as a parameter value to substitute for the delegate. 

c1, @class1
md, @class1.mydelegate
v1, i4
c1 = new class1()
md = new class1.mydelegate(c1.subthis)
v1 = c1.mymethod(md) 
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Declaring and using an event
Events are usually used to provide notifications and are used heavily in forms. To add an event to a 
Synergy .NET class and use it in an application,

1. Create a Synergy .NET class. 

2. Add a delegate declaration to the class.

class class1
    public delegate mydelegate, void
        msg, a
    enddelegate
endclass

3. Add an event to the class by defining an event class member and using the previously defined 
delegate. For example,

class class1
    public event myevent, @mydelegate
endclass

4. Add a method to register for the event. The signature of this method must match the delegate.

class class1
    public method mymethod, void
        msg, a
    proc
        open(2,o,"tt:")
        writes(2,"in mymethod "+msg)
        close(2)
        mreturn
    endmethod
endclass

5. Register the method as an event handler for the event by adding a call to ADDHANDLER.

c1, @class1
c1 = new class1()
addhandler(c1.myevent, c1.mymethod)

6. Add a call to RAISEEVENT to raise the event, which causes all registered event handlers to be 
executed. Note that parameter values to be passed to RAISEEVENT are passed on to the registered 
event handlers.

raiseevent(c1.myevent, "pass this message")
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Calling a routine in a Synergy assembly from another assembly
A Synergy routine in a .NET assembly can be called from another Synergy .NET assembly or from 
a .NET assembly created with another language. Requirements vary depending on the types of 
passed data and whether the calling assembly was created with Synergy.

Calling from a Synergy assembly
The simplest case is to call a Synergy routine from another Synergy .NET assembly. To do this, do 
the following in the calling assembly:

1. Reference the assembly for the Synergy routine. See “Synergy runtime libraries” on page 7-11.

2. If the Synergy routine is part of an explicitly declared namespace, import the namespace.

3. If the routine is a part of a class, call it as a class method. For example,

MyClass MyClassInstance = new MyClass()
MyClassInstance.Mysubroutine(arg1, arg2)

If the Synergy routine is not part of a class, call it as an external subroutine or function. For 
example,

xcall MySubroutine(arg1, arg2)
var1 = MyFunction(arg3, arg4)
MySubroutine2(arg5)

Calling from a non-Synergy assembly and passing .NET types
When calling a Synergy routine from a non-Synergy .NET assembly, the method you’ll use 
depends on the type of data passed. If only .NET types are passed, follow the steps below; 
otherwise see “Calling from a non-Synergy assembly and passing structures or non-.NET types” on 
page 7-62. (.NET types are value types that correspond to .NET System.type types. For 
information, see “Data Types” in the “Defining Data” chapter of the Synergy DBL Language 
Reference Manual.)

In the calling assembly,

1. Reference the assembly for the Synergy routine. See “Synergy runtime libraries” on page 7-11.

2. Import the namespace for the Synergy routine. (For example, use a “using” statement in C#.) If the 
Synergy routine is not in an explicitly defined namespace, it is assigned to the default namespace, 
_NS_name, where name is the name of the assembly. 

3. Call the Synergy routine as a class method. If the Synergy routine is not part of a class, the routine 
is considered a static method of the default class, _CL.
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For example, the Synergy code below includes a subroutine (MySubroutine) and a function 
(MyFunction) that are not part of a namespace or class:

import System
import System.Collections.Generic
import System.Text

subroutine MySubroutine
required out int1    ,int     // .NET
required in string1 ,string // types

proc
open(1, o, "tt:")
writes(1, string1)
int1 = 1
sleep Int1
close(1)
return

endsubroutine

function MyFunction
required out int1    ,int    // .NET
required in string1 ,string // types

record
result ,int     ,0

proc
open(1, o, "tt:")
writes(1, string1)
int1 = 2
sleep 1
close(1)
freturn (result)

endfunction

To call the routines in the Synergy code above, the following C# program imports the default 
namespace (for this example, _NS_MyDll) and calls the routines as methods of the default 
class _CL: 

using System;
using System.Collections.Generic;
using System.Linq;
using System.Text;
using _NS_MyDll;     //Import namespace (in this case, the default
                     // namespace).
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namespace InteropConsoleApp
{
    class Program
    {
    static int      arg1;
    static string   arg2 = "A string";
    static int      freturn;

        static void Main(string[] args)
        {
        _CL.MySubroutine(out arg1, arg2); //Call subroutine as a method.
        Console.WriteLine(arg1);                  
        freturn = _CL.MyFunction(out arg1, arg2); //Call function as a
                                                  // method.
        Console.WriteLine(arg1);                  
        Console.WriteLine(freturn);               
        Console.ReadLine();                       
        }
    }
}

Calling from a non-Synergy assembly and passing structures or non-.NET types
If a Synergy routine has a parameter or return value that accepts or passes a structure or a data type 
that is not a .NET type, do one of the following to call it from a non-Synergy assembly:

 Use a Synergy/DE interop project to create the assembly for the Synergy routine. When you 
use an interop project, wrapper classes with data type mappings and classes for passed 
structures are generated when the project is built.

 Create your own mappings for types that are not .NET types and for passing Synergy 
structures.

 Use Synergy PintypeDesc() classes in the assembly that calls the Synergy routine. See “Using 
Synergy data type classes in non-Synergy assemblies” on page 7-65.

We recommend the first method, using a Synergy/DE interop project, which will include code and 
generated classes that automate data type mapping and record-to-class mappings for structures. 
Note, however, that the interop project type was designed for converting xfServerPlus routines for 
native .NET access (see “Converting xfServerPlus routines for native .NET access” on page 7-70). 
Consequently, code that you write for use with an interop project must adhere to many of the same 
requirements as code written for use with xfServerPlus. For example, it must be written in the form 
of a subroutine or function (not a method) and must not be included in a class.

If you are not familiar with writing code for use with xfServerPlus, you may want to review the first 
chapter of the xfNetLink & xfServerPlus User’s Guide, “Preparing Your Synergy Server Code,” 
particularly the information on passing data when using a .NET client. But bear in mind that some 
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of the information in that chapter (e.g., using ELBs) applies only if your routines are intended for 
use with xfServerPlus. These sections of the “Preparing Your Synergy Server Code” chapter may 
prove useful:

 “Attributing Your Code”

 “Passing Structures as Parameters”

 “Handling Variable-Length and Large Data”

 “Passing Binary Data”

To use an interop project to access a Synergy routine,

1. Create a Synergy/DE interop project by selecting Synergy/DE > Interop in the New Project window 
in Visual Studio.

2. Write and attribute the Synergy code. Generated classes that wrap the Synergy code are based on 
routine definitions in the code and on attributes when necessary. For example, the interface property 
of the xfMethod attribute is used for the name of the generated wrapper class, and the method name 
defaults from the routine name. See “Using Attributes to Define Synergy Methods” in the 
“Defining Your Synergy Methods” chapter of the xfNetLink & xfServerPlus User’s Guide, and note 
the following:

 The interop project will include the SynergyRoutines.dbl file, which has utility routines 
needed for date conversions and for compatibility with xfNetLink .NET clients. Do not make 
changes to this file or remove it from the project. Add your Synergy routines to a new DBL 
code file (Project > Add New Item > Code File).

 Do not put the Synergy routine in a class. Other Synergy routines can be in classes, but code 
that you attribute (i.e., routines for which class wrappers will be generated) should not be in a 
class.

 Structures passed as ordinary parameters or arrays must be .INCLUDEd from the repository 
and defined as a structfield in your code. Passed structures become classes in generated code, 
and fields in the structure become properties of these classes. In addition to “Passing Structures 
as Parameters,” listed above, for more information see “Using Structures” in the “Calling 
Synergy Routines from .NET” chapter of the xfNetLink & xfServerPlus User’s Guide, and note 
that the Original property is not supported for interop projects.

3. Set project properties as necessary. For information on these settings, press F1 while the Interop 
page is displayed.

4. Build the Synergy assembly. This generates wrapper classes and adds them to the project. A class 
will be generated for each interface defined in the project and for each structure.
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5. In the calling assembly, 

 reference the Synergy Interop assembly.

 import the namespace for the class that wraps the Synergy routine.

 call the class method that corresponds to the Synergy routine you wrote in step 2.

The following example Synergy code includes an i argument (arg1), which is not a .NET type. If 
this code is added to a .dbl file in an interop project, the interop project will wrap the Synergy 
routine in a class that maps the i argument to a .NET type (int).

import System.Collections.Generic
import System.Texts

{xfMethod(interface="InteropTest")} ;Attributing is required for
; interop project

subroutine MySubroutine
required out arg1 ,i       ;Not a .NET type
required in arg2 ,String

proc
open(1, o, "tt:")
writes(1, arg2)
sleep 3
close(1)
arg1 = 5
return

endsubroutine

The following is a C# program that calls the Synergy routine above. The C# code imports the 
namespace (which for this example is InteropProjSynDll) and creates an instance of the InteropTest 
class (the generated wrapper class) to access the MySubroutine method:

using System;
using System.Collections.Generic;
using System.Linq;
using System.Text;
using InteropProjSynDll; //Namespace for generated class

Along with the method that corresponds to your Synergy routine, the Object Browser and 
IntelliSense for Visual Studio will display several methods that you shouldn’t use in your 
code: connect, disconnect, Equals, GetHashCode, GetType, getUserString, 
setCallTimeout, and setUserString. These items are for internal use by the generated 
classes and for compatibility with xfNetLink .NET clients.
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namespace InteropProjConsoleApp
{

class Program
{

    static int      arg1;//Corresponds to i parameter in Synergy routine.
    static string   arg2 = "A string";

    static void Main(string[] args)
    {
      InteropTest tst = new InteropTest(); //Synergy routine 
                                           // (MySubroutine) called
      tst.MySubroutine(ref arg1,arg2);     // as method of InteropTest 
                                           // class wrapper 
      Console.WriteLine(arg1);
      Console.ReadLine();
      }
   }
}

Using Synergy data type classes in non-Synergy assemblies
If you import Synergex.SynergyDE and add a reference to Synergy runtime libraries (see “Synergy 
runtime libraries” on page 7-11), you can use the following classes in a non-Synergy assembly to 
pass Synergy alpha, decimal, implied decimal, and integer data when calling a Synergy routine. 
You can use these classes unless structures or other non-.NET types are passed (in which case, you 
will need to do the mappings yourself or use a Synergy/DE interop project).

 PinAlphaDesc(size)

 PinDecimalDesc(size)

 PinImpliedDecimalDesc(size, precision)

 PinIntegerDesc(size)

You can use these classes, but they are not supported. We recommend that you instead 
use a Synergy/DE interop project when passing non-.NET data types. See “Calling from a 
non-Synergy assembly and passing structures or non-.NET types” on page 7-62.
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Preparing Existing Code for Synergy .NET
In addition to using Synergy DBL to create entirely new applications for Microsoft .NET 
Framework (on Windows) or Mono (on Android, iOS, or Linux), you may also be able to use 
existing traditional Synergy code to create .NET applications. 

Whether you are planning to migrate an entire application, port frequently used functionality, or 
simply make some Synergy routines available to other .NET programs, you can begin with an 
existing traditional Synergy solution. 

 If you use xfServerPlus and xfNetLink .NET, you can rebuild your Synergy methods to run 
under Microsoft .NET Framework on Windows and then call them natively (without going 
through xfNetLink .NET and xfServerPlus). See “Converting xfServerPlus routines for native 
.NET access” on page 7-70.

 If you use the Synergy windowing API, you can use Synergy .NET’s support for this API as a 
starting point for your user interface. This results in “UNIX-like” non-mouse-controlled “W_” 
windows in WinForms under the .NET Framework on Windows.

The following steps outline the basic procedure for a typical application. This is an iterative 
process; you start with global entities, move to common code, and then work up to code that’s 
specific to certain functionality. The goal is to organize code into useful projects and avoid circular 
dependencies and forward references, which are not allowed in DLLs (see step 7 on page 7-68), 
while making code compatible with .NET.

Unlike traditional Synergy, 

 all global symbols must be resolved at the time an assembly (class library or executable) is 
compiled because all files in an application are compiled together. (With traditional Synergy, 
the same name can be used for different global entities in different .dbl files if the files are 
compiled separately.)

 it is not possible for a global record in an .exe file to be referenced by an external record in a 
class library.

To prepare existing traditional Synergy code for .NET,

1. Start by creating a Synergy class library project as a new solution (i.e., create the project when no 
solution is open in Visual Studio). Select File > New Project from the Visual Studio menu, and then 
select a class library project template (under Installed Templates > Synergy/DE in the New Project 
window). 

For more information on project templates, see the “Synergy/DE Project Templates” topic in 
Synergy/DE WebDocs, and note that for portability, put as much logic as possible in portable class 
libraries. Portable class libraries can target some or all supported platforms (Microsoft .NET 
Framework on Windows and Mono on Android, iOS, and Linux).
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2. Once you’ve selected a template, specify a name, location, etc., for the project, and click OK to 
create it.

3. In the .dbl file for the project, create a subroutine and add all global entities for your application 
into the subroutine:

 Add all global structures to the data division of the subroutine.

 Add global commons, global literals, global data sections, and INIT statements to the 
procedure division of the subroutine.

4. Set project properties as necessary. See the “Setting Synergy/DE Project Properties” topic in 
Synergy/DE WebDocs.

5. Build the project. If you get errors, it is probably because the code includes something that is not 
supported in the .NET environment. (By double-clicking an error message in the Visual Studio 
Error List, you can go directly to the line of code that is causing the error.) Analyze the code 
causing the problem, and ask yourself the following questions:

 Is it necessary to the .NET solution, or can it be removed?

 Is it replaceable with code that functions in both Synergy .NET and traditional Synergy? If not, 
you can use the following compile-time defines to conditionally compile code of the program: 
DBLNET (for Synergy .NET only), D_MONO (for mono development only), and 
D_PORTABLE (for portable class libraries only). 

Don’t be alarmed if your initial compilations result in a number of errors and warnings. Most of the 
errors and warnings will involve only minor fixes, and solving one will most likely also resolve 
several others. Also keep in mind that many of these issues would result in runtime failures—and 
they may already be causing runtime errors in your current application.

See the “.NET Development” chapter in the Professional Series Portability Guide for information 
on Synergy features that are not supported in Synergy .NET.

6. Repeat the process (step 1 through step 5) for your application’s core routines, and add a project 
reference to the project for global structures, commons, etc.
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7. Repeat the process again, but for sets of routines that are specific to certain areas of your 
application, and this time add project references to the project for core routines and the project for 
globals. For example, if your application has general ledger (GL) functionality and order entry 
functionality, you could create a class library project for the GL routines and another class library 
project for the order entry routines, making sure they reference existing projects: 

With Synergy .NET, only forward references are supported (i.e., circular references are not 
allowed). For example, if you have core routines and order entry routines in separate projects and 
the order entry routines call the core routines, the core routines cannot reference anything in the 
order entry routines. There is an exception: you can use XSUBR for a “backward reference” if 
necessary, but this can adversely affect performance. 

Figure 7-13. Create class libraries for routines specific to certain areas of your application.
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Figure 7-14. Use only forward references with Synergy .NET (unless you use XSUBR).
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8. Create projects for the routines that make up the programs that call the routine libraries and add 
project reference to those libraries. These programs will be executable assemblies, so create 
application projects for these programs. Then repeat the process described in step 4 for these 
projects. 

9. Once compile errors have been corrected for the assemblies, you should be able to run and debug 
the application. 

Figure 7-15. Create application projects for programs that call libraries.
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Converting xfServerPlus routines for native .NET access
If you use xfNetLink .NET to access Synergy routines, you can access these routines natively in 
Microsoft .NET Framework on Windows by generating an assembly for the Synergy routines and 
then accessing that assembly (rather than the assembly generated by gencs). Once you make this 
change to your application, it will no longer be a distributed application that accesses Synergy 
routines remotely. Rather, those routines will be built into a DLL, which will be referenced locally 
by the .NET application (the application that was the xfNetLink .NET client). Neither xfNetLink 
nor xfServerPlus will be involved. 

This conversion can be of benefit if your xfNetLink client application is a Windows application 
(e.g., written in C# or VB.NET). It should improve performance and enable you to use seamless 
in-process debugging from your client code through to the Synergy .NET code. It should also help 
you prepare for future .NET development. For a web application, you can either continue to access 
Synergy routines remotely from your .NET client, or if your web server is Windows based, you can 
convert to run natively without xfServerPlus/xfNetLink .NET.

To convert xfServerPlus routines for native .NET access,

1. Create a Synergy/DE interop project in Visual Studio. (In the New Project window for Visual 
Studio, select Synergy/DE > Interop.) You can add this project directly to the client solution, or you 
can create a separate solution (and later add a reference to it from the client).

The project will include the file SynergyRoutines.dbl, which has stub routines for XFPL_LOG 
and SET_XFPL_TIMEOUT so that if your Synergy code calls these two xfServerPlus API 
routines, it won’t break. SynergyRoutines.dbl also includes some datetime conversion routines 
that are used by the generated classes. Do not alter these routines and do not remove this file from 
the project. 

2. Add the source files that contain the Synergy routines currently accessed by your xfNetLink .NET 
application to the project. 

For web services (IIS and WCF), globals, channels, and server connections must be 
isolated by AppDomain. For more information, see “Using Synergy .NET in Multi-Threaded 
Applications,” available on the Synergy/DE PSG blog site, and see 
SynNetAspAppDomainOnlyInterop.zip, available from Synergy CodeExchange in the 
Resource Center on the Synergex web site.

If your xfNetLink client program calls XFPL_REGCLEANUP directly, you will need to find 
some other way to incorporate that functionality. For example, you could change your code 
to directly call the cleanup routine that was called by XFPL_REGCLEANUP. 

https://resourcecenter.synergex.com/devres/code-exchange-details.aspx?id=240
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3. If your Synergy routines have not yet been modified to use attributes, parameter modifiers, and 
(optionally) documentation comments, do so now. See “Using Attributes to Define Synergy 
Methods” in the “Defining Your Synergy Methods” chapter of the xfNetLink & xfServerPlus User’s 
Guide. 

 Add direction (IN, OUT, INOUT) and required/optional (REQ, OPT) modifiers to parameters. 
See “Parameter definitions” in the “Defining Data” chapter of the Synergy DBL Language 
Reference Manual. 

 Add xfMethod attributes. For details, see “xfMethod Attribute” in the “Defining Your Synergy 
Methods” chapter of the xfNetLink & xfServerPlus User’s Guide. 

Only the interface property of the xfMethod attribute is required when attributing code in an 
interop project, but you may need other properties, such as method name, depending on your 
code. The elb, id, and encrypt properties are unnecessary. Pay special attention to how methods 
are named so that you do not break existing code. Note that if you’ve already attributed your 
code, adding properties such as elb and id, you can leave it as is; these are not necessary when 
using the interop project type, but they do no harm. 

Pay special attention if you choose to rely on default sizes for return values when attributing 
code, as the data type conversion from Synergy to C# types sometimes depends on the defined 
size. See the xfNetLink .NET section of Appendix B in the xfNetLink & xfServerPlus User’s 
Guide for details on data type mapping.

 Add xfParameter attributes as needed. For details, see “xfParameter Attribute” in the “Defining 
Your Synergy Methods” chapter of the xfNetLink & xfServerPlus User’s Guide. 

If your Synergy routines pass structures as ordinary parameters or as arrays, redefine them as 
structfields. 

As with return values, if you rely on default sizes for parameters when attributing code, you 
should pay special attention, as the data type conversion from Synergy to C# types sometimes 
depends on the defined size. See the xfNetLink .NET section of Appendix B in the xfNetLink 
& xfServerPlus User’s Guide for details on data type mapping. 

If you used the alternate interface name feature, you will need to specify the alternate 
name for the interface property when you attribute your code. For example, if the 
interface for the login routine was Cust in the SMC and you always changed it to 
Customer when you generated classes, you would use Customer for the interface 
property in the xfMethod attribute. Or, if you generated classes once with Cust and a 
second time with Vendor, you’d create two xfMethod attributes for the login routine, one 
for each interface. See “Attribute Examples” in the “Defining Your Synergy Methods” 
chapter of the xfNetLink & xfServerPlus User’s Guide for an example. 
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 Add Select classes to access your remote (or even local) data instead of READ, READS, etc., 
and ensure xfServer is enabled. Using Select causes the database (rather than the program) to 
filter the returned records. See the “System-Supplied Classes” chapter of the Synergy DBL 
Language Reference Manual for more information about the Select classes. Note that the 
SparseRecord method and the Select.OrderBy class offer additional performance benefits to 
Select class implementations. 

 Add documentation comments, if desired. See “Documentation Comments” in the “Defining 
Your Synergy Methods” chapter of the xfNetLink & xfServerPlus User’s Guide.

4. Set project properties. 

 On the Interop tab, you’ll find some of the options that you used to set in the Component 
Information dialog in Workbench (or specify on the command line). You should set these 
options the same way you did previously so as not to break code. For help with the fields on 
this tab, press F1 while the tab is displayed. Note the following: 

 Prior to version 9.5, output parameters were always generated as “out” in the C# classes. 
If you change to “ref”, you will need to update your client code. 

 If you previously used pooling, you should select the pooling option. This will ensure that 
any pooling support methods your application relied on are still called. 

 On the Application tab, verify that the value in the Default namespace field matches the 
namespace your application currently uses. It defaults to the project name; previously, it 
defaulted to the project (or assembly) name followed by “NS”.

 If your application passes structures as parameters, be sure to specify the location of the 
repository files. You can do this on the Environment Variables tab or in the synergy.ini file (if 
SFWINIPATH is set). Also set any other environment variables used by the Synergy routines. 
You can use repository files that are not in the location specified by RPSMFIL and RPSTFIL 
(or RPSDAT) by setting DBLNET2XML_RPS. See DBLNET2XML_RPS in the 
“Environment Variables” chapter of Environment Variables & System Options.

 To generate an XML file for API documentation, select the option on the Build tab. 

5. Build the interop project to generate the wrapper classes and the assembly. Fix any issues reported 
by the compiler (see step 4 on page 7-67 for more information). The generated classes are added to 
the project. Note that the classes and assembly are generated in one step rather than two as they 
were in Workbench.

If you previously edited the generated classes, you will need to find some other way to 
include the added (or altered) functionality into your application. Because classes are 
generated and the assembly is built all in one step, any changes you make to the classes 
will be overwritten when you rebuild. 
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6. Update your client application: 

 Open projects for assemblies that used xfServerPlus and remove the references to the previous 
assembly and to xfnlnet.dll.

 Add a reference to the new assembly.

 Rebuild the project and run the application. You may need to set environment variables needed 
at runtime that were previously set on the xfServerPlus machine.  

TIP
Your files will include unnecessary code. For example, there may be calls to the connect() 
and disconnect() methods, which are no longer used. The DLL you built in the interop 
project has stub routines to handle these calls (by doing nothing), but you may want 
eventually to remove the unnecessary calls so that your code is easier to read. 
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What Is a Client/Server System? 
A client/server system is a computer network in which one or more computers act as clients, 
requesting services or access to data, and one or more computers act as servers, processing the 
clients’ requests. The primary objective behind setting up a client/server system is to set up some 
computers on a network as user-interface specialists and some computers as shared-data specialists.

A basic client/server model
In a basic two-tier client/server model, the bulk of the application, including the user interface and 
logic processing, resides on the client machine. (See figure 8-1.) The client is usually a PC, but it 
can also be a workstation connected to a multiuser system. The data—as well as the logic that 
maintains the data’s integrity—is centralized on the server. When a client application needs to 
access remote data, it sends the request over the network to the server.

The server can wait for client requests while processing requests from connected client 
applications. The computer selected to be the server must be capable of pre-emptive multitasking.

Any computer hosting a client application becomes a client. A client application is simply an 
application that uses client capabilities (such as the runtime included with Synergy DBL version 
6.1 or greater or Synergy/DE xfODBC). 

Figure 8-1. A two-tier client/server configuration.
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A multi-tier client/server model
The first multi-tier client/server architecture was the three-tier model (see figure 8-2), which 
divides processing into essentially three layers: 

 User interface (collecting data from the user)

 Database serving (accessing data)

 Business logic (processing data)

The three-tier architecture led to an n-tier architecture, in which many application servers can be 
created to perform parts of the processing involved in any of the three layers, but most commonly in 
the application logic processing area. An n-tier configuration uses a distributed network and has 
different layers of business presentation and database access logic, each running where it is most 
appropriate.

This chapter addresses only data access with xfServer. For information about logic processing and 
the other Synergy products that enable you to create true multi-tier software solutions, see 
chapter 9, “Accessing Logic Remotely with xfServerPlus.”

Figure 8-2. A three-tier client/server configuration.
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Benefits of a client/server system
Client/server architectures are popular for several reasons:

 Your users can share data. This is the same benefit you get from traditional multiuser 
environments. Data requests and transfers between the client and the server can be concurrent 
and are transparent to the user. Supported file types include relative, stream, sequential, and 
ISAM. Any file I/O function supported by the server’s “native file” system can be performed 
from the client application. 

 You can optimize existing systems. When you network various types of computers in the 
same client/server system, you can set up each to execute the function(s) it performs best. 
Client/server tools enable you to use both the network connections and serial terminal 
connections at the same time, so you don’t need a desktop system for every user. Furthermore, 
a client/server system allows both the client and the server to make the most efficient use of 
their power:

 The client application manages the user interface.

 The server system handles shared file or data access requests.

Freeing the server from interface tasks reduces processing time and memory usage.

Although you can access remote data with a mapped drive or on an NAS (network-attached 
storage) drive, we recommend that you use xfServer instead. Mapped and NAS drives are 
known to cause data corruption. With xfServer, there is less chance of data corruption 
because xfServer properly closes files when a network connection is lost. In addition, 
xfServer is more efficient than mapped drives for file I/O. For more information on using 
mapped or NAS drives to access remote data, see Synergex KnowledgeBase article 
100002008.

https://resourcecenter.synergex.com/devres/kb-details.aspx?id=1811
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What Is xfServer?
Synerdy/DE xfServer is the technology that enables Synergy developers to add client/server 
capabilities to their Synergy applications. It provides the connectivity layer for remote access to 
corporate data from Synergy client applications. 

The basic xfServer system consists of a Windows and/or UNIX client application connected by a 
TCP/IP-based network to a Windows, UNIX, or OpenVMS server system. The client portion of 
xfServer is incorporated into the runtime of Synergy DBL for Windows and UNIX systems. The 
server portion of xfServer is a background process that can reside on any Windows, UNIX, or 
OpenVMS computer you select to be the server. Once started in the background, the server program 
continually accepts requests from any client computers. The server program’s executable file is 
rsynd.exe (Windows), rsynd (UNIX), or rsynd.exe and rsdmse.exe (OpenVMS).

xfServer uses a fixed-port TCP/IP implementation. The default port is 2330, but it can be 
overridden, enabling users to resolve port conflicts and run multiple servers on a single host. 

How the xfServer system operates
Let’s say we have a business contact application that is used by the account managers and support 
representatives in a large software company. The Synergy application is located on the PCs (the 
client systems) of the sales and support staff, while the data about customers, which needs to be 
shared, resides on a server in the MIS department. xfServer is what enables the server to accept 
client requests for data and send data back to the client PCs.

This section describes how the xfServer system works locally (at the client application level) and 
remotely (at the server level).

How your application works locally

Access files using a server “address”

To access remote files, you must specify the server name in your file specifications. You can do this 
directly or using a logical. The direct file specification method is to append the server “name” to the 
filename in your Synergy DBL statements and subroutines. The server name, in the form @server, 
can be either the host name of the server or the server’s fully qualified domain name. An alternate 
form of a server file specification is @address, where address is the server’s IP address on the 
network. For example, if your server’s host name is “yubby” and the IP address is 234.52.47.128, 
you can specify the file using either of the following forms:

file@yubby
or file@234.52.47.128

If you are accessing a file on a separate domain, you can specify the file in the following form:

file@yubby.subdomain.com 
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We recommend that you use a logical to specify the server address rather than using a direct 
specification. It is much easier to maintain your code and keep up with potential changes in the 
client/server system architecture if your application uses logicals. Ultimately, your system will 
translate your file specification to the direct form and use it to access the data, but under most 
circumstances, your program should not hard-code the file location. See “Getting Started with 
xfServer” in the “Configuring xfServer” chapter of the Installation Configuration Guide for more 
information about setting up logicals.

I/O limitations

You are restricted to the I/O limitations of the xfServer system. See the Professional Series 
Portability Guide for more information on system-specific limitations.

How the server works remotely (Windows and UNIX) 
The design for the Windows and UNIX xfServer platforms are similar, with only a few differences. 
Because Windows and UNIX servers can handle multiple clients’ requests quickly, and starting a 
new session server process is transparent to the user, “standby” session servers are not needed. 
Instead, a Windows or UNIX server starts a new session server only when it receives a new client 
request. 

xfServer operates on Windows and UNIX as follows:

1. The server receives a request from a client application.

2. The server’s dispatcher starts a new session server process (server thread on Windows). 

3. The new session server completes the connection to the client application.

4. The session server processes the client’s requests. After the process has completed all of the client’s 
requests, the session server process (server thread on Windows) terminates. See figure 8-3.

A remote file specification cannot reference another remote file specification when the first 
file specification is on Windows.

We do not recommend using GET and PUT statements in a heterogeneous client/server 
environment. Remote fixed I/O (GET and PUT) is not transparent between client/server 
systems with different native line terminators (for example, Windows and UNIX). To allow for 
this, you may have to change client applications to support multiple operating system file 
types. Your client application must know where the file is located and account for either 
zero, one, or two line terminators when specifying the destination record size.
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How the server works remotely (OpenVMS) 
xfServer starts a pool of session server processes at server startup. These processes maintain and 
communicate their status (“I’m busy” or “I’m waiting for a client request”) to the server connection 
manager.

As the session server pool is depleted by client requests, connection manager starts additional 
servers in order to maintain the free pool. If there are a sufficient number of session servers in the 
free pool, these temporary processes are deleted after servicing the client’s request.

xfServer operates on OpenVMS as follows:

1. The connection manager receives a request from a client application.

2. The connection manager assigns a session server process (from the pool of processes). 

3. The assigned process completes the connection to the client application.

4. The process services the client’s request. During processing, the connection manager won’t assign 
the process to another request. After the process has completed the client’s request, the process 
sends a message back to the connection manager and waits to be reassigned. See figure 8-4.

Figure 8-3. Windows and UNIX server processing.
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How the user sees the system
You may be asking yourself, “Will my users have to perform any extra steps to access the files on 
the server?” Your users will see the application operate exactly as it did before. Data requests and 
transfers between the client and the server will be completely transparent to the user.

Basic requirements
To set up your xfServer system, you’ll need the following:

 Network hardware (network cards, cables, and connectors)

 Network software (TCP/IP) for all client and server hosts

 Your Synergy application

 Synergy DBL with client support (version 6.1 or higher) for your client machine

 xfServer for your server system

 Log-ins and home directories for each client on the server system

Figure 8-4. OpenVMS server processing.
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Managing and monitoring your xfServer system

On Windows 

You can optionally log information related to xfServer. To view the log, choose Event Viewer from 
the Administrative Tools window. The log of events appears under the rsynd source.

You can also monitor which files are open, who opened them, and whether they are locked by using 
the Monitor utility. See “The Monitor Utility for Windows” in the “General Utilities” chapter of  
Synergy Tools.

On UNIX

xfServer includes utilities you can use to manage your client/server system. To use these utilities, 
add the appropriate option specification when you invoke the rsynd command. For example, to 
start the Monitor function so you can track client/server activity, use the -m option when you 
execute the server command:

rsynd -m

The rsynd options -m and -v do not restart the existing rsynd daemon. They merely return the 
server version (-v) or enable monitoring (-m).

See “The Monitor Utility for UNIX” in the “General Utilities” chapter of Synergy Tools  for 
additional information about monitoring the client/server system.

On OpenVMS

xfServer includes a utility called servstat that you can use to manage your OpenVMS server 
system. See “The servstat Program” in the “General Utilities” chapter of Synergy Tools for more 
information.

See also
 The “Configuring xfServer” chapter of your Installation Configuration Guide for additional 

information about setting up your xfServer system.

 Chapter 9, “Accessing Logic Remotely with xfServerPlus,” for information about logic access.

The event log fills up quickly. Remember to clear your event logs.
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Overview
Synergy/DE enables you to create robust two-tier and multi-tier distributed applications—including 
web-enabled, thin-client solutions—using xfServerPlus, xfNetLink, and Professional Series 
Workbench. Using these tools, you can update your existing Synergy applications by adding a 
modern interface, without completely rewriting your Synergy code. 

The user interface can be handled through applications written in Synergy, Java, or a .NET capable 
language such as C# or VB.NET. Or, you may choose to develop a web solution using ASP.NET, 
JavaServer Pages™ (JSP), or web services. The xfNetLink edition that your application requires 
depends on what type of user interface you want to provide. 

The application logic can be written in Synergy DBL, and the database can be accessed by routines 
written in Synergy DBL. You can use Professional Series Workbench to edit your Synergy server 
code and to generate Synergy JAR files and assemblies. (See chapter 2, “Developing Your 
Application in Workbench,” for details about Workbench.) 

See chapter 8, “Accessing Data Remotely with xfServer,” for an overview of basic distributed 
computing and a list of its benefits. 
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What Are xfServerPlus and xfNetLink?
xfServerPlus and xfNetLink enable you to access Synergy routines and data remotely from a 
Synergy, Java, or .NET client. The three xfNetLink editions serve as clients to xfServerPlus and 
provide the ability to access Synergy logic from a variety of front-ends. Together, xfNetLink and 
xfServerPlus handle creating a connection and translating data between the client machine and your 
Synergy server machine.

xfServerPlus
xfServerPlus is the Synergy business logic server that handles the remote execution of Synergy 
routines. The routines are made available for remote calling by including them in an ELB or shared 
image and defining them in the Synergy Method Catalog (SMC). (Routines that have been defined 
in the SMC are referred to as Synergy methods.) xfServerPlus receives a request to execute a 
Synergy routine from the remote client, translates the request, executes it, and returns the results to 
the client. xfServerPlus uses the dbs non-interactive runtime.

The Synergy Method Catalog

The Synergy Method Catalog identifies each Synergy subroutine or function that you want to be 
able to call remotely and the ELB or shared image in which it can be found. For Java and .NET 
clients, routines are assigned a method name that is used by the client application, and then grouped 
into interfaces. The SMC also provides detailed information on the type and length of the input and 
output parameters, as well as the type and length of the function results that are transmitted back to 
the client. 

xfServerPlus uses the information in the SMC to allocate adequate memory for data that is passed 
to (and possibly updated by) the Synergy DBL routines; to ensure that data from xfNetLink clients 
is translated into the correct Synergy data types; and to ensure that function results are translated 
into the correct return types for the xfNetLink client. Data in the SMC is also used to create JAR 
files for use with xfNetLink Java and assemblies for use with xfNetLink .NET. 

To populate the SMC with information about your routines, you will add attributes that describe the 
routines to your Synergy code. Then, you will run the dbl2xml utility using your Synergy source 
files as input. The dbl2xml utility outputs an XML file containing information about the routines, 
which can then be imported into the SMC. You can also populate the SMC manually using the 
Method Definition Utility. See the “Defining Your Synergy Methods” chapter of your xfNetLink & 
xfServerPlus User’s Guide for details on the SMC. 
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xfNetLink Synergy Edition
xfNetLink Synergy is a set of routines distributed with Synergy/DE Professional Series. These 
routines work in conjunction with xfServerPlus to execute Synergy routines stored on a remote 
machine. Using xfNetLink Synergy, you can create a two-tier distributed application consisting of a 
Synergy user interface on the client accessing Synergy logic residing on a remote Synergy server. 
(See figure 9-1.) A Synergy front-end provides your users with a familiar look. Because the client 
API is provided by Synergy DBL, you can use it on all supported Synergy platforms. The Synergy 
runtime must be deployed on the client. 

There are two ways to use xfNetLink Synergy: %RXSUBR (and the xfNetLink Synergy API) and 
the routine call block API. You can use other Synergy/DE tools to develop your xfNetLink Synergy 
application: Composer provides drag-and-drop GUI development, as well as platform 
independence, and Workbench can be used to edit your Synergy code. 

For more information see the “xfNetLink Synergy Edition” section of your xfNetLink & 
xfServerPlus User’s Guide. For details on making remote calls using a routine call block, see the 
“Synergy Routine Call Block API” chapter of the Synergy DBL Language Reference Manual.

Figure 9-1. xfNetLink and xfServerPlus in a two-tier configuration.
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xfNetLink Java Edition
xfNetLink Java is a Java client for xfServerPlus that works in conjunction with the Java 
programming language. Java is an interpreted language and is supported on a wide variety of 
platforms, including Windows, UNIX, and OpenVMS. Using xfNetLink Java, Synergy business 
logic can be accessed from any Java-capable environment, including Java applications, JavaServer 
Pages, and Java applets in web pages. (We discuss two of these options below.) Together, xfNetLink 
Java and xfServerPlus handle the creation of a connection between the client machine and your 
Synergy machine, as well as the translation of data from Java to Synergy and back to Java. 

The xfNetLink Java tools enable you to create a Java JAR file that references your Synergy 
methods in the SMC. If you’re developing on Windows, you can create a JAR file from within 
Workbench. The JAR file presents a familiar interface for Java developers and can be used in a Java 
application, JSP application, or any other Java environment. 

Java application

Using a Java application, you can create a two-tiered solution that consists of a Java application 
running on the client and accessing Synergy logic on a remote Synergy server. (See figure 9-1.) 
The Java runtime must be deployed on the client.

JSP

JavaServer Pages are a combination of HTML and programming code written in JavaScript and 
Java. When a user’s browser requests a JSP page, the web server executes the embedded program 
and returns a pure HTML page to the browser. Using JSP provides you with a three-tier distributed 
system, which includes an end-user machine running a web browser, a web server where xfNetLink 
and your JSP pages are located, and a Synergy server. (See figure 9-2.) JSP works with many 
Windows and UNIX web servers. A servlet container for the web server is required.

Refer to the “xfNetLink Java Edition” section of your xfNetLink & xfServerPlus User’s Guide for 
more information. 

xfNetLink .NET Edition
xfNetLink .NET, in conjunction with Microsoft’s .NET Framework SDK, enables you to create a 
.NET client for xfServerPlus. .NET is a multi-faceted technology that provides numerous solutions. 
See the Microsoft website or one of the many third-party resources available for detailed 
information about .NET.

Using the component generation tools in xfNetLink .NET, you can create a Synergy .NET 
assembly that references Synergy methods defined in the SMC. (These tools can be accessed from 
within Workbench or from the command line.) The assembly can be used in any .NET environment 
to call routines residing on the Synergy server. For example, the client might be a Windows 
application written in a .NET-capable language such as C# or Visual Basic .NET, or a web 
application that uses ASP.NET, or a web service. We discuss a few of these options below. The 
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.NET redistributable (i.e., the runtime, dotnetredist.exe) must always be deployed on the Windows 
client machine. Although .NET is a Microsoft solution, your Synergy routines can reside on any 
supported Synergy platform. 

Visual Basic .NET

Visual Basic .NET (VB.NET) is a Windows front-end development tool that enables you to write 
applications in the Visual Basic .NET language. While VB.NET is similar to Visual Basic, 
Microsoft has made significant changes. (See the Microsoft website for details.) Using VB.NET 
provides you with a two-tier solution: a VB.NET desktop application on a Windows client 
accessing Synergy logic residing on a remote Synergy server. (See figure 9-1.)

ASP.NET

Active Server Pages .NET are a combination of HTML coding and scripting language. For 
ASP.NET that language can be any Common Language Runtime-compliant language; the most 
commonly used languages are C# and VB.NET. Using ASP.NET enables you to create a three-tier 
distributed system, which includes an end-user machine running a web browser, a web server where 
xfNetLink and your ASP.NET pages are located, and a Synergy server. (See figure 9-2.) ASP.NET 
requires a Windows web server running Microsoft IIS. 

Figure 9-2. xfNetLink and xfServerPlus in a three-tier configuration.
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Web services

Web services are business components that provide functionality to a web or desktop application. 
They serve as “black boxes”: callers use the API that you publish and don’t need to know anything 
about the inner workings of the component. Web services provide you with discreet, reusable 
components. They are easily upgraded and can be called by multiple applications. Because web 
services are a .NET solution, you can write them in any language that supports .NET; however, they 
can be deployed only on Windows servers running Microsoft IIS.

A web service is not a complete solution. It is simply a component that is called by another 
application. Web services must be published on the web so that anyone can use them, which 
requires that you establish and adhere to strict security protocols. 

See the “xfNetLink .NET Edition” section of your xfNetLink & xfServerPlus User’s Guide for 
detailed instructions on using xfNetLink .NET.
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Design Considerations
Regardless of which edition of xfNetLink you are using, the only way to take advantage of a 
distributed processing environment is to use modular, encapsulated code that can be distributed 
independently in a software system. If you are designing an application from the ground up, it 
makes sense to think in terms of completely modularizing your entire system right from the start. 
However, in many cases, the goal is to improve an existing application or to make several routines 
accessible from the Web. This makes things more complex, and the task may seem overwhelming.

The first step is to think about where you most need the benefits of modularization. What pieces of 
functionality do you want to make available on an intranet or the Web? What routines can you 
centralize into a utilities library that can be used by many or all of your applications? Do you want 
to have multiple user interfaces—perhaps a desktop user interface and a web interface?

In a distributed application, processing is divided into three layers: 

 User interface processing occurs on the end user’s machine. 

 Business logic processing occurs on the server system. When you’re building a system with 
xfServerPlus and xfNetLink, this is the xfServerPlus machine.

 Database processing occurs on the database server—the machine (or machines) where the data 
resides. 

Some routines control what the user sees (for example, forms, error messages, and prompts) and 
other routines handle data access, calculations, validations, report generation, and so forth. When 
you want to display the result of a piece of application logic in the user interface, the user interface 
logic can call a function that performs the required task and then display the result.

For example, if you wanted to perform a log-in operation in a distributed processing environment, 
you would probably separate the processing layers as follows:

User interface processing:

 Draw a log-in screen.

 Perform field input.

 Validate field contents and write error messages to the screen.

Business logic processing:

 Validate the username.

 Validate that the password is correct for the specified username.

Database processing:

 Read user information from the database.
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You will likely need to modify your Synergy server code before it can work effectively in a 
distributed environment. Once you identify the areas where modularization is needed, you can start 
redesigning the required functionality with your objectives in mind.

 If supporting multiple user interfaces is your priority, the first step is separating the user 
interface from the application logic. 

 If you want to support multiple databases, the first step is separating the file access from the 
other application logic.

 If you plan to make your application available to  customers on the Web, you will first need to 
modularize the system’s application logic so that it can be called remotely from the user’s 
browser. Another option is to write a few modular routines that perform the functions you want 
customers to have access to, and then integrate them into your system at a later date.

As with any other significant code modification, you can handle the move to modularity in chunks, 
slowly moving your system to a more modular state. Keep in mind that you don’t need to 
modularize all of your code—just what needs to be called remotely.

Separating the user interface from application logic
UI Toolkit, which supports event-style programming, effectively separates much of the user 
interface from the data management. However, Toolkit event loops are candidates for revision if 
you are planning to support multiple user interfaces. When you process user events using arrive and 
leave methods or break processing, be sure to handle those events with a call to a function in an 
ELB. This function must return a result that your user interface logic processes.

Error messages are an often overlooked part of the user interface. Your routines should return a 
success or failure status, and the user interface code should handle the actual generation of the error 
message on the screen. See “Handling errors” on page 9-10 for additional ideas on error handling.

Separating data access from application logic
Separating the database from the application logic involves writing routines to handle all file I/O. 
This is probably the most commonly modularized area in existing applications because it hides the 
details of file organization, data access, and so on from the user of the routine. Since file structures 
change frequently, the benefits of writing routines to handle file I/O have been obvious for a long 
time. Again, be sure to check carefully for error messages, data validations, or other functionality 
that belongs in other layers of the distributed client/server system or web application model.
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Using ELBs or shared images
Executable libraries (ELBs) and shared images (on OpenVMS) provide a means of storing related 
routines in a common library that can be called by multiple Synergy programs. When you build a 
distributed system with xfServerPlus and xfNetLink, your Synergy routines must be contained in an 
ELB or shared image and placed on the xfServerPlus machine. 

The ideal approach to modularizing your system is to create a set of routines with defined interfaces 
(formal argument lists) and then group related routines into ELBs. For example, you might group 
your utility routines (such as string handling and date calculations) into one ELB, your order entry 
application logic into another ELB, and your order entry data access into yet another ELB. These 
routines can be called by any application that can make use of them, particularly if you do not 
maintain global or common data inside the ELBs. With remote execution of ELBs, you can position 
each ELB where the application that uses it is located. 

See the “Preparing Your Synergy Server Code” chapter of the xfNetLink & xfServerPlus User’s 
Guide for more information on using ELBs and shared images with xfServerPlus.

Handling errors
Because a distributed computing system has multiple points of failure, it is more complex to debug. 
Therefore, you should design your application with failure in mind. 

For robust server-side code,

 trap for all possible errors on the server side.

 test your logic locally before calling it remotely. After you have modularized your Synergy 
code, you can test it by using the test skeleton generator utility to generate test code from your 
SMC definitions. It is much easier to debug your code and find problems at this point than it 
will be when you are calling it remotely. For more information about the test skeleton 
generator utility, see “Testing Your Synergy Code” in the “Preparing Your Synergy Server 
Code” chapter of the xfNetLink & xfServerPlus User’s Guide.

 return status information, in the form of status codes, as well as results, rather than displaying 
an error message. If you are modifying existing routines, you may want to convert them to 
^VAL functions to do this, which enables you to return a status value without altering your 
argument list. See “^VAL functions” in the “Understanding Routines” chapter of the Synergy 
DBL Language Reference Manual.

For robust client-side code, write your client-side code to check for errors (both xfServerPlus errors 
and errors from your client code).
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Guidelines to improving performance and resilience
 Minimize the number of trips to the server.

 Minimize expensive operations such as starting your xfServerPlus connection.

 Plan for multiple points of failure.

 When determining what to include in your client-side script, keep in mind that client-side 
script can be edited in a web browser or even disabled by the user. Avoid including business 
logic that you don’t want the user to tweak.

 Favor client-side processing over server-side processing for simple field-level validations that 
don’t require server-side data.

 Take into account that information must travel back and forth across the wire, especially for 
web applications. For example, you should limit the number of records displayed on the user’s 
browser, or display them in reasonably-sized chunks, rather than sending hundreds of records.
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Glossary

access key A true key in a database file, which is used to specify relationships 
between files.

ActiveX A set of technologies developed by Microsoft that provides the ability 
to develop active, executable objects for Windows applications and 
websites.

alias A name that represents a directory path or a section of code. A 
directory alias expands to a complete directory path, which means you 
don’t have to type the entire path when prompted for a filename or a 
directory. An extension-specific alias expands to the syntax for a 
routine or to an entire method or processing loop.

API Short for Application Programming Interface, which is a set of 
subroutines and functions used to communicate between different 
parts of a system. This is the level of the system that the application 
programmer uses. For example, UI Toolkit provides an API that can 
be called by a Synergy program; this API is the interface between the 
Synergy program and UI Toolkit.

Application window An area in Composer in which you can design your user interface.

arrive method A subroutine called to perform special processing before an input field 
is processed. 

assembly A collection of all files required for a .NET executable or class library. 
An assembly is what results when Synergy .NET source files are 
compiled, and it can have the extension .exe or .dll.

attribute A characteristic of an object. For example, width is an attribute of a 
window.

bounds checking A feature of the Synergy debugger that identifies situations in which 
data is being stored into structures that are referenced beyond the 
“bounds” of their normal definition.

break field A sort field on which a report break and possibly a page break is set in 
ReportWriter.



Glossary

Glossary-2 Getting Started with Synergy/DE 10.3.3 (5/16)

check box An input field displayed as a small box with accompanying text to its 
right. When a check box is selected, an “x” is displayed in the box.

client A computer hosting a client application, which is an application that 
requests services or access to data from another computer.

client/server system A computer network in which one or more computers act as “clients,” 
requesting services or access to data, and one or more computers act 
as “servers,” processing the clients’ requests.

command button The rectangular button in a dialog box that carries out a command or 
initiates an action (for example, OK, Help, or Cancel).

Common Intermediate 
Language (CIL)

CIL is a processor- and platform-independent set of instructions that is 
executable in any environment that supports a CLR. During 
compilation, Synergy .NET source code is translated into CIL code. 
This was formerly known as Microsoft Intermediate Language 
(MSIL).

Common Language Runtime 
(CLR)

The CLR is the .NET Framework component that manages program 
execution for .NET. The Microsoft .NET Framework has a CLR for 
Windows platforms, and Mono has a CLR for a number of platforms, 
including Android and iOS.

compile-time definition An expression that can be completely evaluated at compile time.

compiler directive A statement that instructs the Synergy compiler and is evaluated only 
when a program is compiled.

compiling The process of translating source files containing Synergy DBL 
statements into object files containing system-level information.

component One or more related methods grouped together as a named entity.

context The next input field to process OR whatever object your mouse 
pointer is over when you click to access the context menu in 
Composer.

context-sensitive help “What is it?” and “What can I do with it?” information about the 
current context. For example, if the cursor is in an input field, 
context-sensitive help would provide information about what to enter 
in that field.

Control Bar The Composer window that contains Composer’s menu bar and 
toolbars.
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cross-reference file A file that contains name link associations, which ReportWriter uses 
to provide access to related files and data structures.

data division The part of a Synergy program in which you define the data structures 
that will be used in the program.

display method A subroutine called whenever the associated field is about to be 
displayed by Toolkit.

distributed application Software whose tasks are split (i.e., distributed) between client and 
server machines. 

DLL Short for Dynamic Link Library, which is a library file containing API 
routines. You can access these libraries at runtime without explicitly 
linking them to an application. Most (third-party) Windows 
applications provide and use their own DLLs.

drill method A subroutine called when the user clicks a drilldown button (on 
Windows) or selects a drilldown menu entry (in non-Windows 
environments). A drill method is primarily used to look up additional 
information or display a dialog box. 

dynamic memory Memory that is allocated as the program requires it. The system 
allocates the memory and returns a pointer to the base of the memory 
segment. 

edit format method A subroutine called by Toolkit whenever the text in the field is being 
formatted for editing purposes.

ELB See executable library.

environment A program state that consists of the current definition of the screen 
and any terminal settings.

environment variable An abbreviation defined at the operating system level for a device, 
directory, or path name. Also called a logical.

escape sequence The set of characters emitted by a keyboard when a key is pressed. 

executable library A group of subroutine executable modules in a single file created by 
the Synergy linker.

file stack A temporary file management system consisting of a single physical 
file that contains multiple logical scratch files accessed in a stack 
manner.
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font A design for a set of characters, comprised of typeface, point size, 
width, and spacing. For example, within the Helvetica typeface there 
are many different fonts (10-point italic, 12-point bold, and so forth).

format The way data will be displayed in an input field or the way a field will 
be displayed in a report.

function code The internal value assigned by UI Toolkit that associates a keyboard’s 
escape sequences with menu entries.

function name The name of a function code. For example, on a PC, the default name 
of Function 1 is “F1.” 

Global Assembly Cache (GAC) The GAC is a machine-wide central repository of .NET assemblies 
that are shared by multiple applications on a single machine. 

global format A repository format that can be used by a field definition in any 
structure.

handle A pointer to the base of the memory segment.

HTML HyperText Markup Language, the authoring language used to create 
documents on the World Wide Web.

hyperlink method A subroutine that’s called when the user clicks on an input field 
prompt.

information line A single line at the bottom of the screen body that is used to display 
messages and general information.

input field A window field associated with a set of characteristics that defines 
how terminal input and display are to occur.

input information Determines how input must be entered and how it will be displayed 
and interpreted.

input set A list of one or more fields in an input window. It defines the default 
order for processing fields.

input window A window that contains one or more input fields.

integer data A byte-oriented, binary representation of a signed whole number.

Java An interpreted language used to write applications and applets.
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JavaServer Pages (JSP) A web page that combines HTML and programming code written in 
JavaScript. When a browser requests a JavaServer Page, the web 
server executes the embedded program, allowing the web page to 
interact with databases and other programs.

key The portion of the data record that identifies the record and is used to 
access it.

key map A record that defines the correspondence between the function keys or 
other special keys on the user’s keyboard and the functions they 
perform.

key map file A file that contains the escape sequences for each defined terminal 
type.

leave method A subroutine called to perform additional processing after an input 
field is processed.

License Manager A set of utilities that controls the installation and use of Synergy/DE 
products.

linking The process that combines one or more routines into an executable 
program or library.

list A collection of identically formatted items.

list class A nonvisual entity that defines the characteristics for an entire list.

load method A subroutine called by the list processor each time it needs a new item.

menu entry name The internal name for a menu entry.

method A program that you write and that UI Toolkit or ReportWriter calls 
when necessary.

method information Specifies any arrive, leave, drill, or hyperlink method subroutine 
associated with a field. 

modularization A programming technique that requires code to be an isolated 
functional unit with a well-defined, published interface (i.e., an 
argument list).

Mono An implementation of the .NET Framework that runs on a number of 
platforms, including Android devices, iOS devices, and Linux 
machines.

name link An association between fields in different structures that is used by 
ReportWriter to access related files.
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.NET Framework A software framework that consists of a Common Language Runtime 
(CLR) and a base class library named Framework Class Library 
(FCL).

.NET Native A build feature for Universal Windows Platform (UWP) that generates 
native binaries from managed IL binaries. If you build a UWP app 
with .NET Native, the build takes longer, but the final result is a native 
UWP binary, which performs better than a managed IL binary and has 
no dependencies on .NET runtimes installed on desktop systems. If 
you build without .NET Native, the result is a managed IL binary, 
which can be useful for development and initial testing because it 
takes less time to compile.

object Any window, list class, menu column, window field, input field, 
selection window entry, menu entry, text, line, box, or button. 

object library A group of subroutine object modules in a single file created with the 
Synergy librarian. Object libraries are linked into an executable file by 
the Synergy linker.

Object Manager The Composer window that displays a visual representation of the 
project file, script file(s), and user interface object hierarchy.

OLB See object library.

palette entry One in a set of colors (or fonts) available to Synergy programs.

portable class library (PCL) A type of library assembly that can target some or all platforms 
supported by Synergy .NET. 

procedure division The part of a routine that contains the executable statements and 
defines the processing algorithms.

project A collection of one or more related files (for example, all of the files 
for a particular application) and the build parameters that operate on 
those files.

Properties window The Composer window that contains a list of design object attributes, 
followed by the property, or value, for each attribute.

property The value of an attribute of an object.

quick-select character A single character that accesses a menu column, menu entry, or 
selection window entry, or a key that when pressed simultaneously 
with the ALT key accesses a command button in a dialog box. The 
quick-select character is underlined on a menu or list.
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radio button An input field displayed as a set of round buttons. The user selects one 
button to make a choice from among several items.

relation An association between structures that enables you to link the keys of 
one structure with the keys of the other structure.

relational operator An operator that compares two operands (equal to, not equal to, 
greater than, less than, greater than or equal to, or less than or 
equal to).

rendition A set of attributes and color of a screen display item. Rendition 
attributes are boldface, blinking, reverse video, and underscore.

rendition scheme A record that defines the display attributes and colors for your screen.

Repository The Synergy/DE application that orders and defines your data 
structures, files, and attributes.

repository The location where your data definitions are stored.

reserved entry One of a class of menu entries that is handled automatically by 
UI Toolkit and that is used to activate many of the standard Toolkit 
functions.

runtime terminal binding The process that binds the keyboard to the shortcuts at runtime instead 
of during script processing.

script file An editable text file that contains special script commands to define 
and control user interface objects and their characteristics.

selection list A pull-down list of options for an input field.

server A computer that processes client requests.

shared image The functionality of an executable library on OpenVMS.

shortcut A key or key sequence that is associated with a specific menu column 
entry. A shortcut provides a quick way to access a menu item, 
bypassing the standard menu entry selection method.

static handle A persistent memory handle that does not get released when the 
activation level of the generating routine is exited.

string relational operator An operator (equal to, not equal to, greater than, less than, greater than 
or equal to, less than or equal to) that compares two alpha operands for 
the length of both.
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structure An entire record definition, or the combination of field and key 
characteristics. 

structure-specific format A repository format that is defined for a particular structure and can 
only be used by the fields in that structure.

Synergy UI Toolkit Control 
Panel

A visual tool that enables you to customize message text, screen 
renditions, and key mapping.

Synergy Method Catalog 
(SMC)

Identifies the Synergy routines that you have prepared for remote 
calling. The SMC includes information such as the function or 
subroutine name, the ELB or shared image it is stored in, and the type 
and length of its parameters.

tab method A subroutine called to process a tab in a dialog box.

tab set A set of toolbar buttons that is accessed by clicking on the tab that 
extends above the top of the toolbar OR a group of tabs that are placed 
simultaneously, in an organized stack, in a dialog box.

tabbed dialog A dialog box that is organized into more than one screen of fields, 
prompts, and buttons. Each screen is accessed by clicking the tab at 
the top of the screen.

tag file A database that stores the information displayed for a routine when the 
user requests function help.

template In Workbench, a method of expanding syntax automatically by 
generating predefined code into the editor. In Repository, a set of field 
characteristics that can be assigned to one or more field definitions or 
templates.

text window A special window that contains variable-length, editable text.

token A keyword that represents and is replaced with a specific name. 

Universal Windows Platform 
(UWP)

An application architecture that enables applications that target it to 
run as Metro-style apps on any system or device with Windows 10 or 
Windows 10 Mobile. UWP is built into these operating systems and is 
a further development of the Windows Runtime (WinRT) model. 

user-overloadable subroutine A subroutine that you write and register so that UI Toolkit calls it 
automatically at the appropriate time. If you do not register your 
routine, Toolkit will use its default implementation.

validation information Defines what input is considered valid.
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volatile handle A dynamic memory handle that goes away along with the routine 
activation level.

window library An ISAM file with a specific format to which Synergy/DE windows 
are saved.

workspace A group of related projects in Workbench.
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Index

Numerics
32-bit configuration 2-9, 2-13
64-bit configuration 2-9, 2-13

A
About Box template 7-5
access key 3-16
accessing memory 5-15
activating menu 6-10
Active Server Pages .NET 9-6
ActiveX control, browsing in Workbench 2-35
ActiveX Diagnostic Utility, starting 2-8
Activity template 7-5
Add new line on enter at end of fully typed word (Visual 

Studio option) 7-5
adding record 6-20 to 6-21
Additional Compile File Extensions (Visual Studio 

option) 7-5
Additional Content File Extensions (Visual Studio 

option) 7-5
^ADDR debugger command 7-48
address, server 8-5
alias 2-27 to 2-30

creating 2-29
customizing 2-29
expanding 2-27
parameters 2-27

alias.slk file 2-27
Align begin/end to contents (Visual Studio option) 7-5
Align contents to begin (Visual Studio option) 7-5
Align to containing (Visual Studio option) 7-5
Align to containing routine (Visual Studio option) 7-5
Align to first column (Visual Studio option) 7-5
aligned integer 5-23
allocating memory 5-13
allowable entry, specifying 3-12
alpha date, converting

from numeric value 5-21, 5-22
to numeric date 5-21, 5-22

Analyze Frequency (Visual Studio option) 7-5

Android Application template 7-5
Android Class Library template 7-5
Android development 7-24 to 7-54
Android Device Monitor 7-54
Android Layout template 7-5
Android Manifest page (Visual Studio) 7-5
Android Options page (Visual Studio) 7-5
Application Configuration File template 7-5
Application page (Visual Studio) 7-5
Application window (Composer) 4-5
application, developing 1-7
Apply Cut or Copy commands... (Visual Studio 

option) 7-5
array, defining for text window contents 6-27
arrive method 3-12, 4-15

in distributed application 9-9
receiving arguments 6-44
using 6-43 to 6-45

ASP. See Active Server Pages .NET
ASP.NET Server Control Library template 7-5
ASP.NET Server Control template 7-5
assembly 7-14

calling a routine from another assembly 7-60 to 7-65
Assembly Information (Visual Studio) 7-5
Assembly Information File template 7-5
Assembly name (Visual Studio option) 7-5
Asset Catalog template 7-5
attribute (Composer) 4-2, 4-5
Auto list members (Visual Studio option) 7-5
Automatic brace completion (Visual Studio option) 7-5

B
Background Log File menu entry (Visual Studio) 7-5
Basic Unit Test template 7-5
batch file, generating in Workbench on build 2-15
behavior of field, defining 3-9 to 3-13
bitmap graphic on command button 4-12
Blank App template 7-5
Blank Page template 7-5
blank, allowing in input field 3-12



C

Index-2 Getting Started with Synergy/DE 10.3.3 (5/16)

Block (Visual Studio option) 7-5
bounds checking 5-10
break processing 3-12, 9-9
Broadcast Receiver template 7-5
Build Events page (Visual Studio) 7-5
Build page (Visual Studio) 7-5
building (Visual Studio)

Android 7-27
iOS 7-37
Linux 7-43
Windows 7-18, 7-20

building program 5-6
customizing commands for 2-39 to 2-41
from Workbench 2-36, 2-39

button
adding to input window 4-11
bitmap graphic on 4-12
defining 6-19

.BUTTON_SET script command 6-19

C
-c compiler option 7-5
C# to DBL Code Converter 7-5
C# to DBL Solution Converter 7-5
call tree, viewing 2-33
caption, window 6-3
case

converting 3-11
matching 3-12

CASE statement
processing menu column 6-14
USING vs. 5-23

Certificate (Visual Studio option) 7-5
change method 3-13, 4-15
Change Password (Visual Studio option) 7-5
Change Targets dialog (Visual Studio) 7-5
channel, load method 6-31
check box

adding in Composer 4-14
specifying in Repository 3-10

Choose a strong name key file (Visual Studio option) 7-5
class library 7-4
Class Library template 7-5
Class template 7-5
Clear History (Visual Studio option) 7-5
ClickOnce deployment 7-5

client/server 8-1 to 8-9
benefits 8-4
defined 8-2 to 8-4
multi-tier model 8-3
two-tier model 8-2

client-side code 9-10, 9-11
closing

Composer project 4-16
file 6-4
script file 4-16

code
completion 2-16
expanding and collapsing regions 2-22
formatting 2-16
generating 2-27
template 2-31
viewing call tree 2-33
viewing where method is called 2-34

Code File template 7-5
code snippet (Visual Studio) 7-5
collapsing

attribute in Properties window 4-5
files or objects in Object Manager 4-6
regions of code in Workbench 2-22

column
heading, in report 3-15
menu 6-3

creating 6-10 to 6-15
defining 6-10

.COLUMN script command 6-12
COM, creating component project 2-10
combo box, adding 4-14
command button

adding to input window 4-11
bitmap graphic on 4-12
defining 6-19
with bitmap graphic 4-12

command line, accessing in Workbench 2-5
Command Prompt menu entry (Visual Studio) 7-5
comments, documentation 2-21
Committed by pressing the space bar (Visual Studio 

option) 7-5
Committed by typing the following characters (Visual 

Studio option) 7-5
comparing data 5-20
Compile page (Visual Studio) 7-5
Compile with .NET Native tool chain (Visual Studio 

option) 7-5
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Compiler command line (Visual Studio option) 7-5
compile-time definition 5-23
compiling

checking errors 2-36
customizing commands for 2-39 to 2-41
from editor 5-5
from Workbench 2-36
program 5-5
script file 4-17

components in Synergy/DE 1-4
ComPooling template 7-5
Composer 1-5, 4-3 to 4-17

Application window 4-5
Control Bar 4-4
exiting 4-18
help online 4-6
Object Manager 4-6
Properties window 4-5
saving work 4-16
screen elements 4-3
starting 2-8, 4-3
terminology 4-2
using 4-8 to 4-17

composite window 6-40 to 6-42
Configuration (Visual Studio option) 7-5
configuration (Workbench) 2-13

customizing 2-14
understanding 2-9

Console Application template 7-5
context tagging

changing delay 2-42
turning off 2-42
See also tag file

context-sensitive help
displaying routine help in Workbench 2-20, 2-23
implementing with Toolkit 6-33, 6-34 to 6-36

Control Bar (Composer) 4-4
Control Panel. See Synergy UI Toolkit Control Panel
Convert binary fields in repository to (Visual Studio 

option) 7-5
converting

dates 5-21 to 5-23
window to text window 6-26

copying
field 3-5
object 4-6
Workbench customization settings 2-44

creating
input field

Composer 4-13
UI Toolkit 6-15 to 6-19

input window 4-12
Composer 4-8
UI Toolkit 6-15 to 6-23

list 6-31
load method 6-29
menu column 6-10 to 6-15
object (Composer) 4-8
script file 6-10
selection window 6-23 to 6-24
tab set 6-37
tabbed dialog 6-37 to 6-39
text field 4-14
text window 6-24 to 6-28
window library 6-10

cross-referencing data between files 3-17
#CURSOR# token 2-31
cursor, retaining position in text field 3-11
customizing

commands in Workbench 2-39 to 2-41
Workbench 2-38 to 2-45

D
D_MONO compile-time define 7-7
D_PORTABLE compile-time define 7-7
data

access, separating from logic 9-9
comparing 5-20
cross-referencing between files 3-17
displaying to user 6-19
division 5-3, 5-4
field, defining 3-3 to 3-6
referencing indirectly 5-18
sharing 8-4
structure, defining 6-27
type

integer 5-23
specifying 3-4

unloading 6-27
date

converting 5-21, 5-22
defaulting to current 3-11
performing mathematical operations on 5-21

%DATE routine 5-22, 5-21
day of the week, returning 5-21, 5-22
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DBG_INIT environment variable 2-37
.dbl filename extension 5-5
dbl2xml utility 9-3
dbl.als file 2-27
DBLNET compile-time define 7-7
.dbo filename extension 5-5, 5-6
.dbr filename extension 5-6
dbs 9-3
ddlib.dll 7-4, 7-9
deallocating

file from memory 6-4
memory 5-14

_DEBUG compile-time define 7-7
debug configuration (Workbench) 2-9, 2-13
Debug page (Visual Studio) 7-5
debugging 5-9 to 5-11, 7-46

Android 7-27, 7-46
bounds checking enabled 5-10
customizing commands for 2-39 to 2-41
iOS 7-37, 7-46
project in Workbench 2-9, 2-13, 2-36
restoring debugger settings 5-9
saving debugger settings 5-9
Windows (.NET) 7-18, 7-20, 7-46

Debug/Optimize code (Visual Studio option) 7-5
decimal point, omitting in repository field 3-11
Default behavior of unqualified record statements (Visual 

Studio option) 7-5
Default namespace (Visual Studio option) 7-5
Define alternate compile-time ̂ VARIANT (Visual Studio 

option) 7-5
.DEFINE compiler directive 6-5
defining

command buttons 6-19
display window 6-29
field 3-4, 3-9, 3-14

appearance 3-9
behavior 3-9 to 3-13
copying 3-5

file 3-18
input set 6-19
input window 6-16
key 3-15
list class 6-29
menu column 6-10
relation 3-17
selection windows 6-23

structure 3-3
text window 6-25

definition, compile-time 5-23
Delay sign only (Visual Studio option) 7-5
delegate, declaring and using 7-58
deploying

Android 7-27
ClickOnce 7-5
iOS 7-38
Linux 7-43
Windows (.NET) 7-18

designing user interface 4-1 to 4-18
device licensing 7-12
dialog box, tabbed 6-37 to 6-39
Disable specified warnings (Visual Studio option) 7-5
display

components, managing 6-9
information 3-9, 3-14
method 4-15

displaying
data to user 6-19
input in a field 3-8

distributed application 1-8
designing 9-8 to 9-11
performance guidelines 9-11
user interface 9-2

DLL base address (Visual Studio option) 7-5
DM_ALLOC value 5-13
DM_FREE value 5-14
DM_REG value 5-14
DM_RESIZ value 5-13
documentation

comments 2-21
using 1-9 to 1-10

drill method 3-12, 4-15
drilldown 4-12
duplicate value for key 3-16
dynamic

memory 5-12 to 5-16
selection window 6-23

E
E_ENTER routine 6-7
E_EXIT routine 6-7, 6-14
edit format method 4-15
editable text field 4-14
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editing
capabilities in your application 6-24
code 2-16 to 2-26
file 2-18
selecting editor 5-2

editor 2-16 to 2-26
Editor Help (Visual Studio options) 7-5
ELB

comparing to SMC 2-8
creating 5-7
extension 5-6
restrictions 5-8
using in distributed application 9-10

.elb filename extension 5-6
Empty Project template 7-5
Enable AppDomain support with MarshalByRefObject 

(Visual Studio option) 7-5
Enable device licensing (Visual Studio option) 7-5
Enable single-click URL navigation (Visual Studio 

option) 7-5
Enable virtual space (Visual Studio option) 7-5
.END script command 6-12
END statement 5-4
ENDFUNCTION statement 5-4
ENDMAIN statement 5-4
ENDMETHOD statement 5-4
.ENDREGION compiler directive 2-22
ENDSUBROUTINE statement 5-4
Enter outlining mode when files open (Visual Studio 

option) 7-5
Entitlements template 7-5
.ENTRY script command 6-12
entry, reserved. See reserved entry
enumerated field (Repository) 3-12
environment

entering new 6-7
processing 6-7

environment variable
benefits of using 5-18
resetting in Workbench 2-7
setting 2-5, 2-6, 5-19
using 5-18

Environment Variables page (Visual Studio) 7-5
error

compilation 2-36
handling

in distributed application 9-9, 9-10
UI Toolkit 6-4

event, declaring and using 7-59
event-driven programming 6-5
executable file

extension 5-6
xfServer 8-5

executable library. See ELB
exiting

Composer 4-18
environment 6-7

expanding
attribute in Properties window 4-5
files or objects in Object Manager 4-6
list 6-29
regions of code in Workbench 2-22

extension, adding to Workbench 2-41

F
-F compiler option 7-5
field

appearance 3-9
behavior 3-9 to 3-13
changing order in structure 3-6
copying 3-5
data type 3-4
default action 3-11
defining 3-4, 3-9, 3-14

by copying 3-5
for Composer 3-7 to 3-13
for ReportWriter 3-14 to 3-20
in Repository 6-17

displaying 3-8, 3-10
format 3-14
input

entry and display 3-9
justification 3-10
validation 3-10

method subroutines 3-11
moving 4-11
positioning 3-10
prompt 4-11, 4-13
properties 4-13
setting up prior to input 6-43
size 3-4, 4-13
See also input field; text field

.FIELD script command 6-43
#FIELD# token 2-31
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file
defining 3-18
editing 2-18
extension 2-41

registering in Visual Studio 7-5
moving between in editor 2-26
sharing 2-15
stack 6-32

Flow Document (WPF) template 7-5
Folder (Visual Studio option) 7-5
footer, Toolkit screen 6-4
format

assigning 3-10, 3-15
field input, defining 3-8
global 3-8
structure-specific 3-8

formatting code automatically 2-16
Fragment template 7-5
FTP, using in Workbench 2-47 to 2-50
FUNCTION statement 5-3

G
-G compiler option 7-5
g_entnam 6-14
g_fldnam 6-43
g_select 6-13, 6-21
g_setsts 6-21
g_utlib 6-9
Generate code compatible with the Mono runtime (Visual 

Studio option) 7-5
Generate default empty constructor (Visual Studio 

option) 7-5
Generate errors for all compiler warnings (Visual Studio 

option) 7-5
Generate out parameters as (Visual Studio option) 7-5
Generate serialization assembly (Visual Studio 

option) 7-5
Generate structure members as (Visual Studio 

option) 7-5
Generate structures with INotifyPropertyChanged events 

(Visual Studio option) 7-5
Generate utility method stubs (Visual Studio option) 7-5
Generate warning when stack size exceeds # bytes 

(Visual Studio option) 7-5
Generate warnings instead of errors (Visual Studio 

option) 7-5
Generate WCF contracts (Visual Studio option) 7-5
Generate with IDisposable (Visual Studio option) 7-5

Generate XML documentation comments... (Visual 
Studio option) 7-5

generating code segments 2-27
generic class 7-57
GET statement, in client/server environment 8-6
global

format 3-8
screen components (Toolkit) 6-8
variable 6-5

H
h_general window 6-35
handle, memory 5-16
header, Toolkit screen 6-3
Hello World

Android 7-28
iOS 7-39

help
associating window with field 6-36
Composer 4-6
context-sensitive 6-34 to 6-36
displaying on information line 4-15
identifier, specifying 3-10
message, generic 6-35
online, implementing 6-33 to 6-36
Repository 3-2
Visual Studio 7-6
Workbench 2-26

routine syntax 2-20 to 2-21
routines outside current file 2-23, 2-24

Hide advanced members (Visual Studio option) 7-5
HTML Help 6-33
hyperlink

input field prompt 4-13
method 3-13, 4-15

I
I_DISPLAY routine 6-19
I_INIT routine 6-21
I_INPUT routine 6-16, 6-24, 6-44
I_LDINP routine 6-19
I_NEXT routine 6-21
i4 variable 5-23
Icon (Visual Studio option) 7-5
Icon and Manifest (Visual Studio option) 7-5
identifier, variable as 6-6
include file, extension 2-41
Indent as statements (Visual Studio option) 7-5
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Indent contents in block (Visual Studio option) 7-5
Indent contents of block (Visual Studio option) 7-5
Indent .include (Visual Studio option) 7-5
Indent one level (Visual Studio option) 7-5
Indent size (Visual Studio option) 7-5
Indenting (Visual Studio options) 7-5
Info.plist template 7-5
information line

specifying text on 3-10, 4-15
Toolkit screen 6-4

inheriting a .NET class 7-55
initialization setting 2-5
initializing input window 6-21
input

defining display format 3-8
entry and display 3-9
information 3-9
justifying 3-10
method subroutines 3-11
processing 6-20 to 6-23
saving 6-27
validating 3-10, 6-15, 6-43

input field
creating

Composer 4-13
UI Toolkit 6-15 to 6-19

data type 3-4
defining 3-4, 3-9, 3-14

in Repository 6-17
hyperlink prompt 4-13
moving

Composer 4-11
within and between 6-16

prompt 4-11, 4-13
properties 4-13
size 3-4, 4-13

input set, defining 6-19
input window

adding
command button 4-11
field from repository 4-9
line 4-11

creating
Composer 4-8
UI Toolkit 6-15 to 6-23

defining 6-16
initializing 6-21

loading 6-19
navigating 6-16

Insert spaces (Visual Studio option) 7-5
Installer Class template 7-5
instantiating a .NET class 7-55
integer data 5-23
Intel Atom (x86) emulator 7-27
Intel HAXM Android emulator 7-27
IntelliSense language version (Visual Studio option) 7-5
IntelliSense pre-selects... (Visual Studio option) 7-5
interface (UI). See user interface
Interface Definition template 7-5
interface, Synergy .NET 7-56
Interop page (Visual Studio) 7-5
Interop project 7-62, 7-70
Interop template 7-5
I/O

limitations of xfServer 8-6
terminal 6-2

iOS Application template 7-5
iOS Class Library template 7-5
iOS development 7-31 to 7-54
iPad Storyboard View Controller template 7-5
iPad View Controller template 7-5
iPhone Storyboard View Controller template 7-5
iPhone View Controller template 7-5
ISAM files

Android 7-52
iOS 7-54
Windows Phone and Windows Store 7-51
See also Synergy DBMS

item templates (Visual Studio) 7-5

J
JAR file 9-5
Java

calling Synergy routines from 9-5
creating a component project 2-10
JAR file 9-5

JavaServer Pages 9-5
%JPERIOD routine 5-21
JSP. See JavaServer Pages
justifying

data in report 3-15
input in field 3-10
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K
Keep tabs (Visual Studio option) 7-5
key

defining 3-15
duplicates 3-16
null value 3-16
relation 3-17
segment type 3-16

Key file name (Visual Studio option) 7-5
keyword

color coding 2-42
completion 2-18

L
L_CREATE routine 6-30, 6-31
L_METHOD routine 6-31
L_PROCESS routine 6-30
L_SELECT routine 6-30, 6-32
Language. See Synergy DBL
Leave data div alone (Visual Studio option) 7-5
Leave first column alone (Visual Studio option) 7-5
leave method 3-12, 4-15

in distributed application 9-9
receiving arguments 6-44
using 6-43 to 6-45

library
executable 5-6, 5-7, 5-8
object 5-5, 5-6, 5-8
storing routines 9-10
window 6-9, 6-10

Library page (Visual Studio) 7-5
licensing (device) 7-12
line

adding to input window 4-11
terminator 8-6

Line numbers (Visual Studio option) 7-5
linking program 5-5, 5-6, 5-7

customizing commands for 2-39 to 2-41
from editor 5-7
from Workbench 2-36

Linux (Mono) development 7-42 to 7-54
.lis filename extension 5-5
list 6-28

characteristics of 6-28
class 6-28
combining with window(s) 6-40 to 6-42
creating 6-31
expanding 6-29

loading
input window 6-31
item into 6-28

processing 6-28, 6-32
structure of items in 6-28

listing file 5-5
load method 6-28

changing at runtime 6-31
channel requirements 6-31
creating 6-29

loading
item into list 6-28
list input window 6-31
menu column 6-12, 6-26
text window 6-26

local screen components (Toolkit) 6-8
logic, separating

from data access 9-9
from user interface 9-9

logical
benefits of using 5-18
setting 5-19
using 5-18

longword-aligned integer variable 5-23, 6-6
lowercase, converting to uppercase 3-11

M
^M data reference operation 5-15
^M debugger command 7-48
M_LDCOL routine 6-12
M_PROCESS routine 6-13
Mac development machine 7-10
main routine, beginning 5-3
MAIN statement 5-3
Manifest (Visual Studio option) 7-5
manuals, accessing online 2-8
map file 5-6
.map filename extension 5-6
matching

all characters 3-12
case 3-12

maximum value, specifying 3-12
MDI Parent Form template 7-5
%MEM_PROC routine 5-13 to 5-14
memory

accessing 5-15
allocating 5-13
deallocating 5-14
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defining structure 5-12
dynamic 5-12 to 5-16
registering 5-14
resizing 5-13

menu
activating 6-10
navigating 6-10
processing 6-13, 6-14

menu bar, Toolkit screen 6-3
menu column 6-3

creating 6-10 to 6-15
defining 6-10, 6-12
loading 6-12, 6-26

menu entry
defining 6-12
name prefixes to avoid 6-11
predefined by UI Toolkit 6-11

method 6-28
arrive 3-12, 4-15
change 3-13, 4-15
display 4-15
drill 3-12, 4-15
edit format 4-15
generating in Workbench 2-31
hyperlink 3-13, 4-15
information 3-9
leave 3-12, 4-15
subroutine, specifying 3-11, 4-12, 4-15
using 6-43 to 6-45
See also arrive method; leave method; load method; 

tab: method
Method Definition Utility 2-8, 9-3

starting 2-8
METHOD statement 5-3
Min version (Visual Studio option) 7-5
minimum value, specifying 3-12
minus sign

Object Manager 4-6
Properties window 4-5

modifying record 6-21 to 6-23
modular code 9-8 to 9-9, 9-10
Mono development 7-24 to 7-54
moving input fields 4-11

N
-N compiler option 7-5
naming

object 4-6
variables 6-6

Navigation bar (Visual Studio option) 7-5
%NDATE routine 5-21, 5-22
negative, allowing values 3-12
.NET

calling Synergy routines from 9-5 to 9-7
Component project

changing environment 2-43
creating 2-10

Configuration utility. See xfNetLink .NET 
Configuration utility

development 7-1 to 7-73
web services 9-7
See also Synergy .NET

.NET assembly 7-14

.NET Framework Data Provider for ODBC 7-7
network, hardware, and software requirements 8-8
NFS-based mapped drives 2-46
No indentation block (Visual Studio option) 7-5
No indentation in block (Visual Studio option) 7-5
None (Visual Studio indenting option) 7-5
non-interactive runtime 9-3
NuGet 7-11
numeric, converting

from date 5-21
to alpha date 5-21, 5-22
to date 5-21, 5-22

O
O_HELP menu entry 6-14, 6-33, 6-34
object 4-2

copying 4-6
creating (Composer) 4-8
renaming 4-6
size 4-13

object file 5-5
object library 5-5

and ELB rebuilding 5-8
creating 5-6
filename extension 5-6

Object Manager (Composer) 4-6
OK button, adding to input window 4-11
.olb filename extension 5-6
OLB. See object library
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On successful build (Visual Studio option) 7-5
online help

Composer’s 4-6
implementing 6-33 to 6-36
providing context-sensitive 6-34
See also help

OPEN statement 6-4
opening file 6-4
operator, relational and string relational 5-20
order, fields in structure 3-6
Other options (Visual Studio option) 7-5
Outlining (Visual Studio options) 7-5
Output path (Visual Studio option) 7-5
Output type (Visual Studio option) 7-5
overriding a .NET class 7-55

P
Package Manifest (Visual Studio option) 7-5
Page (WPF) template 7-5
paint character, specifying 3-10
pairing (iOS) 7-32
Parameter Entry dialog box (Workbench) 2-27
Parameter information (Visual Studio option) 7-5
Place code snippets in completion lists (Visual Studio 

option) 7-5
Place keywords in completion lists (Visual Studio 

option) 7-5
Platform (Visual Studio option) 7-5
Platform target (Visual Studio option) 7-5
plus sign

Object Manager 4-6
Properties window 4-5

popping up window 6-19
portability of Synergy DBL 5-2
portable class library 7-14, 7-44 to 7-45
Portable Class Library template 7-5
positioning input field 3-10, 4-11
Post-build event command line (Visual Studio 

option) 7-5
Pre-build event command line (Visual Studio option) 7-5
Prefer 32-bit (Visual Studio) 7-5
primary key 3-16
PROC statement 5-4
procedure division 5-3, 5-4
processing

input 6-20 to 6-23
lists 6-28, 6-32
menu 6-13, 6-14

selection windows 6-24
tab sets 6-38

product support, contacting xii
Professional Series 1-4 to 1-5
Professional Series Workbench. See Workbench
programming

event-driven 6-5
tips 5-18 to 5-23

project
Composer 4-2, 4-16
Visual Studio 7-5, 7-14
Workbench

adding files to 2-12
adding to workspace 2-15
benefits 2-10
compiling, building, and running 2-36 to 2-40
configurations of 2-13
creating 2-10 to 2-12
customizing 2-38, 2-39
debugging 2-36
moving between files in 2-26
opening 2-38
understanding 2-9

Project environment variables (Visual Studio option) 7-5
prompt

hyperlink 3-13
specifying 3-10, 4-11, 4-13

Properties window (Composer) 4-5
property

definition 4-2
setting in Composer 4-13

protocol, TCP/IP 8-5
Prototype utility 2-8
Publish page (Visual Studio) 7-5
PUT statement 8-6

Q
-qdescscope compiler option 7-5
-qexternal compiler option 7-5
-qglobal compiler option 7-5
-qlocal compiler option 7-5
-qnodescscope compiler option 7-5
-qrelaxed compiler option 7-5
-qstatic compiler option 7-5
quick-select character 6-10, 6-12
QuickWatch (Visual Studio) 7-46
quitting Composer 4-18
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R
radio button, specifying in Repository 3-10
RDBMS, accessing 1-6
record

adding new 6-20 to 6-21
layout, defining 3-3 to 3-6
modifying 6-21 to 6-23

Refactoring (Visual Studio options) 7-5
Reference paths (Visual Studio option) 7-5
Reference Paths page (Visual Studio) 7-5
referencing data indirectly 5-18
.REGION compiler directive 2-22
registering memory 5-14
relation

defining 3-17
keys 3-15

relational operator 5-20
release configuration (Workbench) 2-9, 2-13
Remote Debugger (Visual Studio) 7-46
Remote Tools for Visual Studio 7-46
renaming object 4-6
reordering fields 3-6
report

defining fields for 3-14
displaying field in 3-14
justifying data 3-15

ReportWriter
application 1-5
defining fields in Repository 3-14 to 3-20

Repository 1-5, 3-1 to 3-20
defining

record layout 3-3 to 3-6
ReportWriter files 3-14 to 3-20
user interface characteristics 3-7 to 3-13

displaying list of valid data 3-2
getting help 3-2
input fields in 6-15, 6-17
starting 2-8, 3-2

repository
converting from script file 2-8
field, adding to input window 4-9

Repository subroutine library 7-4, 7-9
requirements

.NET development 7-10 to 7-12
xfServer 8-8

reserved entry
defining column for 6-16
loading 6-16

prefixes 6-11
text editing 6-25
using 6-11

resizing
field 4-13
memory 5-13
object 4-13

Resource Dictionary (WPF) template 7-5
Resource Dictionary template 7-5
Resources file (Visual Studio option) 7-5
Resources File template 7-5
Resources page (Visual Studio) 7-5
Return to pool (Visual Studio option) 7-5
routine

dispatching dynamically 5-17
displaying argument list 2-20
identifying type 5-3
moving between in Workbench editor 2-22

#ROUTINE# token 2-31
Run peverify on output assemblies (Visual Studio 

option) 7-5
Run the post-build event (Visual Studio option) 7-5
running

Composer 4-3
program 5-5, 5-8

customizing commands for 2-39 to 2-41
from editor 5-8
from Workbench 2-36

Repository 3-2
runtime 1-5

libraries (.NET) 7-11
used by xfServerPlus 9-3

Runtime environment variables (Visual Studio 
option) 7-5

Runtime Settings page (Visual Studio) 7-5

S
-s compiler option 7-5
SAVE debugger command 2-36
saving

script file 4-16
structure 3-6
work in Composer 4-16

screen
default UI Toolkit 6-3
restoring 6-7
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script command
.BUTTON_SET 6-19
.COLUMN 6-12
.END 6-12
.ENTRY 6-12
.SELECT 6-24
.SET 6-19

script file 4-2
closing 4-16
compiling 4-17
converting to repository 2-8
creating 6-10
extension

adding to Workbench 2-41
saving 4-16

Script utility, starting 2-8
scrolling through text window 6-27
segmented key 3-16
.SELECT script command 6-24
selection list

field, adding 4-14
specifying in Repository 3-12

selection window
creating 6-23 to 6-24
defining 6-23
dynamic 6-23
processing 6-24

server 8-1 to 8-9
accessing remote files 8-5
job of 8-4
See also xfServer

server-side code
error handling 9-10
guidelines 9-11

Set compile-time defines (Visual Studio option) 7-5
.SET script command 6-19
Set the warning level (Visual Studio option) 7-5
Settings File template 7-5
Settings page (Visual Studio) 7-5
SFWINIPATH environment variable 2-38
shared image 5-8, 9-10
sharing data 8-4
shortcut 6-10, 6-12
Show channels debugger command 7-48
Show completion list... (Visual Studio option) 7-5
Show handles debugger command 7-48
Show visual glyphs for word wrap (Visual Studio 

option) 7-5

Sign the Assembly (Visual Studio option) 7-5
Sign the ClickOnce manifests (Visual Studio option) 7-5
Signing page (Visual Studio) 7-5
size

field 3-4, 4-13
object 4-13

Smart (Visual Studio option) 7-5
SmartPaste 2-16
SMC/ELB Comparison utility 2-8
solution (Visual Studio) 7-14
source code, creating 5-2, 5-3
SQL Connection 1-6
SQL OpenNet 1-6
stack 6-7
Stack size (Visual Studio option) 7-5
starting UI Toolkit 6-3, 6-4
Startup object (Visual Studio option) 7-5
static handle 5-16
-staticalloc compiler option 7-5
Stop Build on First Error menu entry (Visual Studio) 7-5
string relational operator 5-20
structure

adding in Composer 4-9
assigning to file 3-19
changing field order 3-6
defining 3-3

data 6-27
memory 5-12

saving 3-6
#STRUCTURE# token 2-31
structure-specific format 3-8
Style 1 (Visual Studio option) 7-5
Style 2 (Visual Studio option) 7-5
subattribute, viewing or modifying 4-5
subroutine

beginning 5-3
dispatching dynamically 5-17

SUBROUTINE statement 5-3
support, contacting xii
Surround generated code with .region (Visual Studio 

option) 7-5
Symbol tab (Workbench) 2-23
syn_init_proj 2-7
syn_set command 2-6
syn_set_synergy_ini command 2-7
Synergex.Synergyde.Synrnt NuGet package 7-11
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Synergy DBL 1-5, 5-1 to 5-23
benefits 5-2, 5-3
defined 5-2
program structure 5-3

Synergy DBL Integration 7-4
Synergy DBMS 1-5
Synergy license server (Visual Studio option) 7-5
Synergy Method Catalog 9-3
Synergy .NET 7-1 to 7-73

reporting problems with xiii
Synergy .NET assembly API 7-7
Synergy .NET Remote Debugger 7-46
Synergy Online Manuals menu entry (Visual Studio) 7-5
Synergy Prototype utility. See Prototype utility
Synergy Repository menu entry (Visual Studio) 7-5
Synergy runtime 1-5
Synergy Type Library Configuration utility 2-8
Synergy UI Toolkit Control Panel 2-8
Synergy windowing API, Synergy .NET and 7-66
Synergy/DE 1-1 to 1-10

advantages of 1-2
components 1-4
definition 1-2
philosophy 1-2

SynergyEnvironment tag 7-5
synergy.ini file 2-5, 2-38
SynergyLicenseServer tag 7-5
synfunc 2-29
syninp 2-29
synlist 2-29
synmeappmove 2-28
synmeappsize 2-28
synmeappstate 2-28
synmecentury 2-28
synmechkfld 2-28
synmeclose 2-28
synmedspfld 2-28
synmeedtdsp 2-28
synmeentrst 2-28
synmefkey 2-28
synmehelp 2-28
synmeutils 2-28
synmiarrive 2-28
synmichange 2-28
synmidisplay 2-28
synmidrill 2-28
synmieditfmt 2-28
synmihyper 2-28

synmileave 2-28
synmlarrive 2-28
synmldblclk 2-28
synmlleave 2-28
synmlload 2-28
synmtab 2-28
synmwbutton 2-29
synmwclick 2-29
synmwclose 2-29
synmwevent 2-29
synmwmax 2-29
synmwmin 2-29
synmwmove 2-29
synmwrest 2-29
synmwscroll 2-29
synmwsize 2-29
synrnt 7-11
synsub 2-29
syntab 2-29
syntax expansion 2-20
synxml.dll 7-4, 7-9

T
T_EDIT routine 6-24
T_GETLIN routine 6-27
T_SETUP routine 6-26
T_VIEW routine 6-27
tab

method 6-38 to 6-39
set

changing active tab 6-38
creating 6-37
populating 6-37
processing 6-38

Tab (Visual Studio options) 7-5
Tab size (Visual Studio option) 7-5
tabbed dialog 6-37 to 6-39
tag file 2-23 to 2-24

adding files to 2-23
creating extension-specific 2-24
custom 2-23
imported classes 2-24
including database from another project 2-25
rebuilding 2-25

Target (Visual Studio option) 7-5
Target framework (Visual Studio option) 7-5
Target Synergy runtime (Visual Studio option) 7-5
Target version (Visual Studio option) 7-5
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TCP/IP protocol 8-5
template file 2-31

customizing 2-31
tokens in 2-31

templates (Visual Studio) 7-5
terminal I/O 6-2
Terminal Services, Workbench on 2-7
terminology, Composer 4-2
text

editing capabilities (Toolkit) 6-24
editor, selecting 5-2

text field
creating 4-14
retaining cursor position 3-11

Text File template 7-5
text window

converting 6-26
creating 6-24 to 6-28
defining 6-25, 6-27
extracting input from 6-27
loading 6-26
setting up 6-26
unloading data from 6-27
viewing contents of 6-27

time, defaulting to current 3-11
Timestamp server URL (Visual Studio option) 7-5
tip, programming 5-18 to 5-23
title, window 4-9, 6-3
tklib.elb file 6-2
Toolkit. See UI Toolkit
tools.def file 6-5
.tpl file extension 2-31
TS_PROCESS routine 6-38
%TS_TABSET routine 6-37
Type Library Configuration utility. See Synergy Type 

Library Configuration utility

U
U_CLOSE routine 6-4, 6-5
U_EDIT routine 6-24
%U_HTMLHELP routine 6-33
U_LDWND routine 6-26
U_OPEN routine 6-4
U_POPUP routine 6-19
U_START routine 6-3
%U_WINHELP routine 6-33

UI Toolkit 1-4, 6-1 to 6-45
defined 6-2
native help 6-33, 6-34 to 6-36
.NET routines 7-7
reserved menu entries 6-11
screen, described 6-3
starting 6-3, 6-4

uncompiled object or script 4-6
Underline errors in editor (Visual Studio option) 7-5
Unit Test Project template 7-5
Unit Test template 7-5
Universal Storyboard View Controller template 7-5
Universal View Controller template 7-5
Universal Windows Platform (UWP) 7-3
Universal Windows Platform templates 7-5
unloading data from text window 6-27
uppercasing input 3-11
Use alternate field names in repository (Visual Studio 

option) 7-5
Use alternate form of IF (Visual Studio option) 7-5
Use pooling (Visual Studio option) 7-5
User Control (WPF) template 7-5
User Control template 7-5
user interface

defining fields in Repository 3-7 to 3-13
designing 4-1 to 4-18
distributed application 9-2

Active Server Pages .NET 9-6
Java application 9-5
JavaServer Pages 9-5
Synergy 9-4
Visual Basic .NET 9-6

separating from logic 9-9
USING statement

CASE vs. 5-23
processing menu column 6-14

V
validating input 6-15
validation information 3-9
variable

global 6-5
naming convention 6-6
using for identifier 6-6

Variable Usage utility 2-8
version control, accessing from Workbench 2-43
View template 7-5
Visual Basic .NET 9-6
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Visual Studio
code converter 7-5
code snippet 7-5
debugging in 7-46
file extension 7-5
help 7-6
integration 7-4, 7-5
menu entry 7-5
Remote Debugger 7-46
template 7-5

Visual Studio Emulator for Android 7-27
volatile handle 5-16
.vpj file 2-11
vsvars32.bat file 2-43
.vtg file 2-23, 2-24

W
Warn if build errors exist when refactoring (Visual Studio 

option) 7-5
Watch window (Visual Studio) 7-48
WCF Service Library template 7-5
web services (.NET) 9-7
weekday, returning number of 5-21, 5-22
window 4-2

composite 6-40 to 6-42
converting to text window 6-26
defining display 6-29
input processing 6-15 to 6-23
library 6-9, 6-10
See also input window; selection window; text 

window
Window (WPF) template 7-5
Windows Form template 7-5
Windows Forms Application template 7-5
Windows Forms Control Library template 7-5
Windows Phone, Windows Store 7-3, 7-44 to 7-45
Windows Service template 7-5
Windows UserControl template 7-5
WinHelp 6-33
%WKDAY routine 5-21, 5-22
Word wrap (Visual Studio option) 7-5
Workbench 1-4, 2-1 to 2-40

accessing tools from 2-8
adding command to menu 2-39 to 2-41
collapsing code regions 2-22
configurations 2-13
copying customization settings 2-44
customizing 2-38 to 2-45

distributed applications and 9-2
editor 2-16 to 2-26
expanding code regions 2-22
non-Windows development 2-46 to 2-50
project

compiling, building, and running 2-36 to 2-40
creating 2-10 to 2-12

resetting environment variables 2-7
setting environment variables 2-6
starting 2-4

workspace (Workbench)
adding project to 2-15
creating 2-9
understanding 2-9

WPF Application template 7-5
WPF User Control Library template 7-5
.wsc file 2-41

X
Xamarin tools 7-10
Xamarin.Android 7-5
Xamarin.iOS 7-5
Xcode 7-10
xfNetLink 1-6, 9-4 to 9-7

Java Edition 9-5
.NET Edition 7-7, 7-70 to 7-73, 9-5 to 9-7
Synergy Edition 9-4

xfNetLink .NET Configuration utility 2-8
xfODBC 1-6
xfSeries 1-6
xfServer 1-6, 8-1 to 8-9

executable file 8-5
I/O limitations 8-6
OpenVMS 8-7
operation of 8-5 to 8-8
requirements 8-8
UNIX 8-6
Windows 8-6

xfServerPlus 1-6, 9-3
converting routines for .NET access 7-70 to 7-73

XML API 7-4, 7-9
XML Documentation Comments (Visual Studio 

options) 7-5
XML documentation file (Visual Studio option) 7-5
XML File template 7-5
XML Schema template 7-5
XSLT File template 7-5
XSUBR routine 5-17, 6-13, 6-14
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